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LESSON STRUCTURE:  
In this lesson we shall discus about the various introductory aspects of computers. 

First, we shall focus on the components of computers. We shall also briefly discuss 

the evolution of computers and the various generations of computers. The lesson 

structure shall be as follows:  

1.0 Objectives  

1.1 Introduction  

1.2 Presentation of Content  

1.2.1 Components of Computers  

1.2.2 Evolution of Computers   

1.2.3 Generations of Computers  

1.3 Summary 

1.4 Key Words  

1.5 Self-Assessment Questions (SAQs) 

1.6 References/Suggested Reading 

 

1.0 OBJECTIVES:  
The computer is a major component of Information Technology. Computers influence 

every aspect of life today from small businesses or even satellite launchings. 

Computers are playing very important functions. So it is important that we become 

familiar with the various aspects of computers. In this lesson we shall try to cover 

some introductory aspects of computers.  

The objectives of this lesson are: 

o To Know About the Components of Computers 

o To Understand the Evolution of Computers   



o To Know About the various Generations of Computers 

 

1.1 INTRODUCTION: 
A computer is basically an intelligent machine. When given proper instructions a 

computer can understand what to do with given data and process this data and give 

accurate result. A computer helps generate data. It can store large amount of data 

within a small sized hard disk.  It can process data. In addition, a computer helps in 

retrieval and transmission of data also.  

The most powerful computer is called super computer today, but it does not 

even have 10% capacity of thinking compared to human beings. It means human 

mind is more powerful than 10 supercomputers together.  

The difference between computers and human mind is that the computer 

cannot think rationally. Human mind can think without any boundaries. But a 

computer can do only what it has been instructed to do. The computer can perform a 

job that is tedious and mundane without errors, but the brain behind the computer is 

that of a human. As the popular saying goes, the computer is a GIGO (Garbage In 

garbage Out) machine. If you feed the computer with the garbage you can only 

expect the garbage out of it. The human mind can make sense out of nonsense, but 

the computer can make sense out of sense only. 

 
COMPUTER DEFINED:  
The modern computer can be defined as:  

An electronic machine that is designed to accept data and instructions, store 
the data and instructions, process the data according to instructions to 
produce or store desired results.  
 
1.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Components of Computers  

o Evolution of Computers   

o Generations of Computers  
 
1.2.1 COMPONENTS OF A COMPUTERS:  
A computer performs various functions with the help of the following devices:  



 
INPUT DEVICES:  
The input of human brain is through organs like eyes, ears or nose. Similarly, input to 

the computer is through certain devices like keyboard, mouse, scanner and light pen. 

These devices, which are used to input data and instructions, are called input 

devices.  

Function of Input Devices: The input devices help us to communicate with 

computer by converting human understandable signals and numbers into 

appropriate electric signals.  

Examples of Input devices: Keyboard, Mouse, Light pen, Optical Character Reader 

(OCR), Magnetic Ink Character Reader (MICR), etc.  

 
OUTPUT DEVICES:  
Human beings communicate with each other by talking, writing or drawing, etc. A 

computer communicates through devices like monitor (VDU – Visual Display Unit) 

and printer. These devices, which are used for communication of data and 

information from machine to man, are called output devices.  

Function of Output Devices: The output devices help the computer to 

communicate with us by converting electric signals to human understandable 

signals.  

Examples of Output devices: VDU – Visual Display Unit, Printer, Plotter. The 

output on VDU is called soft copy output whereas output on paper, which is 

produced by printers and plotters are referred to as hard copy output.  

 
CPU (CENTRAL PROCESSING UNIT):  
Now, the human brain has two parts. One, which controls all our actions, and the 

other which stores all the things that are to be remembered. The control center of the 

brain controls our memory capacity. Similarly the control unit of the computer 

controls the data and instructions, which are to be stored or retrieved from its 

memory unit. The human brain also has a logical slot wherein all mental calculations 

are done. Similarly, a computer has an Arithmetic Logic Unit (ALU), which does all 

the calculations and logical functions.  

Central Processing Unit (CPU) has three parts named as control unit, 

arithmetic logical unit and memory unit. Control unit tells to ALU what type of action 



is to be taken on given data or instructions. As well as it controls the data and 

instructions to be stored in memory part and what is to be retrieved from it.  

The memory unit of computer is further divided into Random Access Memory 

(RAM), Read Only Memory (ROM) and Cache Memory. Random Access Memory 

(RAM) is used to store the data and instructions that are currently being processed. 

This memory can be randomly accessed and is also called as Immediate Access 

Memory. The RAM is volatile, i.e. the memory is erased when the power supply is 

cut off. As the name reflects ROM is Read Only Memory and it is written on the time 

of manufacturing of computer. The various types of ROM are EROM, PROM and 

EPROM, etc.  

 
FUNCTIONS OF CPU: Following are the functions of central processing unit:  

o To store data and instructions  

o To control the sequence of operations  

o To carry out data processing and show results  

The CPU fetches the instructions from the memory, decodes the instruction and 

executes the instructions by communicating with the input/output devices and the 

memory units.  

 
1.2.2 EVOLUTION OF COMPUTERS:  
The computer we use today is the result of man’s long search for a device to help in 

performing computations. The search dates back to the 17th century. A series of 

scientific breakthroughs by many persons have contributed to produce this electronic 

machine called computer.  

The word computer is derived from the word “compute”, which means, “to 

calculate”. If we look back to the history of the computers it can be traced back to 

3000 B.C. the Stone Age man used small round stones for counting cattle.  

Later, the Chinese developed a device called Abacus. This is supposed to be the 

first mechanical computing device. 

In 1617, John Napier, a Scottish mathematician developed a device called 

Napier’s bones. With the help of this device, multiplication and addition were 

possible. 

In 1642, Blaise Pascal, a French mathematician invented the first mechanical 

calculator. 



In 1673, Gottfried Wilhelm Leibniz, a German invented the Leibniz calculator 

which was used for addition, subtraction and multiplication. 

A French weaver’s son named Joseph Marie Jacquard made the next 

significant contribution in 1804. After observing his father making different weaving 

patterns on the loom, he thought of storing these patterns for future use. So he 

developed a plate with multiple holes to control the weaving patterns, not knowing 

that one day his idea of storing the weaving patterns would be used to store data 

and would be called the Punch card. 

A Punch Card is a thin rectangular card divided into 80 columns and 12 rows 

in which the various characters could be represented by punching holes in different 

rows and columns. On one card it is possible to punch 80 characters – one character 

per column, thus it is possible to store 80 characters of data.  

Around 1822, Charles Babbage a professor of Mathematics at the Cambridge 

University devised an automatic calculating machine called Difference Engine.  

The next significant invention came from Dr. Herman Hollerith, an American. 

Hollerith built a computer to analyze the Census data of the United States of America 

in 1890. This computer was electro-mechanical and was named the Census 

machine or Hollerith Statistical Tabulator.  

Using this machine Hollerith announced the results of the Census in 2 ½ 

years as compared to 7 ½ years when the processing was done manually. Herman 

Hollerith founded a company named “The Computing Tabulating recording 

Company” which today is the IBM Corporation.  

Howard Aiken built the first fully electromechanical computer named MARK-1. 

In 1945, John Von Neumann, a Frenchman working in IBM, made a 

significant contribution. He designed the basic structure of the computer to include 

the capacity to:  

(i) Perform logic functions.  

(ii) Perform repetitive functions.  

(iii) Store data and instructions. 

 

In 1945, the fully electronic computer named ENIAC was built by Presper Eckert and 

John W Mauchly. ENIAC stands for Electronic Numerical Integrator and calculator.  

The computer has built-in LOGIC, the capacity to make a selection. Logic means 

some rational thinking, like, 2 is bigger than 1. The computer is capable of 



REITERATION or REPETITION. The data and instruction can be stored and 

retrieved using the computer.  

 
1.2.3 GENERATIONS OF COMPUTERS:   
Now, in order to have these three features i.e. to perform logical functions, perform 

repetitive functions and store data and instructions in a computer, certain 

components were made use of, which made a lot of difference in the capacity of the 

computer. So depending on the Technology in use the computers are said to belong 

to different generations.  

 
FIRST GENERATION COMPUTERS (1945-1955):   
In first generation computers the main component in the use was the vacuum tubes 

(like those in the old radios, which warmed up after a minute or so, and glowed red). 

The vacuum tubes were also called as valves. The first computer used 17000 

vacuum tubes, weighed 30 tons and occupied an area of a big hall. Vacuum tubes 

took ages to warm up and consumed massive amounts of electricity. Some of the 

computers of this generation are ENIAC, UNIVAC-1.  

 
Advantages: 

1. Vacuum tube technology made possible the advent of electronic digital 

computers.  

2. These computers were the fastest calculating devices of their time. They 

could perform computations in milliseconds.  

 
Disadvantages:   

1. Too bulky in size  

2. Unreliable  

3. Thousands of vacuum tubes that were used emitted large amount of heat and 

burnt out frequently  

4. Air conditioning required  

5. Prone to frequent hardware failures  

6. Constant maintenance required  

7. Non-portable  

8. Manual assembly of individual components into functioning unit required  



9. Commercial production was difficult and costly  

10. Limited commercial use  

 
SECOND GENERATION COMPUTERS (1955 - 1965):   
The real breakthrough in computers started with the discovery of the transistor. 

Transistor is a tiny semi – conductor device, the size is about 1/50th of a vacuum 

tube, which can perform the same function as that of a large vacuum tube. 

Transistors replaced valves in computers. Some of the computers of this generation 

are: IBM 7000 SERIES, IBM 1620, IBM 1401.  

 
Advantages:  

1. Smaller in size as compared to I Generation Computers.  

2. More reliable  

3. Less heat generated  

4. These computers were able to reduce computational time from milliseconds to 

microseconds  

5. Less prone to hardware failures  

6. Better portability  

7. Wider commercial use  

 
Disadvantages: 

1. Air-conditioning required  

2. Frequent maintenance required  

3. Manual assembly of individual components into functioning unit was required 

4. Commercial production was difficult and costly  

 
THIRD GENERATION COMPUTERS (1965 -1970):   
As the next step, functions of a number of transistors were put together on a single 

chip (wafer) of silicon. These chips are called Integrated circuit (IC) chips. A small 

chip, the size of a fingernail could have equivalent of 200 to 2000 transistors. The 

chip is a small silicon wafer with very minute transistors, which can do logical 

comparisons and calculations. Some chips have been developed for the purpose of 

data storage. These constitute the memory chips. The use of chip technology 



reduced the size of computers. Some of the computers of these generations are: 

IBM 360, IBM 370.  

 
Advantages:  

1. Smaller in size as compared to previous generation computers  

2. Even more reliable than second-generation computers.  

3. Even lower heat generated than second generation computers  

4. These computers were able to reduce computational time from microseconds 

to nanoseconds.  

5. Maintenance cost is low because hardware failures are rare  

6. Easily portable  

7. Totally general purpose. Widely used for various commercial applications all 

over the world  

8. Less power requirement than previous generation computers  

9. Manual assembly of individual components into functioning unit was not 

required  

10. Commercial production was easier and cheaper  

 
Disadvantages:  

1. Air-conditioning required in many cases  

2. Highly sophisticated technology required for the manufacturing of IC chips.  

 
FOURTH GENERATION COMPUTERS (1970 ONWARDS):   
From 1970 onwards we are in the era of IV generation computers, in which the 

electronic component was further miniaturized through Large Scale Integration (LSI) 

of circuits on the silicon chip. Now the advancement of chip technology has come to 

be known as Very large Scale Integration (VLSI), where millions of transistors are 

packed in a single chip. The VLSI chips are refined every day. The size of the chip is 

shrinking and the components, which are packed in a chip, are multiplying. As a 

result the size of a computer is decreasing day by day. What used to be a room 

sized computer at one time is now available as deskTop computer or Laptop 

computer or palmtop computer with much more computational power.  

 
Advantages:  



o Smallest in size because of high component density  

o Very reliable  

o Heat generated is negligible  

o No Air- conditioning required in most cases  

o Much faster in computation than previous generations  

o Hardware failure is negligible and hence minimum maintenance required  

o Easily portable because of its small size  

o Totally general purpose  

o Minimal labor and cost involved at assembly stage  

o Cheapest among all generations  

 
Disadvantages:  

o Highly sophisticated technology required for the manufacturing of VLSI chips.  

 
FIFTH GENERATION COMPUTERS:   
From 1982 onwards research is on to develop a fifth generation computer that will 

have the thinking power just like that of human brain. These computers, which are 

based on Artificial Intelligence (AI), are designed to be “Thinking” computers capable 

of storing large amount of data to be retrieved as and when required to solve a 

problem.  

 

1.3 SUMMARY:  
o A computer is a machine endowed with intelligence. It understands instructions 

and performs a variety of functions. A computer helps generate data. It can store 

large amount of data within a small sized hard disk.  It can process data. In 

addition, a computer helps in retrieval and transmission of data also.  

o The human mind can think without any boundaries while a computer can do only 

what it has been instructed to do. The computer can perform a job that is tedious 

and mundane without errors, but the brain behind the computer is that of a 

human. The human mind can make sense out of nonsense, but the computer can 

make sense out of sense only. 

o The devices in computers, which are used to input data and instructions, are 

called input devices. The input devices help us to communicate with computer by 

converting human understandable signals and numbers into appropriate electric 



signals. Examples of Input devices are: Keyboard, Mouse, Light pen, Optical 

Character Reader (OCR), Magnetic Ink Character Reader (MICR), etc.  

o A computer communicates through devices like monitor (VDU – Visual Display 

Unit) and printer. These devices, which are used for communication of data and 

information from machine to man, are called output devices. The output devices 

help the computer to communicate with us by converting electric signals to 

human understandable signals. Examples of Output devices are: VDU – Visual 

Display Unit, Printer, Plotter. The output on VDU is called soft copy output 

whereas output on paper, which is produced by printers and plotters are referred 

to as hard copy output. 

o The control unit of the computer controls the data and instructions, which are to 

be stored or retrieved from its memory unit. Computere have an Arithmetic Logic 

Unit (ALU), which does all the calculations and logical functions.  

o A Central Processing Unit (CPU) has three parts named as control unit, 

arithmetic logical unit and memory unit. Control unit tells to ALU what type of 

action is to be taken on given data or instructions. As well as it controls the data 

and instructions to be stored in memory part and what is to be retrieved from it. 

o The memory unit of computer is further divided into Random Access Memory 

(RAM), Read Only Memory (ROM) and Cache Memory. Random Access Memory 

(RAM) is used to store the data and instructions that are currently being 

processed. This memory can be randomly accessed and is also called as 

Immediate Access Memory. ROM is Read Only Memory and it is written on the 

time of manufacturing of computer. The various types of ROM are EROM, PROM 

and EPROM, etc. 

o The first generation computers used vacuum tubes as the main component. The 

first computer used 17000 vacuum tubes, weighed 30 tons and occupied an area 

of a big hall. Vacuum tubes took ages to warm up and consumed massive 

amounts of electricity. Some of the computers of this generation are ENIAC, 

UNIVAC-1.  

o Second generation computers used transistors - tiny semi conductor devices, 

which could perform the same function as that of a large vacuum tube. Some of 

the computers of this generation are: IBM 7000 SERIES, IBM 1620, IBM 1401.  

o These computers used silicon chips, called Integrated circuit (IC) chips. A small 

chip, the size of a fingernail could have equivalent of 200 to 2000 transistors. The 



chip is a small silicon wafer with very minute transistors, which can do logical 

comparisons and calculations. Some of the computers of these generations are: 

IBM 360, IBM 370.  

o The fourth generation computers have highly miniaturized electronic component 

on silicon chips. Now through advancements in chip technology known as Very 

large Scale Integration (VLSI), millions of transistors are packed in a single chip. 

The VLSI chips are refined every day. As a result the size of a computer is 

decreasing day by day. What used to be a room sized computer at one time is 

now available as deskTop computer or Laptop computer or palmtop computer 

with much more computational power.  

o The fifth generation computers will have the thinking power just like that of human 

brain. These computers are based on Artificial Intelligence (AI). These are 

designed to be “thinking computers”.  

 

1.4 KEY WORDS:  
Computers: A computer is basically an intelligent machine. When given proper 

instructions a computer can understand what to do with given data and process this 

data and give accurate result. A computer helps generate data. It can store large 

amount of data within a small sized hard disk.  It can process data. In addition, a 

computer helps in retrieval and transmission of data also.  

Computer Defined: A computer is an electronic machine designed to accept data 

and instructions, store the data and instructions, process the data according to 

instructions to produce or store desired results. 

Input Devices: The input of human brain is through organs like eyes, ears or nose. 

Similarly, input to the computer is through certain devices like Keyboard, Mouse, 

Light pen, Optical Character Reader (OCR), Magnetic Ink Character Reader (MICR), 

etc. The input devices help us to communicate with computer by converting human 

understandable signals and numbers into appropriate electric signals. 

Output Devices: Human beings communicate with each other by talking, writing or 

drawing, etc. A computer communicates through devices like monitor (VDU – Visual 

Display Unit) and printer. These devices, which are used for communication of data 

and information from machine to man, are called output devices. The output devices 

help the computer to communicate with us by converting electric signals to human 

understandable signals.  



Central Processing Unit: The Central Processing Unit (CPU) of a computer controls 

the data and instructions, which are to be stored or retrieved from its memory unit. 

The Central Processing Unit (CPU) has three parts named as control unit, arithmetic 

logical unit and memory unit. Control unit tells to ALU what type of action is to be 

taken on given data or instructions. As well as it controls the data and instructions to 

be stored in memory part and what is to be retrieved from it. 

Memory Units: The memory unit of computer is further divided into Random Access 

Memory (RAM), Read Only Memory (ROM) and Cache Memory. Random Access 

Memory (RAM) is used to store the data and instructions that are currently being 

processed. This memory can be randomly accessed and is also called as Immediate 

Access Memory. ROM is Read Only Memory and the various types of ROM are 

EROM, PROM and EPROM, etc. 

First Generation Computers: In first generation computers, the main component in 

the use was the vacuum. The first computer used 17000 vacuum tubes, weighed 30 

tons and occupied an area of a big hall. Vacuum tubes took ages to warm up and 

consumed massive amounts of electricity. Some of the computers of this generation 

are ENIAC, UNIVAC-1.  

Second Generation Computers: In second generation computers, the main 

component in the use was the transistor. Transistor is a tiny semi–conductor device, 

the size is about 1/50th of a vacuum tube, which can perform the same function as 

that of a large vacuum tube. Transistors replaced valves in computers. Some of the 

computers of this generation are: IBM 7000 SERIES, IBM 1620, IBM 1401.  

Third Generation Computers: These computers used silicon chips, called 

Integrated circuit (IC) chips. A small chip, the size of a fingernail could have 

equivalent of 200 to 2000 transistors. The chip is a small silicon wafer with very 

minute transistors, which can do logical comparisons and calculations. Some chips 

have been developed for the purpose of data storage. These constitute the memory 

chips. The use of chip technology reduced the size of computers. Some of the 

computers of these generations are: IBM 360, IBM 370.  

Fourth Generation Computers: The fourth generation computers have highly 

miniaturized electronic component on silicon chips. Now through advancements in 

chip technology known as Very large Scale Integration (VLSI), millions of transistors 

are packed in a single chip. The VLSI chips are refined every day. As a result the 

size of a computer is decreasing day by day. From room sized computers, now we 



have Desk Top Computers to LapTop Computers or PalmTop Computers with much 

more computational power.  

Fifth Generation Computers: The fifth generation computers will have the thinking 

power just like that of human brain. These computers are based on Artificial 

Intelligence (AI). These are designed to be “thinking computers”. 

 

1.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
1. What are the the various components of a computer? Discuss in detail.  

2. Discuss the functions of the central processing unit in detail.  

3. Write a detailed note on the history and evolution of computers.  

4.  Discuss in detail the major changes in the different generations of computers.  
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LESSON STRUCTURE:  
In this lesson we shall discus about the classification of computers. First, we shall 

focus on how computers are classified on the basis of computational methods. We 

shall also briefly discuss classification of computers on the basis of size and 

capability. Next we shall discuss about the components of computers. The lesson 

structure shall be as follows:  

2.0 Objectives  

2.1 Introduction  

2.2 Presentation of Content  

2.2.1 Classification of Computers  

2.2.2 Classification of Computers on Computational Methods    

2.2.3 Classification of Computers on Size and Capability   

2.2.4 Components of Computers 

2.3 Summary 

2.4 Key Words  

2.5 Self-Assessment Questions (SAQs) 

2.6 References/Suggested Reading 

 

2.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Know About the Classification of Computers 

o To Understand the Classification of on Computational Methods  

o To Understand the Classification of Computers on Size and Capability   

o To Know About the Various Components of Computers 

 



2.1 INTRODUCTION: 
Computers are intelligent machines. We give relevant instructions to a computer, 

and a computer will do what it is instructed to do. A computer helps us generate 

data. It has the capacity to store vast amounts of data within a small sized hard disk. 

Computers process data. Also computers help in retrieval and transmission of data.  

Computers are classified according to size, make, processing power, etc. In 

this lesson, we shall discuss about the classification of computers.  

 
2.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Classification of Computers  

o Classification of on Computational Methods  

o Components of Computers  

o Generations of Computers  
 
2.2.1 CLASSIFICATION OF COMPUTERS:   
Human mind can think without any boundaries. Human minds think rationally. But a 

computer can do only what it has been instructed to do. The computer can perform a 

job that is tedious and mundane without errors, but the brain behind the computer is 

that of a human.  

However, computers have emerged as very efficient and powerful tool that 

perform a wide variety of functions. A wide variety of computers are available in the 

market. These computers perform different functions. There are big computers. 

There are small computers. The most powerful computer is the super computer. 

Then there are mainframe computers. There are mini computers also.  

Earlier there were analogue computers. The computers we have these days 

are digital computers. Let us now discuss about these classification of computers in 

detail.  

Computers can be classified in following manner:  

o Computational Method  

o Sizes and Capability  

 
2.2.2 CLASSIFICATION OF COMPUTERS ON COMPUTATIONAL METHOD:   
On the basis of computations computer can be classified in to three types as follows:  



o Digital Computers  

o Analog Computers  

o Hybrid Computers  

 
DIGITAL COMPUTERS:  
A digital computer can count and accept numbers and letters through various input 

devices. The input devices convert the data into electronic pulses and perform 

arithmetic operations on numbers in discrete form. In addition to performing 

arithmetic operations, they are also capable of:  

o Storing data for processing  

o Performing logical operations  

o Editing and deleting the input data  

 

One of the main advantages in the use of digital computer is that any desired level of 

accuracy can be achieved. The main disadvantage is their higher cost. 

 
ANALOG COMPUTERS:  
Analog computers process data input in a continuous form. Data are represented in 

the computer as a continuous, unbroken flow of information, as in engineering and 

scientific applications. The main disadvantages of an analog computer are the 

accuracy factor and limited storage capacity. Hence it is not suitable for processing 

business data.  

 
HYBRID COMPUTERS:  
Computer can also be built using some parts employing digital computations and 

some parts based on analog principles. Such computers are called hybrid 

computers.  

 
2.2.3 CLASSIFICATION OF COMPUTERS ON SIZE AND CAPABILITY:   
Computers are also classified on the basis of size and capability. Computers, 

particularly digital computers, are classified as:  

o Super Computers  

o Mainframe Computers  

o Mini Computers  



o Micro Computers  

 
SUPER COMPUTERS:   
These are largest and fastest computers available. Super Computers are typically 

not used for commercial data processing. Instead they are used in specialized areas 

such as in defense, aircraft design, computer generated movies, weather 
research etc.  

The first Super Computer was ILLIAC IV made by Bur Roughs. Other 

manufacturers of Super Computer are CRAY, CDC and NEC, etc.  

Super Computers can process 64 bits or more at a time. Their processing 

speed ranges from 10,000 million instructions per second (MIPS) to 1.2 billion 

instructions per sec. They can support 10,000 terminals at a time. They have huge 

numbers of storage and other devices connected to them.  

 
MAINFRAME COMPUTERS:   
Mainframe computers are less powerful and cheaper than Super Computers. 

However, they are very large in size. These are general-purpose computers capable 

of handling all types of scientific and business applications.  

Mainframe computers can process several million instructions per second. A 

Mainframe computer can handle more than 1,000 remote terminals. Mainframe 

computers have vast on-line secondary storage capacity.  

A number of different types of peripheral devices like magnetic tape drives, 

hard disk drives, etc. can be attached with Mainframe computers.  

 
MINI COMPUTERS:   
Mini computers perform data processing activities in the same way as the mainframe 

computers but on a smaller scale. The costs of Mini computers are lower. A Mini 

computer is smaller than that of Mainframe computers.  

A mini computer can support 10 to 12 terminals. The most popular mini 

computers are Nova, Dec, PDP_II and IBM series of computers.  

 
MICRO COMPUTERS:    



These are the smallest category of computers, consisting of a microprocessor and 

associated storage and input/output devices. These are also called as Personal 

Computer Systems.  

Microcomputers were first available in 1970’s, when it became possible to put 

the entire circuitry of computer into a small silicon chip.  

The first PC introduced was IBM-PC.  

 
2.2.4 COMPONENTS OF COMPUTERS:  
We can broadly classify hardware components of computers into following two types:  

o Central Processing Unit (CPU)  

o Peripheral Devices connected to and controlled by the CPU  

 

CENTRAL PROCESSING UNIT (CPU):   
A Central Processing Unit controls the execution of programmes and performs the 

calculations. The CPU is also called as the brain of the computer. This is because 

the CPU controls execution of any task by a computer. A CPU consists of of the 

following units:  

o Arithmetic Logic Unit  

o Control Unit  

o Memory Units  

 
Arithmetic Logic Unit (ALU):   
Arithmetic Logic Unit does the operations on the data stored in the memory. This 

part of CPU contains a large number of electronic circuits used to carry out 

Arithmetic and logical computations. These computations are carried out with the 

help of special purpose storage locations, called the registers. There are basically 

three types of registers in an ALU   

o Storage Registers  

o Accumulator  

o Arithmetic and Logical Operation Unit  

 
Storage Registers:  

It temporarily holds data during execution of the programs. These are helpful in 

getting work done by a computer. For example, suppose data stored in two locations 



are to be interchanged. Then a third entity is required to hold the data temporarily. If 

the two locations are named x and y, then one can temporarily fetch x and keep it in 

z. Then y may be fetched and transferred to x. in the third step, z may be copied to y. 

this third entity z may be a third location or a storage register.  

 
Accumulators:  

An accumulator holds the result of the calculations until needed later on. Operations 

are mostly carried out in two operands like we say, add x to y. Here x and y are 

operands. If in a computer instruction, always two operands are provided, then there 

will be requirement of more number of bits to express two operands. Computers are 

normally provided with a register called accumulator, so that in all operands this 

accumulator is assumed by the ALU as a default location for one of the operands. 

 
Arithmetic and Logic Operation Unit  (ALU):  

It receives the data from two or more sources, performs the Arithmetic and logic 

operation unit and transfers the result to the accumulator. The Adder is an important 

component in ALU. In any case a computer performs all operations (subtraction, 

multiplication and division) through additions. 

 
CONTROL UNIT:    
The Control Unit contains that portion of the CPU, which controls each operation 

while a program is being executed. You must have noticed that many times you keep 

a book open with your eyes fixed on it. But you don’t read a single word. This is 

because the control unit of your brain was not allowing your eyes to give any input at 

that time. Possibly control unit of your brain was processing something else.  

Control Unit synchronizes operations of the CPU for ensuring correct execution of 

programs. Control Unit has a special register called the program counter, which 

contains the address of the next instruction to be fetched from the primary memory. 

In order to sequence the instructions, the control unit goes through the following 

sequence of steps:  

o Retrieve the instruction from the processor memory addressed by the 

program counter.  

o Increment the program counter  

o Determine what action is being requested by the instruction.  



o Retrieve the appropriate data from the processor memory.  

o Direct the CPU components to perform the operations indicated by the 

instruction.  

o Determine if the operation was carried out properly, if not, flag the error 

message to the user, through the output device.  

o Else, store the result in the CPU memory, for further processing.  

o Determine the location of the next instruction to be retrieved.  

 
MEMORY UNITS:    
Primary storage section, also called as main memory, is that portion of the computer 

where data and instructions get stored when a program is being executed. The main 

memory is used to:  
o Hold data received from input devices and keep them ready for processing. 

o Hold data being processed and intermediate results being generated therein.  

o Hold the finished results of processing until released to the output devices. 

o Hold the system software and application software in use.  

 
Main Memory is broadly classified into two types:  

o Random Access Memory (RAM)   

o Read Only Memory (ROM)  

 
Random Access Memory (RAM):    
The memory where both reading and writing can take place is called Random 

Access Memory (RAM). By Technology RAM may be of two types:  
o Static RAM  

o Dynamic RAM  

 
Static RAM: Static RAM elements, once set to their values, do not lose them if the 

power supply does not go off. Once some value is stored, it will remain in the main 

memory till the power is on. These elements are costly and have a fast access.  

 
Dynamic RAM: In dynamic RAM the memory elements have less retention period 

and loose its value unless it is refreshed. Refreshing is a process where the RAM is 

read and rewritten. This kind of RAM requires extra circuits for refreshing. These are 



relatively slow but less costly compared to the Static RAMs. This kind of memory is 

therefore used in mass scale. Both of these are volatile i.e., the moment power goes 

off all contents of RAM are lost.  

 
Read Only Memory (ROM):    
There are portions in the computer memory where no writing is allowed. The 

contents are pre-written and can only be read. Such memories are called Read Only 

Memory (ROM). It is used for micro programs not available to normal programmers. 

The term read only means that the storage cannot be altered by regular program 

instructions. The information from the memory may be read out but fresh information 

cannot be written in to it. The micro programs in Read Only Memory (ROM) may be 

used for a variety of purposes, but a common use is to hold a set of instructions that 

are needed frequently, for executing small, extremely basic operations, which are not 

otherwise available in computer circuitry.  

ROM can be classified technologically into 2 types:  

o Programmable ROM  

o Erasable Programmable ROM  

 
Programmable ROM or PROM:    

Are those in which the user can insert the contents of choice only once? Once the 

PROM is written, it can only be read and never be re-written.  

 
Erasable Programmable ROM or EPROM:    

As the name suggests, it can be written many times by a special process. These are 

very useful for design and development.  

 
PERIPHERAL DEVICES ATTACHED TO COMPUTERS:  
There are quite a few peripheral devices connected to a computer and controlled by 

the CPU. There is several input and output devices, which are connected to CPU 

and are, controlled by the CPU. These are: 

o Input Devices, and  

o Output Devices   

 

INPUT DEVICES:   



The input devices are used to input data and instruction. Data and instructions must 

be entered into the memory of the computer to perform computations. Input devices 

carry out this task. Data read by input devices are of different forms, depending upon 

the form of input entity.  

 
Function of Input Devices:    

o Accept the data from outside world.  

o Convert the data into the corresponding ASCII code or binary form.  

o Send data in binary form to the computer for further processing.  

 
Input Devices include the following:    

o Keyboard  

o Pointing Device  

o Mouse  

o Joystick and Tracker Ball  

o Scanner  

 
Keyboard: A keyboard is the most common input device. It is used to input data 

manually by typing. The computer keyboard is like a typewriter keyboard with some 

extra special keys called function keys and controls keys, which can be programmed 

by the user according to his needs. This means that if you write a program, you 

might tell the computer to perform a specific action when a function/ control key is 

pressed.  

The keyboard is connected with the main system through cable. When a key 

is pressed or released, unique scan code is sent from the keyboard electronics to the 

system. The keyboard interface electronics generates the corresponding ASCII code 

for the key depressed.  

 
Mouse: Mouse is basically a pointing device. This is also an input device, but 

instead of sending characters, it sends the coordinates of the point on the screen on 

which the associated cursor is placed. A cursor is specially illuminated character on 

screen, which shows the place of selection for data entry or menu selection or a 

similar kind of thing.  



The mouse is placed on a flat surface and is moved by the user on this 

surface. It has a roller underneath, which when moved, sends signals to the interface 

electronics to move the cursor the same way as the mouse is moved. There may be 

two or three buttons on the mouse. By pressing a button, the user can point the 

selection to the system. The right mouse button is normally used for displaying and 

selecting pop-up menus.  

The mouse may be used to draw diagrams on the screen, to select one from 

a group of choices, or to place the cursor at any specific point on the screen. It 

cannot be used to enter data, the way it can be done using a keyboard. A mouse is a 

must in a graphical user interface, namely Windows. A mouse is must in these days 

as it speeds up the navigation in Graphical User Interface (GUI) packages and most 

packages today are GUI based.  

 
Joystick and Tracker Ball: Both of these are pointing devices and are used for the 

same purpose as a mouse. In joystick, a stick can be moved right, left, forward or 

backward. The electronics in the joystick measures the movement of the stick from 

its central position and sends the information for processing.  

The joystick is normally used for gaming programs. The tracker ball has a ball 

that can be rotated by hand in any direction. The cursor moves accordingly. It is 

normally used in medical computers like brain and body scanners etc.  

 
Scanner: The scanner captures the entire information of an image directly from the 

source and stores it in graphic format for displaying back on the screen. A scanner 

first illuminates the page in to an optical image, which is then converted into a digital 

format, for storage by the computer. The graphic image can then be processed using 

suitable software. For example: if an image is stored as bitmap (BMP) file, it can be 

modified using MS-paint.  

 
OUTPUT DEVICES:    
The job of an output device is to bring out the result of computation to the outside 

World. As you know result in the computer is in the form of Binary. So the binary 

values are converted to human acceptable forms, with the help of output devices. 

The following functions may be attributed to the output device:  



o Accept data in binary form from the computer, which are normally not 

understandable by the human beings.  

o Convert coded data to human acceptable form.  

o Output the converted result to the outside World.  

 

Some of the commonly used output devices are  

o Video Display Unit  

o Printer  

o Plotter  

 
Video Display Unit /Visual Display Unit: You must, have noticed a TV-like screen 

connected to the computer. This is called Video or Visual Display Unit (VDU) or 

Monitor. It works on similar principles as a TV and displays graphics and characters 

on its screen. The screen consists of several tiny points called picture points or 

pixels, which can be illuminated by highly focused electron beam. Output on screen 

is called soft copy. 

 
Printers: Printers are popular output devices. The output information is in a 

permanent readable form and is called the hard copy. Printers may be classified as:  

o Character Printers  

o Line Printers  

o Page Printers  

A character Printer prints one character at a time. E.g.: Dot Matrix Printer.  

Line Printer would print one line of text at a time. E.g.: Chain or Drum Printer.  

A Page Printer would print a complete page at a time. E.g.: Laser Printer.  

 

Printers are also classified as:  

o Impact Printers  

o Non-Impact Printers  

Impact Printers use electromechanical mechanism to cause hammers or pin stud, to 

strike against a ribbon and paper arrangement. Dot Matrix, Chain, Drum Printer are 

examples of Impact Printers. The Non-Impact Printers do not have any mechanism 

to strike. It uses the chemical, thermal, electrostatic, laser beam or inkjet technology 

for printing. Non-impact types are normally faster than the impact printers.  



 
Plotters: These are output devices and are used to produce high-resolution graphics 

and drawings by computers. The plotters use ink pen to draw. Color pens are also 

utilized.  

 
HARDWARE:    
The devices, which are tangible, are called hardware devices. These include: CPU 

(Central Processing Unit), Keyboard, Mouse, and VDU, etc.  

 
SOFTWARE:    
These are those components, which are non-tangible. Software can be classified 

into following categories:  

o System Software  

o Application Software  

o Utilities  

 
System Software: It is collection of programs designed to operate, control and 

extend the processing capability of the computer system itself. System software 

consists of low-level language that interacts with the computer at a very basic level. 

System software comes along with the computer system. These programs are used 

for starting the computer, controlling and managing its resources, converting high 

level language to machine level language or for some specific purpose. A system 

software can be classified into: 

o Operating System (Unix, MS-DOS, Windows 95/98/NT)  

o Translator (C, Cobol, Fortran)  

o System utilities (Virus scanning and cleaning software)  

 
Application Software: Application software is software, which has been developed 

to computerize an activity. We can say application software sits on the top of the 

system software because it is unable to run without operating system and system 

utilities.  

Application software can be developed using a computer language.  



Generally these are developed in high-level languages such as COBOL, C 

and VISUAL TOOLS etc. Examples include: Financial accounting, Payroll 

Accounting and Banking etc.  

 
Utilities Programmes: Utilities are programs, which perform a specific function. 

Often utilities are part of system programmes. These are generally provided by the 

computer manufacturer and also available for call up by operating system. These 

programs help the user to do common jobs, like, copying a file, comparing a file etc.  

 

2.3 SUMMARY:  
o Computers are intelligent machines. We give relevant instructions to a 

computer, and a computer will do what it is instructed to do. A computer helps 

us generate data. Computers process data. Also computers help in storage, 

retrieval and transmission of data. Computers are classified according to size, 

make, processing power, etc.  

o Computers are very efficient and powerful tool that perform a wide variety of 

functions. A wide variety of computers are available in the market. These 

computers perform different functions. There are big computers. There are 

small computers. The most powerful computer is the super computer. Then 

there are mainframe computers. There are mini computers also. Earlier there 

were analogue computers. The computers we have these days are digital 

computers.  

o A digital computer can count and accept numbers and letters through various 

input devices. The input devices convert the data into electronic pulses and 

perform arithmetic operations on numbers in discrete form.  

o One of the main advantages in the use of digital computer is that any desired 

level of accuracy can be achieved. The main disadvantage is their higher 

cost. 

o Analog computers process data input in a continuous form. Data are 

represented in the computer as a continuous, unbroken flow of information, as 

in engineering and scientific applications. The main disadvantages of an 

analog computer are the accuracy factor and limited storage capacity. Hence 

it is not suitable for processing business data.  



o Computer can also be built using some parts employing digital computations 

and some parts based on analog principles. Such computers are called hybrid 

computers.  

o These are largest and fastest computers available. Super Computers are 

typically not used for commercial data processing. Instead they are used in 

specialized areas such as in defense, aircraft design, computer generated 

movies, weather research etc.  

o Mainframe computers are less powerful and cheaper than Super Computers. 

However, they are very large in size. These are general-purpose computers 

capable of handling all types of scientific and business applications.  

o Mini computers perform data processing activities in the same way as the 

mainframe computers but on a smaller scale. The costs of Mini computers are 

lower. A Mini computer is smaller than that of Mainframe computers.  

o Micro Computers are the smallest category of computers, consisting of a 

microprocessor and associated storage and input/output devices. These are 

also called as Personal Computer Systems.  

 

2.4 KEY WORDS:  
Computers: Computers are intelligent machines. We give relevant instructions to a 

computer, and a computer will do what it is instructed to do. A computer helps us 

generate data. It has the capacity to store vast amounts of data within a small sized 

hard disk. Computers process data. Also computers help in retrieval and 

transmission of data. Computers are classified according to size, make, processing 

power, etc.  

Classification of Computers: On the basis of computations computer can be 

classified in to three types as follows: digital computers, analog computers, and 

hybrid computers.   

Digital Computers: A digital computer can count and accept numbers and letters 

through various input devices. The input devices convert the data into electronic 

pulses and perform arithmetic operations on numbers in discrete form. In addition to 

performing arithmetic operations, they are also capable of: storing data for 

processing, performing logical operations, and editing and deleting the input data. 

One of the main advantages in the use of digital computer is that any desired level of 

accuracy can be achieved. The main disadvantage is their higher cost. 



Analog Computers: Analog computers process data input in a continuous form. 

Data are represented in the computer as a continuous, unbroken flow of information, 

as in engineering and scientific applications. The main disadvantages of an analog 

computer are the accuracy factor and limited storage capacity. Hence it is not 

suitable for processing business data.  

Hybrid Computers: Computer can also be built using some parts employing digital 

computations and some parts based on analog principles. Such computers are 

called hybrid computers.  

Super Computers: These are largest and fastest computers available. Super 

Computers are typically not used for commercial data processing. Super Computers 

can process 64 bits or more at a time. Their processing speed ranges from 10,000 

million instructions per second (MIPS) to 1.2 billion instructions per sec. They can 

support 10,000 terminals at a time. They have huge numbers of storage and other 

devices connected to them.  

Mainframe Computers: Mainframe computers are less powerful and cheaper than 

Super Computers. However, they are very large in size. These are general-purpose 

computers capable of handling all types of scientific and business applications. 

Mainframe computers can process several million instructions per second. A 

Mainframe computer can handle more than 1,000 remote terminals. Mainframe 

computers have vast on-line secondary storage capacity.  

Mini Computers: Mini computers perform data processing activities in the same way 

as the mainframe computers but on a smaller scale. The costs of Mini computers are 

lower. A Mini computer is smaller than that of Mainframe computers. A mini 

computer can support 10 to 12 terminals. The most popular mini computers are 

Nova, Dec, PDP_II and IBM series of computers.  

Micro Computers: These are the smallest category of computers, consisting of a 

microprocessor and associated storage and input/output devices. These are also 

called as Personal Computer Systems. Microcomputers were first available in 

1970’s, when it became possible to put the entire circuitry of computer into a small 

silicon chip. 

 

2.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
1. Discuss the various bases on which computers are classified.  

2. Discuss how computers are classified in the basis of computational methods.  



3.  Discuss how computers are classified in the basis of size and computing 

capacities.  

4. Write a detailed note on the various components of computers.  
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3.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Know About the Principles of Communication Systems  

o To Understand the Principles of Digital Communication  

o To Know About the Levels of Digital Communication  

o To Learn the Advantages of Digital Communication  

 

3.1 INTRODUCTION: 
Digital communication has become important with the expansion of the use of 

computers and data processing. And it has continued to grow providing the 

interconnection of computer peripherals and transmission of data between distant 

sites.  

With the requirements of higher and higher speeds of data transmission, the 

importance of digital communication techniques has also increased. As a result, the 

channel (the medium of data transfer) and its characteristics, Bandwidth, frequency, 

noise, distortion, transmission speed, types of coding, etc., have become very 

common terms.  

  
3.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Principles of Communication Systems  

o Principles of Digital Communication  

o Levels of Digital Communication  
o Advantages of Digital Communication  

 
3.2.1 PRINCIPLES OF COMMUNICATION SYSTEM:  
The goal of a communication system is to transfer information from one place to 

another. This is generally done by sending the information as electromagnetic 

energy through vacuum, air, wire, or strands of optical fibers.  

All Communication systems have at least two endpoints. At one end, there is 

a source of signals (a voice, video or other kinds of computer data), a circuitry for 

converting the signal source into a signal that is compatible with the rest of the 

system, and a transmitter that puts the converted signal onto the communications 

pathway or link (wire, air, or an optical fiber).  



After the transmitted signal passes through this link, it is received by the far 

end, converted into signal format as required, and finally passed to the user. 

 
TYPES OF COMMUNICATION SYSTEMS:   
Communication systems can be broadly divided into analog and digital systems. In 

an analog system, the electrical waveform carries the information as a replica of the 

information signal.  

In digital systems, by contrast, the electrical waveforms are coded 

representations of the original information. Pressing the letter A on a computer 

Keyboard will generate a signal, usually a series of binary pulses, that is a code for 

the letter A. Alternatively, the code could be a single discrete voltage level. But 

binary pulses have the advantage of being more easily distinguishable in the 

presence of noise and interference.  

Thus, for a string of letters such as a Tele text transmission, a data sequence 

generated is a coded representation of the information rather than an analog of the 

information signal. If the original information is an analog signal such as the output of 

a microphone this must be converted into a series of discrete values that can then be 

transmitted digitally.  

The process of converting the original information into a data sequence is 

referred to as source encoding. Whatever the original source of information, text, 

speech, or the like, the most commonly used coding scheme is binary digital in which 

the message appears as a binary sequence such as…0110011. For transmission 

purpose, this has to be converted to a continuous electrical waveform. The 

conversion process is referred to as modulation. These waveforms are analog 

representation of binary data.  

 
3.2.2 PRINCIPLES OF DIGITAL COMMUNICATION:   
In a basic digital computer system the source encoder converts the information into 

binary code; each source code; each source code word then represents one of the 

discrete levels at the input. If the input is an analog waveform, part of the job of the 

source encoder is to first digitize this.  

The next function showed is that of channel encoding, which generates 

channel code words from the source code words. Certain bit patterns in the source 

code words may be troublesome to transmit, and one function of channel encoding is 



to change these. Another function of channel encoding is to alter the source code 

words in a controlled manner in order to combat noise-induced errors at the 

receiving end.  

For transmission, a continuous waveform is modulated by the channel code 

words, this being the function of the modulator. The modulated waves in such cases 

are referred to as band-pass waveforms. Band-pass waveforms are required for 

radio transmission. The modulated continuous wave may also be simply a change, 

for example the univocal and bipolar waveforms. These are referred to as base band 

waveforms, and they are suitable for transmission over the transmission lines.  

The waveforms, whether base band or band pass, are referred to as digital 

waveforms or digital signals, although in fact they are continuous waveforms that are 

analog representations of the channel code words. Referring to them as digital 

waveforms does make clear the distinction between this mode of analog 

transmission and analog communications, in which information such as speech is 

transmitted in analog rather than digitally encoded form.  

To recover the information contained in the transmitted waveforms, the 

receiver must have decoding functions corresponding to the encoding functions at 

the transmitter. In addition, in what are termed self-synchronizing systems? The 

receiver requires circuitry to recover correct bit timing and, in the case of band-pass 

system, the carrier frequency.  

In any communications system, both the user at the sending end and the user 

at the receiving end must agree on many factors for successful and meaningful 

communication to occur. These factors include what signals are used, the way the 

message is coded, the meaning of symbols within the message and the type of 

modulation used. This applies to analog as well as to digital systems. In digital 

systems there are many more thing that can be changed and agreed upon, and that 

contribute to better system performance. In contrast an analog system has relatively 

few things that can be change, beyond adjusting the signal level, filtering and 

selecting the modulation parameters.  

 
3.2.3 LEVELS OF DIGITAL COMMUNICATION:    
Communication is a multiple-level or multiple activities. In communication between 

people, there are rules to follow to ensure that each person has a chance to speak, 

to interrupt, to finish. This is called the protocol of communications. Communications 



systems also have protocols that specially define how the communication is to start, 

finish, and recover form problems (Such as due to noise or equipment failure). How 

the receiver is to indicate if a message was received properly and without error; and 

what to do if an error is detected.  

The next-to-highest level is the coding, which defines how initial data will be 

sent and transformed into the symbols that represent it, before being actually 

transmitted with these specific signal values. One level below is the format, which is 

responsible for adding additional information about the message, such as who it is 

for, how long helps the receiver determine if the message, as received contains any 

errors. At the lowest level are the specific voltages (or currents or frequencies) used 

in modulation to represent the digital information.  

 
BANDWIDTH:    
Bandwidth is the span of frequencies within the spectrum occupied by a signal and 

used by the signal for conveying information. For example voice has a bandwidth of 

3 to 4 kHz. Audio signal (speech and music) has 15kHz, where as video requires a 

bandwidth of 5MHz. The bandwidth is an important parameter in communication and 

it depends on the type of signal or type of application, the amount of information to 

be Communicated and the time in which the information is to be communicated.  

To convey more information in short time we need more bandwidth. The same 

quantity of information can be sent in a longer period using less bandwidth. Similarly 

to convey voice signal we need less bandwidth and to convey video it requires more 

bandwidth and so on.  

 
INFORMATION TRANSFER RATE:    
The bit has been defined as the basic unit of information in digital binary system. The 

speed at which information is transferred from one computer or terminal to another in 

a digital system called the information transfer rate or bit rate, and is measured in 

bits/sec. Thus, for example if 10 bits gets transferred in 10ms the information transfer 

rate is 10bits/10ms=1000bits/s or that is equal to 1kbps.  

You must have seen the specification on your MODEM as 24 kbps, 33.kbps 

or 56kbps. Now you understand what it means.  

 
SIGNAL RATE (BAUD):  



The baud rate or signaling rate is defined as the number of symbols per second. The 

baud rate specifies how fast signal states are changing in the communication 

channel and is measured in symbols per second or baud. In a purely binary system, 

where one symbol represents one bit, the bit rate and baud rate are equal. The 

grouping of bits leads to the difference bit rate and baud rate.  

For a multiple level digital signals, a symbol represents a group of two or more 

bits. Therefore on a transmission line a signal transition represents multiple bits. 

Thus, a distinction must be made between the end-to-end information rate and the 

rate at which the signal transmission takes place-the baud rate or signaling rate FB. 

For example, in a four digital signal each digital level corresponds to two-bit data 

group. Now each symbol represents two bits and effective information rate is twice 

the signaling rate or baud rate.  

A 1000-baud signal using four levels (two bit symbols) is transferring information 

at a rate of 2000 bits/sec. Similarly, if the system uses eight levels (3 bit symbol), a 

1000 baud represents an information rate of 3000 bits/sec.  

 
3.2.4 ADVANTAGES OF DIGITAL COMMUNICATION:    
Here are the advantages of digital technology:  

o Digital communication provides greater immunity to noise when compared 

with the Analog communication. It also provides various means of detecting 

and correcting the errors occurred during the process of transmission of the 

signals. Digital signals, which are inherently compatible with computers, have 

a potential to be stored, retrieved, processed and manipulated for signal 

enhancement and improved performance.  

o Using Digital communication it is easy to integrate diverse source of 

information into a common format.  

o High degree of security of information can be maintained in the course of 

transmission by proper encryption of the data. This is of great importance in 

applications like military communication.  

 

3.3 SUMMARY:  
o All Communication systems have at least two endpoints. At one end, there is 

a source of signals (a voice, video or other kinds of computer data), a circuitry 

for converting the signal source into a signal that is compatible with the rest of 



the system, and a transmitter that puts the converted signal onto the 

communications pathway or link (wire, air, or an optical fiber). After the 

transmitted signal passes through this link, it is received by the far end, 

converted into signal format as required, and finally passed to the user. 

o Communication systems can be broadly divided into analog and digital 

systems. In an analog system, the electrical waveform carries the information 

as a replica of the information signal. In digital systems, by contrast, the 

electrical waveforms are coded representations of the original information. 

o Communication systems can be broadly divided into analog and digital 

systems. In an analog system, the electrical waveform carries the information 

as a replica of the information signal.  

o In digital systems, by contrast, the electrical waveforms are coded 

representations of the original information.  

o Bandwidth is the span of frequencies within the spectrum occupied by a signal 

and used by the signal for conveying information. For example voice has a 

bandwidth of 3 to 4 kHz. Audio signal (speech and music) has 15kHz, where 

as video requires a bandwidth of 5MHz. The bandwidth is an important 

parameter in communication and it depends on the type of signal or type of 

application, the amount of information to be Communicated and the time in 

which the information is to be communicated.  

o The bit has been defined as the basic unit of information in digital binary 

system. The speed at which information is transferred from one computer or 

terminal to another in a digital system called the information transfer rate or bit 

rate, and is measured in bits/sec. Thus, for example if 10 bits gets transferred 

in 10ms the information transfer rate is 10bits/10ms=1000bits/s or that is 

equal to 1kbps.  

o The baud rate or signaling rate is defined as the number of symbols per 

second. The baud rate specifies how fast signal states are changing in the 

communication channel and is measured in symbols per second or baud. In a 

purely binary system, where one symbol represents one bit, the bit rate and 

baud rate are equal. The grouping of bits leads to the difference bit rate and 

baud rate.  

o Digital communication provides greater immunity to noise when compared 

with the Analog communication. It also provides various means of detecting 



and correcting the errors occurred during the process of transmission of the 

signals. Digital signals, which are inherently compatible with computers, have 

a potential to be stored, retrieved, processed and manipulated for signal 

enhancement and improved performance. 

 

3.4 KEY WORDS:  
Types of Communication Systems: Communication systems can be broadly 

divided into analog and digital systems. In an analog system, the electrical waveform 

carries the information as a replica of the information signal.  

In digital systems, by contrast, the electrical waveforms are coded representations of 

the original information. 

Bandwidth:  Bandwidth is the span of frequencies within the spectrum occupied by 

a signal and used by the signal for conveying information. For example voice has a 

bandwidth of 3 to 4 kHz. Audio signal (speech and music) has 15kHz, where as 

video requires a bandwidth of 5MHz. The bandwidth is an important parameter in 

communication and it depends on the type of signal or type of application, the 

amount of information to be Communicated and the time in which the information is 

to be communicated.  

Information Transfer Rate: The bit has been defined as the basic unit of 

information in digital binary system. The speed at which information is transferred 

from one computer or terminal to another in a digital system called the information 

transfer rate or bit rate, and is measured in bits/sec. Thus, for example if 10 bits gets 

transferred in 10ms the information transfer rate is 10bits/10ms=1000bits/s or that is 

equal to 1kbps.  

Signal Rate (Baud): The baud rate or signaling rate is defined as the number of 

symbols per second. The baud rate specifies how fast signal states are changing in 

the communication channel and is measured in symbols per second or baud. In a 

purely binary system, where one symbol represents one bit, the bit rate and baud 

rate are equal. The grouping of bits leads to the difference bit rate and baud rate.  

Advantages of digital technology: Digital communication provides greater 

immunity to noise when compared with the Analog communication. It also provides 

various means of detecting and correcting the errors occurred during the process of 

transmission of the signals. Digital signals, which are inherently compatible with 



computers, have a potential to be stored, retrieved, processed and manipulated for 

signal enhancement and improved performance.  

 

3.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
1. Discuss the principles of communication systems.   

2. What are the principles of digital communication? Discuss in detail.   

3. Write a detailed note on the levels of digital communication.   

4. Write a detailed note on the advantages of digital communication.  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various aspects of memory in computers. 

First, we shall focus on Random Access Memory (RAM). Next, we shall focus on 

Read Only Memory (ROM). We shall also briefly discuss about Virtual Memory. 

Finally we shall discuss secondary storage devices. The lesson structure shall be as 

follows:  

4.0 Objectives  

4.1 Introduction  

4.2 Presentation of Content  

4.2.1 Random Access Memory (RAM)  

4.2.2 Read Only Memory (ROM)  

4.2.3 Virtual Memory 

4.2.4 Secondary Storage Devices 

4.3 Summary 

4.4 Key Words  

4.5 Self-Assessment Questions (SAQs) 

4.6 References/Suggested Reading 

 

4.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Know About Random Access Memory (RAM)  

o To Understand Read Only Memory (ROM)     

o To Know About Virtual Memory  

o To Learn About Secondary Storage Devices  

 



4.1 INTRODUCTION: 
A computer primarily uses a built in memory system to store data, etc. Additionally, 

secondary storage devices are also used. The primary storage section of a 

computer, also called as main memory, is that portion of the computer where data 

and instructions get stored when a program is being executed. The main memory is 

used to:  

o Hold data received from input devices and keep them ready for processing. 

o Hold data being processed and intermediate results being generated therein. 

o Hold the finished results of processing until released to the output devices. 

o Hold the system software and application software in use.  

 
Memory is broadly classified into two types: Random Access Memory (RAM) and 

Read Only Memory (ROM). A third type of computer memory is virtual memory. In 

this lesson we shall discus about the various types of memory systems in computers.   

  
4.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Random Access Memory (RAM)  

o Read Only Memory (ROM)  

o Virtual Memory  
o Secondary Storage Devices  

 
4.2.1 RANDOM ACCESS MEMORY (RAM):  
The memory where both reading and writing can take place is called Random 

Access Memory (RAM). By technology used, RAM may be of two types:  
o Static RAM  

o Dynamic RAM  

 
STATIC RAM:   
Static RAM elements, once set to their values, do not lose them if the power supply 

goes off. Once some value is stored, it will remain in the main memory till the power 

is on. These elements are costly and have a fast access.  

 
DYNAMIC RAM:  



In dynamic RAM the memory elements have less retention period and loose its value 

unless it is refreshed. Refreshing is a process where the RAM is read and rewritten. 

This kind of RAM requires extra circuits for refreshing. These are relatively slow but 

less costly compared to the Static RAMs. This kind of memory is therefore used in 

mass scale. Both of these are volatile i.e., the moment power goes off all contents of 

RAM are lost.  

 
4.2.2 READ ONLY MEMORY (ROM):  
There are portions in the computer memory where no writing is allowed. The 

contents are pre-written and can only be read. Such memories are called Read Only 

Memory (ROM). It is used for micro programs not available to normal programmers. 

The term read only means that the storage cannot be altered by regular program 

instructions. The information from the memory may be read out but fresh information 

cannot be written in to it. The micro programmes in Read Only Memory (ROM) may 

be used for a variety of purposes, but a common use is to hold a set of instructions 

that are needed frequently, for executing small, extremely basic operations, which 

are not otherwise available in computer circuitry. 

ROM can be classified into 2 types:  

o Programmable ROM  

o Erasable Programmable ROM  

 
PROGRAMMABLE ROM OR PROM:  
PROM is that memory in which the user can insert the contents of choice only once. 

Once the PROM is written, it can only be read and never be re-written.  

 
ERASABLE PROGRAMMABLE ROM OR EPROM:  
As the name suggests, it can be written many times by a special process. These are 

very useful for design and development.  

 
4.2.3 VIRTUAL MEMORY:  
Virtual memory is a technique that allows the execution of processes that may not be 

complete in memory. One major advantage of this scheme is that programs can be 

larger than physical memory.  



Further virtual memory abstracts main memory into an extremely large, 

uniform array of storage, separating logical memory as viewed by the user from 

physical memory. This technique frees programmers from the concerns of memory –

storage limitations.  

Virtual memory also allows processes to easily share files and address 

spaces, and it provides an efficient mechanism for process creation.  

Virtual memory is not easy to implement, however, and may substantially 

decrease the performance if it is used carelessly.  

 

4.2.4 SECONDARY STORAGE DEVICES:    
There are several devices used as secondary storage devices for computers and 

they can store and retrieve data in machine-readable forms. These are useful to 

store result temporarily, or for transforming data to other computers. The commonly 

used secondary devices are: Floppy Diskette, Magnetic Disk and CDROM derives.  

 
Floppy Diskette: The floppy diskette is made up of flexible plastic material. This 

plastic base is coated with an iron-oxide recording substance. Data is recorded as 

tiny invisible magnetic spots on this coating. Each floppy diskette is packed in 

protective paper or plastic envelope. These are mainly used for the purpose of 

backup and transportability of data, for small data volumes.  

The floppy commonly used these days is 3-½ inch in diameter and has a 

storage capacity of 1.44MB. When formatted, the floppy gets divided into tracks and 

tracks get further divided into Sectors. Tracks are concentric circles and sectors are 

small portions of a track, where data gets physically recorded. Sectors have their 

own capacity in terms of storing the data, which depends upon the type of floppy. 

While storing the data, if the sector is full, the data storing is done in the next sector 

and so on. Some floppies used are double sided.  

Double-sided floppy does not mean that you can reserve the diskette and 

read it. Double sided here means that the electronics in the computer is placed in 

such a way, that at one go itself the data can be stored or retrieved from both sides 

of the magnetic material of the floppy. 

This type of floppy has 80 tracks per side and 18 sectors per track. Total 

capacity of floppy is 1.44MB/ 2.88MB.  

 



Magnetic Disk: A magnetic Disk is an assembly of thin, circular metal plate coated 

on both sides with a magnetic material. Since the plates are made up of metal, it is 

also known as hard disk. A disk pack consist of a number of these disks, three or 

more mounted on a central shaft, which rotate at the speed of 2,400 or more 

revolutions per minute (RPM) each disk or surface consist of a number of invisible 

concentric circles called tracks.  

A set of corresponding tracks in all the surfaces is called a cylinder. Outer 

surface of the top and bottom disks cannot be accessed. All the disks of a disk pack 

move simultaneously, in the same direction and at equal speed. Even though the 

length of each track is different, the number of characters stored in each track is 

same usually.  

 
CD ROM: CD-ROM (Compact Disk read Only Memory) is an output storage device, 

which uses laser beam for reading and writing information. A CD-ROM is normally 

formed from a resin named polycarbonate, which is coated with aluminum to form a 

highly reflecting surface. The information is stored on the CD-ROM by creating 

microscopic pits on this reflective surface with the help of a laser beam. A coat of 

lacquer is applied on the CD-ROM surface to protect it from dust and scratches.  

The CD-ROM available these days has storage capacity of 650 MB. 

Information on the CD-ROM is written using a CD-Writer. Information once written 

into CD-ROM cannot be erased. However, re-writable CDs are also available and 

allow storage of up to 650 MB. In a re-writable CD data can be written and deleted 

several times, as we can do with floppies. These CD-ROMs serve as excellent back 

up devices.  

 

4.3 SUMMARY:  
o A computer primarily uses a built in memory system to store data, etc. 

Additionally, secondary storage devices are also used. The primary storage 

section of a computer, also called as main memory, is that portion of the 

computer where data and instructions get stored when a program is being 

executed. The main memory is used to: hold data received from input devices 

and keep them ready for processing, hold data being processed and 

intermediate results being generated therein, hold the finished results of 



processing until released to the output devices, and hold the system software 

and application software in use.  

 
o Memory is broadly classified into two types: Random Access Memory (RAM) 

and Read Only Memory (ROM). A third type of computer memory is virtual 

memory. In this lesson we shall discus about the various types of memory 

systems in computers.  

o Random Access Memory (RAM). By technology used, RAM may be of two 

types: static RAM and dynamic RAM  

o Static RAM elements, once set to their values, do not lose them if the power 

supply goes off. Once some value is stored, it will remain in the main memory 

till the power is on. These elements are costly and have a fast access.  

o In dynamic RAM the memory elements have less retention period and loose 

its value unless it is refreshed. Refreshing is a process where the RAM is read 

and rewritten. This kind of RAM requires extra circuits for refreshing. These 

are relatively slow but less costly compared to the Static RAMs. This kind of 

memory is therefore used in mass scale. Both of these are volatile i.e., the 

moment power goes off all contents of RAM are lost.  

o Read Only Memory (ROM) may be used for a variety of purposes, but a 

common use is to hold a set of instructions that are needed frequently, for 

executing small, extremely basic operations, which are not otherwise 

available in computer circuitry. ROM can be classified into 2 types: 

programmable ROM, and erasable Programmable ROM.   

o PROM is that memory in which the user can insert the contents of choice only 

once. Once the PROM is written, it can only be read and never be re-written.  

o As the name suggests, it can be written many times by a special process. 

These are very useful for design and development.  

o Virtual memory is a technique that allows the execution of processes that may 

not be complete in memory. One major advantage of this scheme is that 

programs can be larger than physical memory.  

 

4.4 KEY WORDS:  
Computer Memory: A computer primarily uses a built in memory system to store 

data, etc. Additionally, secondary storage devices are also used. The primary 



storage section of a computer, also called as main memory, is that portion of the 

computer where data and instructions get stored when a program is being executed. 

Main Memory: The main memory in a computer is used to: hold data received from 

input devices and keep them ready for processing, hold data being processed and 

intermediate results being generated therein, hold the finished results of processing 

until released to the output devices, and hold the system software and application 

software in use.  

Types of Memories: Memory is broadly classified into two types: Random Access 

Memory (RAM) and Read Only Memory (ROM). A third type of computer memory is 

virtual memory. In this lesson we shall discus about the various types of memory 

systems in computers.  

Static RAM: Static RAM elements, once set to their values, do not lose them if the 

power supply goes off. Once some value is stored, it will remain in the main memory 

till the power is on. These elements are costly and have a fast access.  

Dynamic RAM: In dynamic RAM the memory elements have less retention period 

and loose its value unless it is refreshed. Refreshing is a process where the RAM is 

read and rewritten. This kind of RAM requires extra circuits for refreshing. These are 

relatively slow but less costly compared to the Static RAMs. This kind of memory is 

therefore used in mass scale. Both of these are volatile i.e., the moment power goes 

off all contents of RAM are lost.  

Read Only Memory: Read Only Memory (ROM) may be used for a variety of 

purposes, but a common use is to hold a set of instructions that are needed 

frequently, for executing small, extremely basic operations, which are not otherwise 

available in computer circuitry. ROM can be classified into 2 types: programmable 

ROM, and erasable Programmable ROM.   

PROGRAMMABLE ROM OR PROM: PROM is that memory in which the user can insert 

the contents of choice only once. Once the PROM is written, it can only be read and 

never be re-written.  

ERASABLE PROGRAMMABLE ROM OR EPROM: As the name suggests, it can be 

written many times by a special process. These are very useful for design and 

development.  

Virtual Memory: Virtual memory is a technique that allows the execution of 

processes that may not be complete in memory. One major advantage of this 

scheme is that programs can be larger than physical memory.  



4.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
5. Discuss the concept of computer memory in detail.  

6. What is random access memory? Discuss in detail.  

7. What is read only memory? Discuss in detail.  

8. Discuss the concept of virtual memory in detail.  

9. Discuss the secondary storage devices in detail.  

 

4.6 REFERENCES / SUGGESTED READING: 
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o Computers; Anne Rooney; 2005  

o Mastering Microsoft Word; Matthew Holtz; 1987  

o Mastering CorelDRAW; S. Rimmer; 1997  

o How the Web was Born: The Story of the World Wide Web; Robert Cailliau 

& James Gillies; 1997 

o The Internet: The Basics; Jason Whittakar; 2002  

o How the Internet Works; Preston Gralla; 1998  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various introductory aspects of word 

processing. First, we shall focus on Word Processor. We shall also discuss how to 

work with MS-Word in detail. The lesson structure shall be as follows:  

5.0 Objectives  

5.1 Introduction  

5.2 Presentation of Content  

5.2.1 Word Processor- An Introduction   

5.2.2 MS-Word-An Introduction    

5.2.3 Working With MS-Word  

5.3 Summary 

5.4 Key Words  

5.5 Self-Assessment Questions (SAQs) 

5.6 References/Suggested Reading 

 

5.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Get an Introduction to Word Processor  

o To Get an Introduction to MS-Word  

o To Understand how to Work with MS-Word 

 

5.1 INTRODUCTION: 
Writers write. What writers write is then edited. Editing often involves correcting and 

improving write-ups grammatically, factually, and many related ways. The next step 



is composing the text. Proofreading follows it. All these steps form part of what is 

generally known as word processing.  

 In this lesson, we shall try to cover some aspects of MS-Word, a major word 

processing application package.  

 
5.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Word Processing- An Introduction  
o MS-Word-An Introduction  
o Working With MS-Word  

 
5.2.1 WORD PROCESSOR- AN INTRODUCTION:  
A Word Processor is an application or programme for manipulating text-based 

documents. A Word Processor is the electronic equivalent of paper, pen, typewriter, 

eraser, dictionary, and thesaurus. Word processors range from simple through to 

complex. But word processors make the tasks associated with editing documents 

(deleting, inserting, rewording, and so on) very easy.  

Depending on the programme and the equipment in use, word processors can 

display documents in different modes. The display could be in the text mode, using 

highlighting, underlining, or colour to represent italics, boldfacing, and other such 

formatting. Or the display could be in the WYSIWYG mode, where formatting and a 

variety of fonts appear on the screen, as they will on the printed page.  

All word processors offer facilities for document formatting, such as font 

changes, page layout, paragraph indention, and the like. Many word processors can 

also check spelling, find synonyms, incorporate graphics created with another 

programmme, correctly align mathematical formulas, create and print standard 

letters, perform calculations, display documents in multiple on-screen windows, etc.  

 
5.2.2 MS - WORD- AN INTRODUCTION: 
Microsoft Word (MS Word) is a word processor developed by Microsoft Corporation. 

In this software the user can create, edit and print the documents according to one’s 

requirements. Auto correct, spelling and grammar checking text formatting, mail 

merge, graphics, table etc. are some of the features of MS Word.  

 



SYSTEM REQUIREMENTS:   
o Any IBM compatible computer with 80486 or higher processor  

o 1 Floppy Disk Drive 1.44 MB (3.5 inch)  

o 1 Hard Disk Drive with minimum of 100 MB  

o Operating system Windows XP or Windows 2000  

o Minimum 16 MB RAM  

o VGA Monitor  

o Pointing device—Mouse or track ball  

 
5.2.3 WORKING WITH MS-WORD: 
To start Word, first boot the computer with Windows 95 and select, Select 
Programs\Microsoft Word. Word opens an empty document after displaying the 

logo.  

ICONS ON THE MONITOR:   
Title Bar: The first line at the top of the screen. It displays the active application and 

the name of the document. It can be used to move the Word window on the screen.  

Minimize Button: It is used to minimize the Word window.  

Restore Button: It is used to store the window to its previous size, if the window is 

maximized.  

Maximize Button: It is used to maximize the window. It is on top right corner of 

screen. 

Close Button: It is used to close (exit) MS-Word.  

Menu Bar: It is displayed below the Title Bar. It contains the menu options.  

Toolbar: A set of icons to perform different tasks and displayed as a set is called a 

toolbar. Standard toolbar and formatting toolbars are displayed at the top of the 

screen below the menu bar. In Word 97, drawing toolbar is displayed at the bottom 

of the screen.  

Ruler Line: It displays the margins, indents; tap positions on a numbers scale. 

Horizontal ruler line will be on the top and vertical ruler line is to the left of the 

screen.  

View Bar: View Bar is displayed below the workspace containing 4 icons in it. It can 

be used to display the document in Normal View, Online Layout View, Page Layout 

View or Outline View.  



Status Bar: The Status Bar is displayed at the bottom of MS-Word window (above 

the taskbar). It displays the information about the active document such as page 

number, section number, number of pages, insertion point position etc.  

CREATING A DOCUMENT:   
When MS Word is loaded, a blank window will be displayed with the name 

Document1. To create a document, start typing the text in the window.  

TYPING TIPS: 
1. While typing the text, when the right margin is encountered, the insertion point 

will automatically return to the next line. This feature is called Word Wrap. 
Therefore, do not press Enter at the end of every line unless you require a 

paragraph break.  

2. To change the paragraphs, press Enter.  
3. To start a new line without considering it as a new paragraph, press Shift + 

Enter.  
4. In case of mistakes, to delete backwards, press backspace. To delete the 

character at the cursor (Insertion point) position, press Delete Key.  

ADDITIONAL TYPING TIPS: 
o The text can be typed or deleted at the position of insertion pointer.  

o Therefore, to type a word in the middle of a sentence, to edit (delete or 

correct) a word, the insertion point must be moved to the word. Clicking on the 

left mouse button in appropriate position of the word can move the insertion 

pointer to that place. 

o You can press appropriate keys in the keyboard to move the insertion pointer. 

The sequence is given in the following table.  

KEY SEQUENCE INSERTION POINT MOVEMENT:  
o Arrow Keys: Up, down, left or right by one line or one character.  

o Page Up/Page Down: Up or down by one screen  

o Ctrl right /Ctrl left: Right or left by one word  

o Ctrl Up/ Ctrl Down key: Up or down by one paragraph  

o Home Beginning of line  

o End: End of line  

o Ctrl Home: Beginning of document  

o Ctrl End: End of document  

o Ctrl Alt Page Up: Previous page  



o Ctrl Alt Page Down: Next page  

FILE OPERATIONS:   
In this screen, file operations like opening a file, saving a file and creating a new file 

are discussed.  

Saving the File:  
After typing the text it has to be saved for future use. To save the file, you can follow 

any one of the following three methods.  

o Select File\Save  
o Press Ctrl\S  
o Click on Save icon in the standard toolbar.  

The Save As dialog will be displayed on your screen. Here you can type any name 

that you wish to give to your file and click on Save. If the file is to be saved in a 

different folder (directory), select the folder name after typing the file name and then 

click on Save The file will be saved with the extension.  

Creating a New File:  
To create a new file, save the current file and use any one of the following methods.  

o Select File\New and Select Blank Document in General category and click on 

OK.  

o Press Ctrl + N  
o Press on New icon In the standard toolbar. The screen will be cleared and a 

new file will be created.  

Opening A File:  
To open the file, which is already created, use any one of the following four methods. 

o Select File\Open  
o Press Ctrl + O  
o Click on Open icon in the standard toolbar.  

o Click on the name at the end of the File menu, if the file name is visible there. 
o Closing a File  
o To close the open file, choose File\Close  

EDITING TEXT:  
The process of changing the appearance of the text, deleting a portion of the text, 

duplicating or moving a part of the text, is called editing. To make these changes you 

must first select the portion of text, which needs the change.  



To select portion of the text is called a Block. When the text is blocked, it will be 

highlighted.  

You will find below some of the methods to block or select a portion of the 

text. 

o Click and Drag: Click in the place from where the text is to be selected and 

drag to the place at the end of selection and release the mouse button  

o Click and Shift + Click: Click in the place from where the text is to be 

selected and Shift + click in the place where the selection has to end  

o Double Click on the word to block a word  

o Click on the selection area (space at the left side of the screen — after the 

ruler but before the text) of line to block a line  

o Ctrl + Click anywhere on the sentence to block a sentence  

o Double Click in the selection area of any line to block a paragraph  

o Ctrl + Click in the selection area of any line to block entire document  

o Keeping Alt key pressed, click and drag to lock the text column wise  

FORMATTING TEXT:   
The text-formatting feature includes — font, font size, bold, italic, underline, text 

color, and background and text border.  

To format the text you have to block the text (select the text), and click on the 

appropriate icon in the formatting toolbar. For e.g. to change the font size, block the 

text to be formatted, click on the drop down list box displayed after the font size and 

click on the desired font size number (8 to 72). If you want to remove boldface, 

underline from your document, block the text again and click on the appropriate icon 

in the formatting toolbar.  

Text Color:  
In Word 97, to color a portion of your text, or to highlight a portion of your text, first 

block the text and click on the arrow mark pointing downwards, in formatting toolbar 

and click on the desired color.  

Text Border:  
Text Border is used to put a border to the selected portion of the text Microsoft 
Word. For example to put the text border, you can block the text and click on the 

Border list box and select the border.  

Advanced Formatting:  



The text advanced formatting features include — different types of underlines, 

subscript, superscript, spacing between characters and animation: 

To use the advanced text formatting features,  

o Block the text.  

o Select Format Font. Font dialog will be displayed on the screen.  

o Select the desired font type, font size, font style, type of underline (single, 

double, dashed, thick, dot, thick, dot dash, wave etc.), font effects (subscript, 

superscript) etc. and click on OK.  

Subscript: The text that is written below the original line is a subscript.  

E.g., H2O, here is 2 is the subscript. To create a subscript, block the text, which is to 

be printed below the original line (in the above case 2), select Format Font, select 

Subscript check box and click on OK.  
Superscript: The text that is written above the original line is called superscript. For 

example, H3 + B3. Here 3 is the superscript. To create a superscript, block the text, 

which is to be printed above the original line (in the above case 3), select Format 
Font, select Superscript check box and click on OK.  
Adjusting spacing between characters:  
The character Spacing tab of the Font dialog box provides options for changing the 

distance between characters (Normal, Expanded or condensed), the position of 

characters (Raised or Lowered) and Kerning (the precise amount of space between 

characters).  

Scaling is used to specify the character size. But it is better to change the 

character size using formatting toolbar. Spacing is used to control the distance that 

appears between the characters. Word allows you to increase or reduce the gap 

between the characters. To increase the space between characters, block the text, 

select/ block the word Expanded and specify the measurement in points. Similarly, to 

reduce the space between characters, select/block the Word Condensed.  

Positioning the characters:  
By default, the characters are positioned normally (on the line). If the text is to be 

printed slightly above or below the line, use the features Raised and Lowered 
respectively. Here the text is Raised by 4pt.  

Changing Case:  



This feature is used to convert the text, which is already written in upper case, lower 

case, toggle case etc. To change the case, block the text, select Format Change 
Case, select the appropriate option and clik on OK.  
Moving the Text:  
Steps to move the text (generally the paragraphs)  

o Block the text to be moved.  

o Select Edit\Cut or (press Ctrl + X)  

Copying Text:   
Steps to copy or duplicate the text,  

o Block the text to be copied.  

o Select Edit\Copy (or press Ctrl +C)  

o Click in a new place where the blocked text should be copied.  

o Select Edit\Paste (or press Ctrl +V)  

UNDO AND REDO:  
o To undo the previous work select Edit\Undo or press Ctrl + Z  
o To redo the previous action, select Edit\Repeat or press Ctrl + Y  

PARAGRAPH OPTIONS:  
In Word, a paragraph is text, graphics or other items that is followed by a paragraph 

mark. Paragraph mark is not displayed unless the show/hide icon in standard tool 

bar is selected. This paragraph mark is inserted every time the Enter key is pressed. 

To make changes to a selected paragraph, use Format Paragraph option. From 

paragraph dialog you can align paragraphs, create line spacing, indent the 

paragraphs and specify line and page breaks.  

Paragraph Alignment:  
The text in the paragraph is by default Aligned, i.e. the text written will be properly 

adjusted in the left side. The text can be centered, right aligned or justified.  

To change the paragraph alignment:  

o Click anywhere on the paragraph that has to be aligned  

o Click on appropriate icon in the Formatting Toolbar  

The available icons are:  

o Center Icon  To centre align selected paragraphs  

o Align left icon  To left align selected paragraphs  

o Align right icon  To right align selected paragraphs  

o Justify icon   To justify the paragraph at both left and right side  



Line Spacing:  
Line spacing is the amount of gap in between the lines in the paragraph.  

The different line spacing available are; Single, 1.5 lines, Double, At Least, Exactly 

and multiple.  

To select the line spacing:  

o Click on the paragraph that needs the change.  

o Select Format Paragraph  
o Select the desired line spacing from the Line Spacing drop down box and click 

on OK.  
Paragraph Indents:  
When you type a letter or circular and you would like to draw the attention of the 

reader to a particular paragraph, you may wish to keep some space to the left or to 

the right. Or you may just want the first line of the paragraph to start after some 

space. These extra spaces are called Indents.  
There are four types of indents.  

Left: Leaves a gap at the left side of a paragraph.  

Right: Leaves a gap at the right side of a paragraph.  

First Line: Leaves a gap at the beginning of first line of a paragraph.  

Hanging: Leaves a gap at the left side of paragraph except for the first line in the 

paragraph.  

BORDERS AND SHADINGS:  
You can specify the borders for paragraphs and pages. You can also specify 

shading for paragraphs to emphasize the text.  

Paragraph Borders:  
o Paragraph borders are used to emphasize a particular portion of the text.  

o Various borders can be applied to a single paragraph or a group of 

paragraphs.  

o Different styles of borders, like - thin or thick line, double or dotted line borders 

can be applied in different colors. Shadow can also be selected for right side 

or left side of the paragraph.  

To apply borders to a paragraph:  
1. Click on the paragraph,  

2. Select Format\Borders and Shading.  
3. In borders tab, from Setting select Box, Shadow, 3-D or Custom.  



4. Select the line style of border.  

5. Select the line color of border.  

6. Select the width of line and click on OK.  

This sentence is an example for single line border.  

This line is an example for double line border with shadow.   

 
Page Border:  
You have seen in previous sessions that borders are applicable to paragraphs, the 

border can be set to pages also. In case of page border, the selected type of border 

will be applied to the full page.  

Paragraph Shading:  
Paragraph shading is also used to emphasize the text written in the paragraph. The 

shading can be done for one paragraph or selected paragraphs using different 

colors. 

BULLETS AND NUMBERING:  
This feature is used to create a bulleted or numbered list from a selected list of items 

by including some symbol or serial numbers to the left side of the text. The icons for 

bullets and numbering available in Formatting toolbar are:  

To apply bullets and numbering:   

o Block the text,  

o Select Format Bullets and Numbering  
o Select the style of bullet from bulleted tab or the type of numbers from 

Numbered tab and click on OK.  
To change the type of bullet symbol, click on any one bullet, click on Customize... 
button, and click on Bullet, select the required symbol by choosing the appropriate 

font. 

To remove bullets and numbering, block the text, select Format Bullets and 
Numbering and select the bullet type None and click on OK.  
 
TAB STOP:  
Tabs are used to type the text in columns. MS Word has tab stops set to every 0.5 

inch by default. These tab stops can be identified by the gray thick marks that appear 

at the bottom of the ruler. To type the text in different columns, tab stops can be set. 



There are five types of tabs. They are left, center, right, decimal and bar (thin vertical 

bar will appear to separate the columns). The text that is typed will be aligned on the 

basis of the type of the tab set at that position.  

To set the tab stops:  

1. Select Format Tabs to open the tabs dialog box.  

2. Type the tab stop position number in inches.  

3. Select how the text must be aligned from the available alignments.  

4. Select the type of leader, if required.  

5. Click on Set.  

6. Repeat the steps 2 to 5 to set other tab positions.  

7. To remove a tab position, click on the tab stop number, which is already set 

(appearing inside the box) and click on Clear. To clear the entire tab stops that are 

set click on Clear All.  

8. Click on OK to come out.  

 
FIND, REPLACE, GO TO:   
You can find a particular word or phrase in the document, replace some words, 

which are already typed or go to a specific page, section, or line in the document. 

This is very useful when you want to change only certain names in a lengthy 

document (e.g. a Lawyers notice, in which all the legal terms are the same but the 

names of the parties are different).  

Find:  
o Select Edit\Find.... or press Ctrl + F. The following Find and Replace dialog 

will be displayed.  

To find a particular word or phrase in the entire document or selected text,  

o Type the word to be found in Find what box.  

o Select the options like Match case to have the search to be case sensitive, 

i.e., exact combination of uppercase and lowercase letters specified in the find 

what box.  

o Find the whole words only - to find the words, which are not a part of other 

words.  

o Use wildcards - the use of ? to represent a character or * to represent any 

number of character as wildcards in the text to be found.  



o Sounds like - to find the word that sounds like the word entered but spelled 

differently.  

o Find all words - to search for the words in the entire document.  

o Click on Find Next to find the text. To continue finding the same text, continue 

to click on Find Next. To find another word, change the word in the find what 

box. To come out of Find and Replace dialog, click on Cancel. 
 
SPELLING AND GRAMMAR:   
You can check the spelling of the words in the document and also check for possible 

grammar and style errors.  

Spelling:  
While typing the text, if any spelling mistake is made, a red wavy underline will be 

included for such words and if there is a suspected grammar mistake in the 

sentence, a green wavy underline will be included.  

Change: Changes the wrongly spelt words with words present in change to box. 

Change All: Changes every occurrence of a particular wrongly spelt word with the 

word in the change to box. 

Ignore: Ignores the word that is not correct but which the user wants to keep as it is. 

(E.g. Name of a person will be showed as wrongly spelt word). 

Add: Stores a specified word in the dictionary. 

Auto Correct: Adds the wrongly spelt word and its correction to Auto Correct list so 

that MS-Word will correct it automatically in future. 

CANCEL (or CLOSE): Stops the spell checking. 

 
AUTO TEXT:   
The text entries, which are stored and can be inserted by a few shortcut keys, are 

Auto Text entries. Frequently used words can be stored as Auto Text entries, like 

Yours Sincerely, Yours Faithfully, and Thanking You, etc. You will find that it is an 

easy way to include the text into the document without typing it in full, i.e. the Auto 

Text entry will be stored in some shortcut name.  

To store an Auto Text entry, type the text and block it, then select Insert Auto 
Text New. A dialog will be displayed to enter a name to the Auto Text entry. Type a 

shortcut name to the text blocked (for example, AT for paragraph on Auto Text, YF 

for Yours faithfully) and click on OK. To insert the Auto Text into the document, type 



the shortcut name given and press the function key F3. Automatically, the shortcut 

name will be converted to the original text.  

Auto Text can also be inserted into the document by selecting Insert Auto 
Text, click on the required shortcut name and click on Insert. To delete the Auto 

Text entry, select Insert Auto Text\Auto Text, click on the Auto Text shortcut name 

to be deleted and click on Delete. To come out of the dialog, click on Close.  
 
AUTO CORRECT:   
Auto Correct is used to get the text that is required immediately after typing the 

shortcut name without having a need to press any other keys. It is a method to 

correct the text as the user types it. Common mistakes and its corrections will be 

stored as Auto Correct entries. E.g., on Typing MAHE it should automatically change 

the text to GJU Academy of Higher Education. For example, if we type gJU, it must 

be changed to GJU. To create an Auto Correct entry, select Tools\Auto Correct. 
Type the spelling of the word that we generally type e.g. GJU in Replace box. In 

With box, type the correct spelling of the word and click on Add and click on OK. 
Now onwards, if GJU is typed, it will automatically convert to Guru Jambheshwar 

University. To delete the Auto Correct entry, select Tools\Auto Correct, click on the 

name of Auto Correct to be deleted and click on Delete.  
WORD COUNT:   
This feature of word allows you to count the number of pages, words, characters, 

paragraphs, and lines in the document. To count the words, lines, paragraphs etc., in 

the document, select Tools\Word Count. The result will be displayed in a dialog 

box.  

BREAKS:   
There are three types of breaks available in MS-Word. They are, Page Break, 

Column Break, Section Breaks. To insert any one of the above breaks, select Insert 
Break. The Break dialog will be displayed on the screen. Select the kind of break 

required and clicks on OK.  
Page Break inserts a page break at the cursor position and shifts the remaining text, 

to the next page. Manual page break can also be inserted by pressing Ctrl+Enter.  
Column Break inserts a column break at the cursor position and shifts the remaining 

text if any, to the next column. It allows the user to type the text in next column by 

ending the current column.  



Section Break is used to end the current section and to start a new section type 

changing the section number. It is generally used to apply different type of formatting 

to different types of the document. Section-breaks are of four types.  

o Next Page: Inserts a section-break and breaks the page so that the next 

section starts at the beginning of next page.  

o Even Page: Inserts a section-break and starts the next section on the next 

even numbered page. If the section break is included in an even numbered 

page, the next page (odd numbered page) will be blank.  

o Continuous: Inserts a section-break and starts the next section immediately, 

without inserting a page break.  

o Odd Page: Inserts a section-break and starts the next section on the next odd 

numbered page. If this section break is included in the odd numbered page, 

the next page (even numbered page) will be blank.  

COLUMNS:   
Columns are used to type the text in different columns. Text can be typed into the 

columns after defining the columns or the existing text can be converted into 

columns.  

Typing the text by defining the columns  
To type the text inside the columns by defining the columns,  

1. Click on the place from where the text has to be in columns.  

2. Select Insert\Break\Continuous, click on OK.  
Select Format Columns. The columns dialog will be displayed.  

o Specify the number of columns required (two, three etc.)  

o Specify whether a separator line is required in between the columns. If 

a line is needed between the paragraphs, select the check box Line 
Between.  

o By default, the width of each column will be equal. If you need to have 

columns with different widths, change the width and spacing between 

the columns after de-selecting Equal Column Width and click on OK.  
o Type the text in the first column. When you have finished typing in the 

first column and want to go to the next column, Insert\Break\Column 
Break. Type the text in the other columns.  

o At the end of the last column, select Insert\Break\Continuous.  



o To end the columns and start typing the text as regular paragraphs, 

select Format\Columns and from Presets, select the number of 

columns as One.  

TABLES:  
A table is any information grouped together, arranged in rows and columns. A Table 

will have two or more columns and one or more rows. Each intersection of a row and 

a column is a cell of the table.  

A Table can be useful for enhancing the presentation of data in your document; it 

can be used for creating side-by-side paragraphs, and for organizing information.  

Any data, especially numbers, is more presentable and easier to type in the tabulator 

form. Even though the text can be typed in different columns using the tabs, setting 

the tabs and typing the text by pressing the Tab key will be a slow and tricky 

process. The table feature of Word allows the user to create the table faster and also 

to type the text easily.  

INSERTING OBJECTS:  
You can insert date and time, symbol, pictures and word art.  

Insert Date and Time:  
o Date and Time is used to insert current date or time into the document.  

o To insert date or time, click on the place where the system date or time is to 

be inserted and select Insert Date and Time.  
o Different date and time formats will be displayed. Click on the required format. 

If the date or time inserted into the document must be modified each time the 

file is opened, select the check box Insert as Field and click on OK.   
o If the date inserted into the file has to be changed automatically, every time 

the file is opened, select the check box Update automatically.  
Insert Symbol:  
Different symbols from different fonts or special characters can be inserted into the 

document by selecting Insert Symbol. Select the Font (generally Wingdings) Click 

on the desired symbol, click on Insert and click on Close.  
To Insert a Special Character like Trade MardTM, Registered, Copyright etc., into 

the document, click on the place where the special character to be inserted and 

select Insert Symbol, select the tab Special Characters, click on the desired 

character to be inserted into the file and click on Close.  
 



Insert Picture: 
 A number of pictures are available in MS Word that can be inserted into any 

document.  

o To insert a picture into a Word Document:  

o Click on the place, where the picture is to be inserted.  

o Select Insert Picture Clipart.  
o Select the required category and click on the required picture from the 

selected category.  

o Select Insert and click on Close.  
 
HEADER AND FOOTER:   
Header is the text that will be printed at the top of the page and footer is the text that 

will be printed at the bottom of the page, The header and footer can include text or 

graphics such as page numbers, date, the company logo, file name, authors name 

etc. To add a Header or Footer to a document, select view Header and Footer.  
A box will be displayed to type the header text along with the header and 

Footer tool bar displayed below the box. Any text can be typed inside the box 

directly. The text typed in the Header box will appear at the top of every page. If any 

special information is to be inserted, like-page number, date and time, file name etc. 

in the header or footer, click on appropriate icon in the toolbar. The icons in the 

toolbar and insert Auto Text, Page number, Number of pages, Format Page Number, 

Insert Date, Insert Time, Page Setup, Show/Hide Document Text, Same as 

Previous, Switch between Header and Footer, Show Previous, Show Next and 

Close.  

To insert the page number, date, file name etc. in header or footer, select 

from the Insert AutoText list.  

The page number, date, time, etc. can also be inserted into the file by clicking 

on appropriate icon in the header and Footer toolbar. The header or footer text can 

be written in 3 alignments, i.e. Left, Centered And Right. To change the alignment, 

press Tab key.  

By default, header text can be typed directly. To type the footer text, click on 

Switch between header and footer icon from the toolbar. At the end, click on the 

close icon to return to document. Header/Footer cannot be seen in the normal view 

of the document. But it is visible in the page layout view and print preview.  



FOOTNOTES AND END NOTES:  
Footnote and Endnote is the reference note written at the end of the same page or at 

the end of the document. Footnotes will be printed at the end of same page and 

Endnote will be printed at the end of document. To type the footnote or endnote text, 

place the insertion point at the position, where the note mark has to appear and 

select Insert\Footnote. The following dialog will be displayed. Select whether 

Footnote or Endnote has to be written and the style of numbering. Instead of 

number, if any symbol is to be inserted in that place. Select Symbol and select the 

desired symbol by selecting appropriate font. To start typing the footnote or endnote 

text, click or OK.  
If Footnote is selected the insertion point will appear at the bottom of the page 

by displaying the footnote number or symbol where the footnote text can be typed. (if 

Endnote is selected, insertion point will appear at the end of document.) To return to 

the text click outside the footnote area.  

 
VIEWS:   
A document can be edited by displaying it in different ways on the screen called 

views. Word has six different views. The Normal View, Online Layout View, Page 

Layout View, Print Preview, Outline View, and Master Document. These different 

views (except Print Preview) can be selected from View Menu. Normal View is the 

default view in Word. It is an all-purpose view for typing, editing and formatting the 

text. Normal view shows text formatting but simple files the layout of the page so the 

typing and editing can be done faster. To return to Normal View from any other view, 

select View Normal.  
It will be display side-by-side column positioning, footers, headers or the 

printing position of framed objects. Page breaks are shown as dotted lines. Manual 

page breaks are shown with dotted line containing the word Page break. Online 
Layout View optimizes the layout to make online reading easier. Text appears larger 

and wraps to fit the window. It will not display the text the way in which it is actually 

printed. By default, online layout view includes a resizable navigation pane called 

Document Map, which shows the outline view of the document’s structure. By 

clicking on outline topic of the document, the cursor can be moved to that part of the 

document. Background pictures can be included only in the online layout view. To 

switch to Online Layout view, select View Online Layout.  



Page layout View displays the text and graphic objects, as it will appear 

when printed. This view is useful for editing headers and footers, for adjusting 

margins and working with columns, drawing objects, inserting pictures etc. Both 

horizontal and vertical margins will be displayed allowing the user to set the tabs and 

margins easily. To return to page layout View, Select View Page Layout.  
Print Preview displays one or multiple pages of a document in a reduced size 

to display the document, as it will be on a printed page. One or more page will be 

displayed. This view is useful to check the layout of the document by displaying the 

header, footer, and margins and allows the user to edit or format before printing the 

document. To return to Print Preview, select File Print Preview  
To return to document from Print Preview, select close from the tool bar 

displayed at the top of print preview window.  

Outline View makes it easy to look at the structure of a document and to 

move, copy and reorganize text. In the outline view, there is a provision to collapse 

the document to see only the main headings or the document can be expanded to 

see the entire document. To return to Outline View, select View Out line.  
Master Document view makes it easier to organize and maintain a long 

document, such as a book with chapters. Use master document view to group 

several word documents into one master document. After this, an index, table of 

contents or cross-reference can be included without opening each of the individual 

documents. To switch to Master Document view, select View Master Document.  
 
5.3 SUMMARY:  

o A Word Processor is an application or programme for manipulating text-based 

documents. A Word Processor is the electronic equivalent of paper, pen, 

typewriter, eraser, dictionary, and thesaurus. Word processors range from 

simple through to complex. But word processors make the tasks associated 

with editing documents (deleting, inserting, rewording, and so on) very easy.  

o All word processors offer facilities for document formatting, such as font 

changes, page layout, paragraph indention, and the like.  

o Many word processors can also check spelling, find synonyms, incorporate 

graphics created with another program, correctly align mathematical formulas, 

create and print standard letters, perform calculations, display documents in 



multiple on-screen windows, and enable users to record macros that simplify 

difficult or repetitive operations.  

o Microsoft Word (MS Word) is a word processor developed by Microsoft 

Corporation. In this software the user can create, edit and print the documents 

according to one’s requirements. Auto correct, spelling and grammar checking 

text formatting, mail merge, graphics, table etc. are some of the features of 

MS Word.  

 

5.4 KEY WORDS:  
Word Processor: A Word Processor is an application or programme for 

manipulating text-based documents. A Word Processor is the electronic equivalent 

of paper, pen, typewriter, eraser, dictionary, and thesaurus. Word processors range 

from simple through to complex. But word processors make the tasks associated 

with editing documents (deleting, inserting, rewording, and so on) very easy.  

Facilities In Word Processors: All word processors offer facilities for document 

formatting, such as font changes, page layout, paragraph indention, and the like. 

Many word processors can also check spelling, find synonyms, incorporate graphics 

created with another program, correctly align mathematical formulas, create and 

print standard letters, perform calculations, display documents in multiple on-screen 

windows, etc.  

Microsoft Word: Microsoft Word (MS Word) is a word processor developed by 

Microsoft Corporation. In this software the user can create, edit and print the 

documents according to one’s requirements. Auto correct, spelling and grammar 

checking text formatting, mail merge, graphics, table etc. are some of the features of 

MS Word.  

 

5.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
10. Write a detailed note on word processing.  

11. Write a detailed note on any word processing programme.  

12. Write a detailed note on MS-Word.  

13. What are the facilities available with MS-Word?  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various introductory aspects of presentation 

software package PowerPoint. First, we shall focus on the. We shall also briefly 

discuss the. The lesson structure shall be as follows:  

6.0 Objectives  

6.1 Introduction  

6.2 Presentation of Content  

6.2.1 Components of Computers  

6.2.2 Evolution of Computers   

6.2.3 Generations of Computers  

6.3 Summary 

6.4 Key Words  

2.5 Self-Assessment Questions (SAQs) 

6.6 References/Suggested Reading 

 

6.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Know About the Components of Computers 

o To Understand the Evolution of Computers   

o To Know About the various Generations of Computers 

 

6.1 INTRODUCTION: 



Multimedia is the combination of sound, graphics, animation, and video with 

traditional media such as text. In the world of computers, multimedia is a subset of 

hypermedia that combines the elements of multimedia with hypertext, which links the 

information.  

A multimedia application is one that uses a collection of media sources. Some 

of the better-known examples of such applications are PowerPoint, the presentation 

package from Microsoft, and Acrobat, the document presentation product from 

Adobe Systems.  

In this lesson, we shall discuss about PowerPoint, the presentation package 

from Microsoft.  

 
6.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Components of Computers  

o Evolution of Computers   

o Generations of Computers  
 
6.2.1 POWER POINT- AN INTRODUCTION:  
Microsoft PowerPoint is a presentation programme developed by Microsoft for its 

Microsoft Office system. Microsoft PowerPoint runs on Microsoft Windows and the 

Mac OS computer operating systems, although it originally ran under Xenix systems. 

It is widely used by business people, educators, students, and trainers and is 

among the most prevalent forms of persuasion technology. Beginning with Microsoft 

Office 2003, Microsoft revised branding to emphasize PowerPoint's identity as a 

component within the Office suite: Microsoft began calling it Microsoft Office 

PowerPoint instead of merely Microsoft PowerPoint. The current version of Microsoft 

Office PowerPoint is Microsoft Office PowerPoint 2007. As a part of Microsoft Office, 

Microsoft Office PowerPoint has become the world's most widely used presentation 

programme. 

Bob Gaskins and software developer Dennis Austin developed the original 

Microsoft Office PowerPoint as Presenter for Forethought, Inc, which they later 

renamed PowerPoint. 

PowerPoint 1.0 was released in 1987 for the Apple Macintosh. It ran in black 

and white, generating text-and-graphics pages for overhead transparencies. A new 



full color version of PowerPoint shipped a year later after the first color Macintosh 

came to market. 

Microsoft Corporation purchased Forethought and its PowerPoint software 

product for $14 million on July 31, 1987. In 1990 the first Windows versions were 

produced. Since 1990, PowerPoint has been a standard part of the Microsoft Office 

suite of applications (except for the Basic Edition). 

The 2002 version, part of the Microsoft Office XP Professional suite and also 

available as a stand-alone product, provided features such as comparing and 

merging changes in presentations, the ability to define animation paths for individual 

shapes, pyramid/radial/target and Venn diagrams, multiple slide masters, a "task 

pane" to view and select text and objects on the clipboard, password protection for 

presentations, automatic "photo album" generation, and the use of "smart tags" 

allowing people to quickly select the format of text copied into the presentation. 

Microsoft Office PowerPoint 2003 did not differ much from the 2002/XP 

version. It enhanced collaboration between co-workers and featured "Package for 

CD", which makes it easy to burn presentations with multimedia content and the 

viewer on CD-ROM for distribution. It also improved support for graphics and 

multimedia. 

The current version, Microsoft Office PowerPoint 2007, released in November 

2006, brought major changes of the user interface and enhanced graphic 

capabilities.  

 

6.2.2 POWER POINT OPERATIONS:  
In PowerPoint, as in most other presentation software, text, graphics, movies, and 

other objects are positioned on individual pages or "slides". The "slide" analogy is a 

reference to the slide projector, a device that has become somewhat obsolete due to 

the use of PowerPoint and other presentation software. Slides can be printed, or 

(more often) displayed on-screen and navigated through at the command of the 

presenter. Slides can also form the basis of webcasts. 

PowerPoint provides many types of movements. Entrance, emphasis, and exit 

of elements on a slide itself are controlled by what PowerPoint calls Custom 

Animations. Transitions, on the other hand are movements between slides. These 

can be animated in a variety of ways. The overall design of a presentation can be 

controlled with a master slide; and the overall structure, extending to the text on each 



slide, can be edited using a primitive outliner. Presentations can be saved and run in 

any of the file formats: the default .ppt (presentation), .pps (PowerPoint Show) or .pot 

(template). In PowerPoint 2007 the XML-based file formats. pptx, .ppsx and .potx 

have been introduced. 

 

6.2.3 CRITICISMS OF POWER POINT:  
One major source of criticism of PowerPoint comes from Yale professor of statistics 

and graphic design Edward Tufte, who criticizes many emergent properties of the 

software: 

o It is used to guide and reassure a presenter, rather than to enlighten the 

audience;  

o Unhelpfully simplistic tables and charts, resulting from the low resolution of 

computer displays;  

o The outliner causing ideas to be arranged in an unnecessarily deep hierarchy, 

itself subverted by the need to restate the hierarchy on each slide;  

o Enforcement of the audience's linear progression through that hierarchy 

(whereas with handouts, readers could browse and relate items at their 

leisure);  

o Poor typography and chart layout, from presenters who are poor designers 

and who use poorly designed templates and default settings;  

o Simplistic thinking, from ideas being squashed into bulleted lists, and stories 

with beginning, middle, and end being turned into a collection of disparate, 

loosely disguised points. This may present a kind of image of objectivity and 

neutrality that people associate with science, technology, and "bullet points".  

o Tufte's criticism of the use of PowerPoint has extended to its use by NASA 

engineers in the events leading to the Columbia disaster. Tufte's analysis of a 

representative NASA PowerPoint slide is included in a full page sidebar 

entitled "Engineering by Viewgraphs" in Volume 1 of the Columbia Accident 

Investigation Board's report. 

 

6.2.4 VERSIONS OF POWER POINT: 
Here are the major versions of Power Point presentation programme:  

o 1987 PowerPoint 1.0 for Mac OS classic  

o 1988 PowerPoint 2.0 for Mac OS classic  



o 1992 PowerPoint 3.0 for Mac OS classic  

o 1994 PowerPoint 4.0 for Mac OS classic  

o 1998 PowerPoint 98 (8.0) for Mac OS classic (Office 1998 for mac)  

o 2000 PowerPoint 2001 (9.0) for Mac OS X (Office 2001 for mac)  

o 2002 PowerPoint v. X (10.0) for Mac OS X (Office:mac v. X)  

o 2003 PowerPoint 2003 (version 11) — (Office 2003)  

o 2004 PowerPoint 2004 (11.0) for Mac OS X (Office:mac 2004)  

o 2006-2007 PowerPoint 2007 (version 12) — (Office 2007) 

o 2008 PowerPoint 2008 (12.0) for Mac OS X (Office:mac 2008)  

 

6.2.5 SLIDE LAYOUTS:  
One of the most important things in the Power Point presentation programme are the 

slide layouts.  

Each presentation would have one or more than one slides. Each Power Point 

slide has a specific page layout associated to it. The page layout of a slide decides 

the position of various objects you can have in Power Point. It also specifies the 

default text attributes and style like the font face, font size, font color, font style, 

alignment etc., the line thickness, it’s style, color etc.  

Power Point provides 24 different types of page layouts along with a blank 

page layout. To have customized objects and object appearance use the blank page 

layout. Page layouts basically ease out the creation of slides with template for most 

commonly used object combinations.  

The defaults objects present in any of the 24 default page layouts provide by 

Power Point are called as “Click here” objects. At the start each such box would 

have the explanation of what is the functionality of that box. All the user needs to do 

is position the mouse pointer on the object and click once. This automatically triggers 

off the corresponding operation.  

 
Select Slide Layouts:  
When you select to create a new presentation or select to add a new dialog box 

appears asking you to select the desired page layout from the available list, select 

the page layout and choose OK. Your first slide or the new slide would be inserted 

with the new page layout.  

 



Change Slide Layout:  
You can also change the page layout after you have completed the slide. This would 

be advantageous when you want to give specific slide backgrounds.  

o Select Slide Layout from the Format Menu  

o Select the desired page layout or select blank  

 
6.2.6 GETTING MORE FAMILIAR WITH POWERPOINT:  
The text, organization chart, graph or the picture present on a Power Point slide is 

called an object. If you need to make any kind of changes you have to first select the 

object. Any operation performed is specific to the selection. Let us look at some of 

the terms and selection methods followed in PowerPoint the object or objects 

selected would get eight small squares around it.  

 
Making Selections:  
Selecting a Single Object: Take the mouse pointer to the specific object and click on 

the object.  

Selecting Multiple Objects: Position the cursor on the object obtaining the text and 

click. Now, hold down the Shift key and position the mouse pointer on the second 

object and click, then release the Shift key, both the objects now remain select. To 

select more objects repeat the same procedure.  

Selecting a Text Object: Position the cursor on the object containing the text and 

click once. Now the text object is selected. Clicking on it again will take you to the 

text entry mode or modify mode.  

Selecting all the Objects: Choose Select All from the Edit Menu.  

 
Increase or Decrease an Object Size:  
The method to follow either to increase or decrease the size of the object is similar to 

the method used to increase or decrease the size of a window under your desktop.  

o Select the object.  

o Position the tip of the mouse pointer to touch the corresponding box to which 

you need to increase or decrease the size of the object.  

o Hold down the left mouse button and drag the mouse to the left, right, top or 

bottom.  

o A ghost outline appears indicating the new size of the object.  



o Decide upon the size and release the left mouse button.  

 
Moving an Object:  

o Select the object or objects to be moved.  

o Position the mouse pointer within the object frame.  

o Hold down the left mouse button and drag your mouse.  

o A ghost outline appears indicating the new location of the object.  

o Release the left mouse button to move the object to the selected location.  

 
Deleting an Object:  

o Select the object or objects.  

o Press the Del key on the keyboard or Select clear from the Edit menu.  

 
Change the Object Color:  

o Select Toolbars from the View menu.  

o Select Drawing.  

To change the Area Color:  

Select the new color for the area of the object by clicking on the Fill Color Tool. 

To change the Line Color:  

o Select Toolbars from the View menu.  

o Select Drawing  

To change the Area Color:  

Select the new color for the area of the object by clicking on the Fill Color Tool. 

To change the Line Color:  

Select the new color for the area of the object by clicking on the Line Color Tool. 

To change the Line Thickness:  

Select the new color for the area of the object by clicking on the Line Thickness Tool.  

 
EDITING A SLIDE:    
By now, after using Windows and Word you are familiar with the Cut/Copy/Paste 

operation. The same can be performed in Power Point. Select the objects to be 

moved or copied, select the corresponding option or tool. You can also find a string 

to replace the same. Select Find from the Edit menu to search for a string:  



o To replace a string with another string select Replace from the Edit Menu to 

search for and replace the string.  

o To store the previous state of an operation select Undo from the Edit Menu.  

 
WORKING WITH SLIDES:   
To Insert a New Slide:  

o Select New Slide from the Insert Menu or click on the new slide tool in the 

standard toolbar.  

o Select the Page layout.  

To Duplicate a Slide:  
o Duplicating a slide is possible only through the Slide sorter view.  

o Select the slide to duplicate by clicking on the same. This selected slide will 

be highlighted.  

o Select Duplicate from the Edit Menu.  

To Delete a Slide:  
o Highlight the slide through Slide Sorter View.  

o Select Delete Slide from the Edit Menu.  

The slide background remains the same for the entire slide, if any of the 24 default 

page layouts of Power Point is used. If you desire individual backgrounds for slides 

then you would have to change each page layout to Blank. To do this:  

o Select Background from the Format Menu.  

o Select the color for the slide background.  

o Select Apply to apply the background to the active or selected slide.  

o Select Apply to All to apply the selected background to all the slides.  

o Select Fills Effects from Background dialog box to change the effect and 

pattern.  

 
APPLYING TEMPLATES:   
Use this selection to pick a slide design from a list of different sections:  

o Selection Format > Apply Design  
o Select any one of the templates on the left-hand side.  

o Click on the apply button.  

o All the slides/charts will be updated.  

 



POWER POINT VIEWS:   
Slide View:  
The slide view is the default view used to create and edit your slides. In this views all 

the menus and toolbars are available.  

Outline View:  
The outline view is used to display the outline format of your slide show. The slide 

number and text contents are displayed in this view. Switching to outline view takes 

the data from your slides and redisplays it in the form of an outline. Any change you 

make to the presentation while in outline view is automatically reflected in the 

representation when you return to the slide view.  

The following list highlights a few important points about outline view.  

o The outline is made up of titles and body text of each slide.  

o Any other objects you have added to a slide such as picture charts and so on 

are not included in outline.  

o Also if you add any text object to the slide in addition basic title and body text 

objects are automatically included when you create a new slide, the additional 

text objects are not included in the outline.  

o A high level heading in the outline the text of this heading is drawn from the 

slide’s title represents each slide, and a button that represents the entire slide 

appears next to the headings.  

o Also the slide number appears to the left of the slide button.  

o Each text line from a slide’s body text appears as an indented heading 

subordinates to the slide’s main title heading.  

o Power Point enables you to create as many as five heading levels on each 

heading slide.  

 
Promoting and Demoting Paragraphs:  

o To promote paragraphs means to move it up one level in outline.  

o To promote a paragraph, place the cursor anywhere in the paragraph and 

then click on the promote button.  

o To demote a paragraph is just the opposite the paragraph moves down on 

level in the outline. To demote a paragraph place the cursor anywhere in the 

paragraph and press the demote button.  



If you demote a slide title, the entire slide is included into the preceding slide. In 

other words, the slide title becomes a main point in the preceding slide.  

 
Moving Text Up and Down:  
Outline view is also handy for rearranging your presentation. You can easily change 

the order of individual points on the slide, or you can rearrange the order of the 

slides.  

o To move the select text up  

o To move the selected text down  

 
Expanding and Collapse\point the Outline:  
Power Point enables you to collapse outline so that only the slide titles are shown. 

Collapsing the outline doesn’t delete the body text; it merely hides it so that you can 

focus on the order of the slides in your representation. Expanding a presentation 

restores the collapse body text to the outline so that you can once again focus on 

details.  

o To collapse an entire presentation  

o To expand an entire presentation  

 
Slide Sorter View:  
The slide sorter view gives you a miniature picture of each slide. You can use this 

view to select and drag slides from one position to another within your slide show. 

This sorts, or rearrangements the order in which your slides are presented.  

 
Notes View:  
The notes view is used to enter notes or script for the slide within a presentation. 

Once the notes are added, you can print the slide show and use the printed output 

as a script. You can also give the copies of printed materials to your audience as in-

depth handouts.  

 
Slide Show:  
This view displays the slides in full screen. It is used to either actually show or simply 

review your slide presentation. Use this view to check final sizes, color, animation, 

and transitions between slides, sounds and other controls. To check the timing of 



self-running presentation, use the view > Slide show menu selection. You can also 

distribute your presentation with the Power Point viewer program, used to run 

presentations without the actual Power Point program.  

 
The Slide Master:  
The slide master is the master organizer. All the slides follow the pattern of the slide 

master. The slide master will automatically be active in the background whenever 

slides are prepared or opened.  

 
BUILT-UP WIZARDS:  
Now that you familiar with some Power Point basics, it’s time to take a look at Power 

Point’s built-in design aids, called wizards. You encounter a wizard each time you 

launch the Power Point program. Look at the first dialog. In previous activities you 

closed this dialog and used File > New or File > Open. However, both these 

operations are easily achieved with this dialog. The four choices presented by the 

dialog are summarized. Then, the Auto Content Wizard selection is explored in more 

detail.  

Auto content wizard: This selection launches a series of wizard dialogs that guide 

you through the creation of a few presentations.  

Template: This selection allows you to pick a slide design template from a large list 

of background patterns and colors.  

Blank Presentation: This selection opens the New Slide dialog from which you 

choose the layout of the first slide in a new presentation.  

Open an Existing Presentation: This selection uses the File > Open Dialog from 

which you can pick an existing slide presentation file.  

 
Using the Auto Content Wizard:  
Use the procedure to familiarize yourself with the Auto Content wizards.  

1. Click on the Auto Content Wizard button. Then click on OK to view the opening 

dialog.  

2. Click on Next do display the first working dialog. Select the type of presentation 

you want.  

3. Click on Next and select the type of presentation.  



4. Click on Next and check the selections one this dialog as shown in the 4th step. 

We consider this an On-Screen presentation. And choose NO at “Will you print 

handouts?” option. You can change your mind later if you decide to print paper 

copies of your slides. Notice that PowerPoint can create pages for use as overhead 

projections transparencies, in either color or black and white. PowerPoint can also 

produce files that are compatible with 35mm slide making equipment from Genicom. 

If you want use this service, you should select this add-in using Setup.  

5. Click on Next and click on Finish to let Power Point build the presentation for you.  

6. The slides already have key sales points and list suggested information for 

inclusion in your presentation, At this point, you are ready to begin customising the 

information to suit your needs.  

 
EXAMPLE OF CREATING A PRESENTATION SLIDE:   

1. Execute PowerPoint and select blank presentation.  

2. Select the slide layout according to the requirement and click on OK.  

3. Now create title slide by tying the information.  

4. Click on Apply Design Template from common task taskbar. Notice the 

following dialog.  

5. Select the design from the list of design templates and click on Apply.  

6. Click on New Slide and pick second slide on the top row. Click on OK.  

7. Type the information for the second slide.  

8. Click on New Slide, pick the Text & Clip Art layout and click on OK.  

9. Type the title and bulleted text as shown below.  

o Double click on the picture. It will take you to Clip Art and select the 

picture click on Insert.  
o Click on New Slide and double-click on the bulleted list side. 

10. Now use File > Save to save your presentation. Type the file name and 

click on Save. Notice that it is saved as a presentation (*.ppt) file type.  

11. Press the Ctrl + Home to move back to the first slide. Then click on Slide 
Show view button.  

 
INSERTING CLIP-ART PICTURES INTO SLIDES:  
These steps show you how to insert clipart pictures into your presentation:  

o Move to the slide on which you want to paste the clipart.  



o Choose the Insert > Picture > Clip Art command.  

o Choose the Clip Art picture you want.  

o Clip on Insert to insert the picture.  

 
Moving, Sizing and Stretching Pictures:  
Follow these steps to force your inserted Clip Art into full compliance:  

· Click on the picture and drag wherever you want.  

· Notice the eight handles. Drag one of them to resize the picture.  

 
Editing a Clip Art Picture:  
Sometimes one of the clipart pictures supplied with PowerPoint is close but not 

exactly what you want. In that case you can insert the picture and then edit it. These 

steps tell you how to edit a clipart picture.  

1. Choose the picture you want to edit.  

2. Use the Draw > Ungroup command to convert the picture to PowerPoint 

shapes that you can edit.  

3. Now edit the picture.  

To beautify your presentation you can add pictures onto your slide. You can either 

insert a picture created using another drawing utility or insert the pictures available 

through Microsoft Office’s Clipart Gallery.  

 
SLIDE SHOW:   
Once your slides are ready, you are ready for the presentation. Before you start the 

slide show you can apply various effect onto the slide show. The change over of 

slide can have various transition effects or the data present in a Bulleted List box of 

the Bulleted List Page Layout can have a move-in effect with various builds. The 

best view to apply transition and to build slides for presentation is the slide sorter 

view, which allows easy access to select slides.  

 
USING SLIDE TRANSITIONS:   
A transition is how PowerPoint gets from one slide to the next during an on screen 

slide show. The normal way to jump from slide to slide is simply to cut to the new 

slide. Effective, PowerPoint enables you to assign any of 45 different special effects 

to each slide transition.  



For example, you can have slide scoot over the toop of the current slide from 

any direction or you can have the current slide scoot off the screen in any direction to 

reveal the next slide.   

 

6.3 SUMMARY:  
o Multimedia is the combination of sound, graphics, animation, and video with 

traditional media such as text. In the world of computers, multimedia is a 

subset of hypermedia that combines the elements of multimedia with 

hypertext, which links the information.  

o Microsoft PowerPoint is a presentation programme developed by Microsoft for 

its Microsoft Office system. Microsoft PowerPoint runs on Microsoft Windows 

and the Mac OS computer operating systems.  

o Bob Gaskins and software developer Dennis Austin developed the original 

Microsoft Office PowerPoint as Presenter for Forethought, Inc, which they 

later renamed PowerPoint. 

 

6.4 KEY WORDS:  
Multimedia Application Programmes: A multimedia application is one that uses a 

collection of media sources. Some of the better-known examples of such 

applications are PowerPoint, the presentation package from Microsoft, and Acrobat, 

the document presentation product from Adobe Systems.  

Power Point: Microsoft’s PowerPoint is a presentation programme developed by 

Microsoft for its Microsoft Office system. Microsoft PowerPoint runs on Microsoft 

Windows and the Mac OS computer operating systems.  

Slide Show:  Once your slides are ready, you are ready for the presentation. Before 

you start the slide show you can apply various effect onto the slide show. The 

change over of slide can have various transition effects or the data present in a 

Bulleted List box of the Bulleted List Page Layout can have a move-in effect with 

various builds. 

Using Slide Transitions: A transition is how PowerPoint gets from one slide to the 

next during an on screen slide show. The normal way to jump from slide to slide is 

simply to cut to the new slide. Effective, PowerPoint enables you to assign any of 45 

different special effects to each slide transition. 

 



6.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
14.  Write a detailed note on the Power Point Presentation programme.  

15. Discuss the major facilities available in the Power Point Presentation programme. 

16. Write a detailed note on slide preparation in Power Point. 
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LESSON STRUCTURE:  
In this lesson we shall discus about the various aspects of the MS Excel software 

programme. First, we shall focus on the basics of Excel. We shall also briefly discuss 

the Excel styles. The lesson structure shall be as follows:  

7.0 Objectives  

7.1 Introduction  

7.2 Presentation of Content  

7.2.1 MS Excel- An Introduction  

7.2.2 Versions of MS Excel 

7.2.3 Basics of MS Excel  

7.2.4 Excel Styles 

7.3 Summary 

7.4 Key Words  

7.5 Self-Assessment Questions (SAQs) 

7.6 References/Suggested Reading 

 

7.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Get an Introduction to MS Excel  

o To Understand the Various Versions of MS Excel   

o To Know About the Basics of MS Excel  
o To Understand the Various Excel Styles  

 

7.1 INTRODUCTION: 



Microsoft Excel (full name Microsoft Office Excel) is a spreadsheet application 

written and distributed by Microsoft for Microsoft Windows and Mac OS. It features 

calculation and graphing tools, which, along with aggressive marketing, have made 

Excel one of the most popular microcomputer applications to date. It is 

overwhelmingly the dominant spreadsheet application available for these platforms 

and has been so since version 5 in 1993 and its bundling as part of Microsoft Office. 

Microsoft originally marketed a spreadsheet program called Multiplan in 1982, 

which was very popular on CP/M systems, but on MS-DOS systems it lost popularity 

to Lotus 1-2-3. This promoted development of a new spreadsheet called Excel, 

which started with the intention to, in the words of Doug Klunder, 'do everything 1-2-3 

does and do it better’.  

The first version of Excel was released for the Mac in 1985 and the first 

Windows version (numbered 2.0 to line-up with the Mac and bundled with a run-time 

Windows environment) was released in November 1987. Lotus was slow to bring 1-

2-3 to Windows and by 1988 Excel had started to outsell 1-2-3 and helped Microsoft 

achieve the position of leading PC software developer.  

This accomplishment, dethroning the king of the software world, solidified 

Microsoft as a valid competitor and showed its future of developing graphical 

software. Microsoft pushed its advantage with regular new releases, every two years 

or so. The current version for the Windows platform is Excel 12, also called Microsoft 

Office Excel 2007. The current version for the Mac OS X platform is Microsoft Excel 

2004. 

Microsoft Excel 2.1 included a run-time version of Windows 2.1. Early in its life 

Excel became the target of a trademark lawsuit by another company already selling 

a software package named "Excel" in the finance industry. As the result of the 

dispute Microsoft was required to refer to the program as "Microsoft Excel" in all of its 

formal press releases and legal documents. However, over time this practice has 

been ignored, and Microsoft cleared up the issue permanently when they purchased 

the trademark to the other program.  

Microsoft also encouraged the use of the letters XL as shorthand for the 

program; while this is no longer common, the program's icon on Windows still 

consists of a stylized combination of the two letters, and the file extension of the 

default Excel format is .xls. Excel offers many user interface tweaks over the earliest 

electronic spreadsheets; however, the essence remains the same as in the original 



spreadsheet, VisiCalc: the cells are organized in rows and columns, and contain 

data or formulas with relative or absolute references to other cells.  

 In this lesson we shall discus about the various aspects of MS Excell.  
 
7.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o MS Excell- An Introduction   

o Versions of MS Excel  
o Basics of MS Excel  
o Excel Styles  

 
7.2.1 MS EXCELL- AN INTRODUCTION:  
MS Excel is a Windows based spreadsheet (worksheet) package. When calculations 

are made on paper and certain data must be changed, then the entire work must be 

recalculated and re-written. If a spreadsheet package is used then the re-calculation 

is automatic. The details of bank passbook, tax, inventory, purchase and sales can 

also be maintained using a spreadsheet package. Lotus 1-2-3, Quattro Pro, 

Symphony, MS Excel etc. are spreadsheet packages.  

Excel was the first spreadsheet that allowed the user to define the 

appearance of spreadsheets (fonts, character attributes and cell appearance). It also 

introduced intelligent cell re-computation, where only cells dependent on the cell 

being modified are updated (previous spreadsheet programs recomputed everything 

all the time or waited for a specific user command). Excel has extensive graphing 

capabilities. 

When first bundled into Microsoft Office in 1993, Microsoft Word and Microsoft 

PowerPoint had their GUIs redesigned for consistency with Excel, the killer app on 

the PC at the time. 

Excel has included Visual Basic for Applications (VBA), a programming 

language based on Visual Basic which adds the ability to automate tasks in Excel 

and to provide user defined functions (UDF) for use in worksheets. VBA is a powerful 

addition to the application, which, in later versions, includes a fully featured 

integrated development environment (IDE).  

Macro recording can produce VBA code replicating user actions, thus allowing 

simple automation of regular tasks. VBA allows the creation of forms and in-



worksheet controls to communicate with the user. The language supports use (but 

not creation) of ActiveX (COM) DLL's; later versions add support for class modules 

allowing the use of basic object-oriented programming techniques. 

The automation functionality provided by VBA has caused Excel to become a 

target for macro viruses. This was a serious problem in the corporate world until anti-

virus products began to detect these viruses. Microsoft belatedly took steps to 

prevent the misuse by adding the ability to disable macros completely, to enable 

macros when opening a workbook or to trust all macros signed using a trusted 

certificate. 

 
7.2.2 VERSIONS OF MS-EXCEL:  
Versions of Microsoft Excel for Windows: 
1987 Excel 2.0 for Windows  

1990 Excel 3.0  

1992 Excel 4.0  

1993 Excel 5.0 (Office 4.2 & 4.3, also a 32-bit version for Windows NT only on the 

Power Pc, DEC Alpha, and MIPS)  

1995 Excel for Windows 95 (version 7.0) - included in Office 95  

1997 Excel 97 - (version 8.0) included in Office 97 (x86 and also a DEC Alpha 

version)  

1999 Excel 2000 (version 9.0) included in Office 2000  

2001 Excel 2002 (version 10) included in Office XP  

2003 Excel 2003 (version 11) included in Office 2003  

2007 Excel 2007 (version 12) included in Office 2007  

  

Versions for the Apple Macintosh include: 
1985 Excel 1.0  

1988 Excel 1.5  

1989 Excel 2.2  

1990 Excel 3.0  

1992 Excel 4.0  

1993 Excel 5.0 (Office 4.X -- Motorola 68000 version and first PowerPC version)  

1998 Excel 8.0 (Office '98)  

2000 Excel 9.0 (Office 2001)  



2001 Excel 10.0 (Office v. X)  

2004 Excel 11.0 (part of Office 2004 for Mac)  

2008 Excel 12.0 (part of Office 2008 for Mac)  

 

CRITICISM:  
Due to Excel's foundation on floating point calculations, the statistical accuracy of 

Excel has been criticized, as has the lack of certain statistical tools. Excel 

proponents have responded that some of these errors represent edge cases and 

that the relatively few users who would be affected by these know of them and have 

workarounds and alternatives.  

Excel incorrectly assumes that 1900 is a leap year. The bug originated from 

Lotus 1-2-3, and was implemented in Excel for the purpose of backward 

compatibility. This legacy has later been carried over into Office Open XML file 

format. Excel also supports the second date format based on year 1904 epoch. 

 
7.2.3 EXCEL BASICS:  
Before working with MS-Excel, different parts of Excel spreadsheet must be 

identified.  

Parts of MS-Excel Spreadsheet:   
When MS-Excel is loaded, the Excel window will appear on the screen.  

Excel window appearance with its parts as given below.  

Title bar — Displays the application name, file name and various window controls 

like minimize button, maximize button and close button.  

Menu bar — Different options for selection  

Standard Toolbar — Displayed by default, allows giving common commands like 

saving the file, opening a file, printing etc.  

Formatting Toolbar — Allows the user to give commands related to formatting cells 

and cell contents like Bold, Underline, Font style, Font size, Color etc.  

Name Box — Displays the address of the current cell.  

Formula Bar — Displays the cell content  

Current Cell — Current cell will be the active cell.  

Row Headers — There are 65536 rows (lines) numbered 1,2,3.....65536. First row 

number is 1 and the last row number is 65536. To go to cell in last row, press End 

and Down arrow key, to return to cell in first row, press End and Up arrow key.  



Column Headers — There are 256 columns as A, B, C .... Z, AA, AB....AZ, BA, 

BB...IV. First column name is A and last column name is IV. To go to the cell in last 

column header press End and Right arrow key, to return to the cell in first column, 

press End and Left arrow key.  

Scroll Bars — Used to scroll through different parts of current sheet.  

Split Boxes — Used to split the window into 2 or 4 parts or to remove the split.  

Tab Split Box — Used to adjust the space occupied by the sheet tabs and 

horizontal scroll bar.  

Sheet Tabs — Displays the sheet names. Each worksheet is named as Sheet 1, 

Sheet 2 and Sheet 3.  

Status Bar — Displays on the left side various modes like Ready or Edit mode. The 

status on num lock, caps lock and scroll lock keys on the keyboard on the right side. 

 

WORKSHEETS WITH IN WORKBOOK:  
Excel documents (files) are known as workbooks. Each Workbook contains 3 

worksheets by default. Adding or deleting the sheets can change the number of 

sheets. Each sheet is named uniquely like Sheet 1, Sheet 2 etc. which is displayed 

in the sheet tab. A workbook can also contain chart sheets, which are named as 

Chart 1, Chart 2 etc., by default. When Excel is loaded, it automatically opens a new 

workbook, named BOOK1. (With extension. XLS.) This name is displayed on the title 

bar. The main part of the Excel screen is the worksheet area — a grid of rows and 

columns. The worksheet contains 65536 rows and 256 columns.  

CELL:  
The intersection of a column and a row is called as a cell. Each cell has a name or a 

cell address. The cell address consists of the column letter and a row number. For 

instance, the first cell is in first column and first row. First column name is A and first 

row number is 1. Therefore, the first cell name address is A1. First cell is also called 

as Home Cell. Similarly, the last cell address is IV65536 (column IV and row 65536). 

Total cells in a worksheet are 256 * 65536 (total number of columns x rows). At any 

time one cell can be active and the address of the active cell is displayed in the 

name box. A thick black border indicates the active cell. Any cell can be made active 

by clicking on that cell. Using key combinations also it is possible to move quickly to 

the desired cell.  

NAVIGATING WORKSHEET:  



To move to any cell of any worksheet of an open workbook, the mouse can be used. 

· To scroll through different parts of the worksheet, drag the scroll box in the scroll 

bars or click on the arrow marks in the scroll bars. · To go to different sheets in the 

workbook, click on the desired sheet name in the sheet tab.  

· To go to a desired cell, cell inside the cell, or select Edit > Go To type the desired 

cell address in the Reference box (for example, D7) and click on OK. Or  

· Click on the name box, type the desired cell address and press Enter.  

ENTERING AND EDITING DATA:  
Any entry can be made in the active cell. Entries can be of 4 different types. 

They are:  

· Text — Text in a cell include any combination of letters, numbers, and keyboard 

symbols. A cell can contain 32000 characters. If column width prevents a text string 

fitting visually in a cell, the display extends over neighboring cells. However, if the 

neighboring cells are occupied, the display is truncated. To store a number as a text 

entry, use apostrophe (‘) as the first character.  

· Numbers — Numbers include digits from 0 to 9 and some special characters like $ 

% + - / (), etc. Date and time are stored as numbers. If 8-15 is entered in a cell, excel 

will display it as 15-Aug. When an unformatted number does not fit in a cell, it is 

displayed in scientific notation. When a formatted number does not fit in a cell #### 

is displayed.  

· Logical Values — Logical entries, TRUE and FALSE (uppercase only) can be 

entered in the cells.  

· Formulas — Formulas are entered into the cell to perform calculations. A formula 

begins with an equal sign (=). After completing the formula entry, the result of 

formula will be displayed in the cell and the formula will be displayed in the formula 

bar. If the formula entered is wrong, error values are stored in the cell. Built-in-

functions, which are used to perform some calculations, are also treated as a 

formula entry.  

To Make Any Entry in the Cell  
· Make the cell active (select the cell) by click on the cell or by pressing arrow keys. 

· Type the content of cell. · Press Enter or press the arrow keys or click on any other 

cell to complete the entry. 

To Edit the Cell Content  
Make the cell active (select the cell) and use any one of the following methods. 



· Press F2 function key or double click on the cell, make the correction in the cell 

content and press Enter.  

· Click on the formula bar (which displays the active cell content), make the 

correction and press Enter.  

· To delete the cell content, click on the cell and press Delete.  

COPYING AND MOVING CELL CONTENTS:  
Copying the cell content  

To copy the cell contents to other cells,  

· Select the range of cell, Choose Edit > Copy or Ctrl + C, go to the new position and 

press Enter. Or 

· Select the range of cells, point at the outside border of the selected range using 

mouse, the mouse pointer will turn into an arrow, hold down the ctrl key and drag the 

selection to a new location.  

Moving the cell content:  
To move the cell content to another location,  

· Select a range of cells, Choose Edit >Cut or Ctrl + X, go to the new position, and 

press Enter.  

Or  

· Select the range of cells, point at the outside border of the selected range using 

mouse, the mouse pointer will turn into an arrow, drag the selection to a new 

location.  

INSERTING CELLS, COLUMNS, AND ROWS:  
To insert cells, columns and rows select Insert > Cells.... Insert dialog box will be 

displayed with the following options,  

· Shift cells right insert a new cell and existing cells will be shifted to the right.  

· Shift cells down insert a new cell and existing cells will shifted down.  

· Entire row will insert one row.  

· Entire column will insert one column.  

Choose Insert > Columns option to insert one or more columns. To insert more than 

column, block the number of columns to be inserted and choose insert > Columns. 

Insert > Rows option will insert one row in current position. To insert many rows 

block the number of rows to be inserted and choose insert > Row.  

OPERATOR:   



Operator is a symbol used to specify the type of calculation that is to be performed 

on the elements of a formula. Microsoft Excel includes four different types of 

calculation operators: arithmetic, comparison, text and reference.  

Arithmetic Operators:  
Arithmetic operators perform basic mathematical operations such as addition, 

subtraction, multiplication; combine numbers; and produce numeric results.  

+ (plus sign) Addition 3+3  

- (minus sign) Subtraction Negation 3-1-1  

* (asterisk) Multiplication 3*3  

/ (forward slash) Division 3/3  

% (percent sign) Percent 20%  

^ (caret) Exponentiation 3 ^ 2  

Comparison Operators:  
These operators compare two values and then produce the logical value TRUE or 

FALSE.  

= (equal sign) Equal to A1 = B1  

> (greater than sign) Greater than A1 > B1  

< (less than sign) Less than A1 < B1  

>=(greater than or equal Greater than or equal to A1 > = B1 to sign) 

<= (less than or equal to sign) Less than or equal to A1 <= B1  

<> (not equal to sign) Not equal to A1<> B1  

Text Operator:  
The text operator “&” combines one or more text values to produce a single piece of 

text. & (ampersand) Connects, or concatenates, two value of produce one continues 

text value “North” & “wind” produce “North wind”  

Reference Operators:  
Reference operators combine a range of cells for calculations.  

: (colon) Range operator, which produces one B5 : B15  

reference to all the cells between two references, including the two references.  

, (comma) Union operator, which combines SUM (B5:B15, D5:D15) multiple 

references into one reference (single Intersection operator, which produces space) 

SUM (B5:B15 A7 : D7) one reference to cells common to two in this example, cell B7 

references. is common to both ranges.  

FUNCTION WIZARD f*: 



The function can also be entered using the Function Wizard, instead of typing them 

.To use the function wizard.  

· Click on the cells where the function is to be included  

· Click on the function wizard icon named paste Function available in the Standard 

Toolbar (or select Insert >function...)  
· Select a function category in the left side. Available in that category will be 

displayed on the right side. Select the required functions and click on OK.  

· Now, give the range in the place of number1, number2 etc. either by typing the 

range manually or by blocking the range. The result will be displayed inside the 

dialog for confirmation. To end it, click on OK.  

CELL FORMATTING:  
There are different categories of formats available like General, Number, Currency, 

Date, and Text etc. To select a format,  

1. Click on the cell or select a range of cells that are to be formatted.  

2. Select Format > Cells: The Format Cells dialog box will be displayed, here, you 

may choose the desired format. General will be the default format.  

· Number format is used to specify number of decimals; thousand-separator symbol 

and how negative numbers are to be displayed.  

· Currency format is used to specify the number of decimals, the currency symbol, 

and how the negative numbers are to be displayed.  

· Accounting format can be used to specify the number of decimals and a currency 

symbol.  

· Date format can be used to specify, how the date must be displayed in a cell i.e. 

month in words etc.,  

· Time format is used to specify 24 hour or 12 hour format, display seconds or not.  

· Percentages format multiply the cell value by 100 and display the result with a 

percent % symbol. Number of decimals can be specified.  

· Text format can be used to represent a number entered in a cell as a text entry.  

 

7.2.4  EXCEL STYLES:  
Excel allows the user to a whole lot of different kinds of formatting, i.e. number 

format, font, alignment, borders, patterns, and protection status in one dialog box. 

Instead of using all the above individually to a certain cell the style feature provides 

the user to set a specific formatting to certain cells. The same style can be used 



format any other cell. It is very useful for the user to use styles as it saves time and 

also establishes formatting standard.  

Excel includes six built-in styles like Comma, Comma, Currency, Currency, 

normal, and Percent of which Normal style is commonly used. The user can also 

create other styles with specific formatting. When the workbook is saved along with it 

the styles are also saved.  

 

Creating Styles:  
To create styles, select Format > Style. A list of style names will be displayed. A new 

style name can be specified for the style already created by the user. To do this, type 

any name in the style name box and choose add. The style name that has been 

created can be later applied to format cells simultaneously.  

Note: Row height and column width is not part of the style definition.  

 

Custom List:  
A custom list is a collection of some commonly used words, which can be 

reproduced by dragging the fill handle. For example, a company operates in for 

different regions (North, South, East and West), and the region has to be typed 

constantly onto the worksheet. A custom list can be used to save data entry time.  

 

Defining Custom List (When list is already existing on the worksheet):  
· Enter the list into a (contiguous) range of cells, in a row or column.  

· Select the range of cells containing the list.  

· Choose Tools > Options, then select the Custom Lists tab.  

· Click on the Import button (the list will be displayed in the Custom List box and List 

Entries box)  

· Click on OK  

 

Defining Custom List (By typing the list in the List Entries Box):  
· Choose Tools > Options, then select the Custom Lists tab.  

· Click on the New List Option from Custom List or click in the List Entries Box. 

· Type the entries in the List Entries box, beginning with the first entry. Press ENTER 

after each entry. Click on OK after completing the List entries.  

 



CHARTS:  
Charts are graphical representation of numerical data. A set of numeric data, which 

is actually plotted, is called data series. Each value in the data series is a data point. 

Data series can be in rows or columns.  

Types of Charts:  
Depending on the appearance of chart, chart can be Embedded Chart and Chart 

Sheet. Embedded chart is drawn on the worksheet where the data exists. Chart 

sheet is a separate sheet containing only the chart in it.  

Creating a Quick Chart Sheet:  
To create a chart in a separate sheet, select the data with column headings and one 

text column.  

E.g. select A2: D6 and press F11. A default chart (generally a column chart) will be 

created in a separate sheet named Chart1, before the sheet, which contains the 

data. The chart created will not have any titles, legends, or data labels. The chart will 

be drawn with series column-wise.  

Steps to Create a Regular Chart:  
Select the data range with the column headings and one text column entry, e.g., 

A2:D6.  

Click on the Chart Wizard icon in the Standard Toolbar or select Insert> Chart. Chart 

wizard step 1 of 4 dialog will be displayed.  

Step 1, displays the available type of charts under the groups Standard Type and 

Custom Type. Default is the Column Chart available in the group Standard Types. 

Select a type of chart. On the right side, the selected chart’s sub-types will be 

displayed. Select a sub-type. To see the Sample chart click and hold down the 

Press and hold to view example Button. Click on Next to go to second step.  

Step 2, allows the user to specify the data range, series in rows or columns, and 

specify the range of each series including the range of xalis labels. In the Data 

Range tab, we can specify the data range (range of data series to be plotted and x-

axis labels) and whether the series in Rows or Columns.  

Default is series in Columns: The sample chart will be displayed on the screen and if 

information is changed it will be modified automatically. For example, select series in 

Rows, the chart will be modified to show the series in rows. If the data range is not 

displayed, then it can be specified by typing the range or clicking in the data range 

box and by blocking the data range in the worksheet. The range will be displayed in 



the data range box and the chart sample will be displayed accordingly. The data 

range displayed there can also be edited.  

The second tab Series, is used to specify the range for each data series with 

the cell, which contains the name of series, adding or removing a series and 

specifying the x-ails labels. After specifying these things, click on Next to move to the 

third step.  

In Step 3, titles, axes, grid lines, legend position, data labels, and data tables for the 

chart can be specified.  

 

Titles: Allows you go give different titles for the chart.  

Chart Title: Main title for the chart.  

Category (X) axis: Title for X-axis, will be displayed below the X-axis labels.  

Value (y) axis: Title for the Y-axis, will be displayed at the left side of Y-axis 

numbers.  

Second category (X) axis: Title for the Second X-axis.  

Second Value (Y) axis: Title for the secondary Y-axis, will be displayed at the right 

side of numbers. Second Y-axis will appear on the right side of column chart.  

For the chart, given the chart title - Sale of Soaps in Oct., Nov. and Dec., category 

(X) axis title — Soaps, value (Y) axis title — Quantity.  

Axis: It can be used to specify whether the primary X-axis and Y-axis must be 

displayed in the chart or not.  

Category (X) axis: If deselected, X-axis labels will not be displayed. If selected, X-

axis labels can be displayed in date format or with the content of X-axis label range.  

Value Y-axis: If deselected, Y-axis numbers are not displayed. To display Y-axis 

numbers, this option must be selected.  

Gridlines: It is used to specify whether major and minor X-axis and Y-axis gridlines 

are to be displayed in the chart or not. By default, only value Y-axis Major gridlines 

will be displayed.  

Legend: It is used to specify, whether the legend for the chart is to be displayed or 

not. A legend is an index displaying the color of series and the name of series. If it to 

be displayed, specify the placement of legend in the chart (bottom, corner, top, right, 

or left). By default, the legend will be displayed at the right side of the chart.  

Data labels: It is used to specify whether the chart by default, it is not display inside 

the chart or not. Number or text displayed above each data point is called data 



labels. If the data labels must be displayed, either the value (number) or label (text) 

must be displayed as the data labels. We can also specify, whether the legend key is 

to be displayed next to the label or not. By default, the data labels are not displayed.  

Data Table: It is used to display the data below the chart. By default, it is not 

displayed. To display the data table, select Show data table check box. We can also 

specify, whether legend key must be displayed along with the data table or not. If 

data labels are displayed, data table need not be displayed in the chart. After 

specifying the required options, select Next to go to last step.  

Step 4, allows you to specify the placement of chart. The chart can be placed in a 

new chart sheet named Chart1 by selecting the option As new sheet, or it can be 

placed as an object in any one of the existing worksheets by selecting As object in.  

Click on the Finish button to complete the creation of the chart.  

 

3-D CHARTS:  
3-D charts can represent complex data better than 2-D charts. Elevation box is used 

to view the chart from specified height. The elevation ranges from-90 degrees to 90 

degrees. -90 degree is a view from directly below the plot area and 90 degree is a 

view from directly above plot area. Rotation box is used to control the rotation of the 

plot area around the z-axis -vertical axis. Rotation is measured in degrees from 0 to 

360.  

3-D charts rotation ranges from 0-44. Perspective box controls the view of the chart 

depth. The perspective value specifies the ratio of the front of the chart to the back of 

the chart. Value ranges from 0 to 100 degrees.  

 

DATA SERIES WITH DRAWING OBJECTS:  
Draw the drawing object, for example, a launching face from the auto shapes basic 

shapes. Select it by click on it, press Ctrl + C to copy it to clipboard, select the series 

and press Ctrl+V to paste it on the series. The smiling face can be copied to Dec. 

series and one face will be present for one data point. To have multiple smiling 

faces, right click on the data series, select Format Data Series, select Fill Effects 

available in Patterns tab, select Stack in the format for select Stack and Scale to and 

specify a measurement. The smiling face will be repeated to fill the data points. 

Stretch to have one picture to represent one data point.  



To remove the drawing objects included in the series, select the data series, select 

Edit > Clear > Formats.  

 

COMBINATION CHARTS:  
A combination chart will have 2 types of charts in one, one to represent some data 

series and another to represent some other data series. To create a combination 

chart, right click on the data series, select Chart Type from the shortcut menu and 

select a type of chart. The series will be converted to that chart type, by keeping the 

other series as it is. Also selecting the appropriate chart type can also create 

Combination chart.  

 

 

 

7.3 SUMMARY:  
o Microsoft Excel (full name Microsoft Office Excel) is a spreadsheet application 

written and distributed by Microsoft for Microsoft Windows and Mac OS. It 

features calculation and graphing tools, which, along with aggressive 

marketing, have made Excel one of the most popular microcomputer 

applications to date.  

o The first version of Excel was released for the Mac in 1985 and the first 

Windows version (numbered 2.0 to line-up with the Mac and bundled with a 

run-time Windows environment) was released in November 1987. Lotus was 

slow to bring 1-2-3 to Windows and by 1988 Excel had started to outsell 1-2-3 

and helped Microsoft achieve the position of leading PC software developer.  

o Excel has included Visual Basic for Applications (VBA), a programming 

language based on Visual Basic which adds the ability to automate tasks in 

Excel and to provide user defined functions (UDF) for use in worksheets. VBA 

is a powerful addition to the application, which, in later versions, includes a 

fully featured integrated development environment (IDE).  

o The statistical accuracy of Excel has been criticized, as has the lack of certain 

statistical tools. Excel proponents have responded that some of these errors 

represent edge cases and that the relatively few users who would be affected 

by these know of them and have workarounds and alternatives.  



o Excel documents (files) are known as workbooks. Each Workbook contains 3 

worksheets by default. Adding or deleting the sheets can change the number 

of sheets. Each sheet is named uniquely like Sheet 1, Sheet 2 etc. which is 

displayed in the sheet tab. A workbook can also contain chart sheets, which 

are named as Chart 1, Chart 2 etc., by default. 

 

7.4 KEY WORDS:  
Microsoft Excel: Microsoft Excel is a spreadsheet application written and distributed 

by Microsoft for Microsoft Windows and Mac OS. It features calculation and graphing 

tools, which, along with aggressive marketing, have made Excel one of the most 

popular microcomputer applications to date.  

Criticism of Excel: The statistical accuracy of Excel has been criticized, as has the 

lack of certain statistical tools. Excel proponents have responded that some of these 

errors represent edge cases and that the relatively few users who would be affected 

by these know of them and have workarounds and alternatives.  

Worksheets in Excel: Excel documents (files) are known as workbooks. Each 

Workbook contains 3 worksheets by default. Adding or deleting the sheets can 

change the number of sheets. Each sheet is named uniquely like Sheet 1, Sheet 2 

etc. which is displayed in the sheet tab. A workbook can also contain chart sheets, 

which are named as Chart 1, Chart 2 etc., by default. 

 

7.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
17. Write a detailed note on the MS Excel Spreadsheet programme.  

18. Discuss the major facilities available in the MS Excel Spreadsheet programme. 

19. Write a detailed note on the functioning of the MS Excel Spreadsheet 

programme.  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various introductory aspects of MS-Access. 

First, we shall focus on database management. We shall also briefly discuss the 

elements, field types, and table creation in MS Excel. The lesson structure shall be 

as follows:  

8.0 Objectives  

8.1 Introduction  

8.2 Presentation of Content  

8.2.1 Microsoft Access- An Introduction  

8.2.2 Microsoft Access and Database Management  

8.2.3 Elements of Microsoft Access 

8.2.4 Field Types in Microsoft Access  

8.2.5 Creating Tables in Microsoft Access   

8.3 Summary 

8.4 Key Words  

8.5 Self-Assessment Questions (SAQs) 

8.6 References/Suggested Reading 

 

8.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Get an Introduction to Microsoft Access  

o To Know About Microsoft Access and Database Management   

o To Understand the Elements of Microsoft Access  

o To Know About the Field Types in Microsoft Access  



o To Understand How to Create Tables in Microsoft Access  

 

8.1 INTRODUCTION:  
As a relational database management system, MS Access can be applied to small 

projects. But it performs poorly to larger projects involving multiple concurrent users. 

This is because it is a desktop application, not a true client-server database.  

When multiple concurrent users share a Microsoft Access database, 

processing speed suffers. The effect is dramatic when there are more than a few 

users or if the processing demands of any of the users are high. Access includes an 

Upsizing Wizard that allows users to upsize their database to Microsoft SQL Server if 

they want to move to a true client-server database. It is recommended to use Access 

Data Projects for most situations. 

 

8.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Microsoft Access- An Introduction  

o Microsoft Access and Database Management  

o Elements of Microsoft Access  
o Field Types in Microsoft Access  
o Creating Tables in Microsoft Access   

 

8.2.1 MICROSOFT ACCESS- AN INTRODUCTION: 
Microsoft Access is a relational database management system from Microsoft, which 

combines the Relational Microsoft Jet Database Engine with a graphical user 

interface. The latest version of MS Access is known as Microsoft Office Access. It is 

a member of the 2007 Microsoft Office system. 

Access is used by small businesses, within departments of large corporations, 

and hobby programmers to create ad hoc customized desktop systems for handling 

the creation and manipulation of data. Access can be used as a database for basic 

web based applications hosted on Microsoft's Internet Information Services.  

Some professional application developers use Access for rapid application 

development, especially for the creation of prototypes and standalone applications 

that serve as tools for on-the-road salesmen.  



Access allows relatively quick development because all database tables; 

queries, forms, and reports are stored in the database. For query development, 

Access utilizes the Query Design Grid, a graphical user interface that allows users to 

create queries without knowledge of the SQL programming language. In the Query 

Design Grid, users can "show" the source tables of the query and select the fields 

they want returned by clicking and dragging them into the grid. Clicking and dragging 

fields in tables to fields in other tables can create joins. Access allows users to view 

and manipulate the SQL code if desired. 

 

DIFFERENT VERSIONS OF MS-ACCESS:  
o 1992 Access 1.1 1 Windows   

o 1993 Access 2.0 2.0 Windows Office 4.3 Pro  

o 1995 Access for Windows 95 7.0 Windows 95 Office 95 Pro  

o 1997 Access 97 n/a Windows, others Office 97 Pro  

o 1999 Access 2000 9.0 Windows, others Office 2000 Pro and Premium  

o 2001 Access 2002 10 Windows, others Office XP  

o 2003 Access 2003 11 Windows, others Microsoft Office System 2003  

o 2007 Microsoft Office Access 2007 12 Windows, others 2007 Microsoft Office 

system  

 

COMPETING VERSIONS OF MS-ACCESS: 
o Amiga Datastore  

o Alpha Five  

o Borland Paradox  

o dBase  

o FileMaker Pro (formerly Claris Filemaker)  

o Kexi  

o Lotus Approach  

o OpenOffice.org Base  

o Sun StarBase  

o Sybase PowerBuilder  

 

In this lesson, we shall discuss about various aspects of MM-Access.  

 



8.2.2 MS-ACCESS & DATA BASE MANAGEMENT:  
A database is a collection of data related to a particular subject or purpose, such as 

tracking customer order or maintaining a music collection. Using MS-Access, you 

can manage all your data from a single database will have extension MDB. Within 

the database file, divide your data in to separate storage containers called tables. It 

is possible to view, add and update the table data using online forms; queries; and 

analyze or print data in a specific layout using reports.  

 

MS-ACCESS AS A RELATIONAL DATABASE MANAGEMENT SYSTEM:  
MS-Access is a RDBMS or a Relational Database Management System. Now what 

do we mean by a Relational Database? In a relational database the tables are 

related to common fields known as key fields. This help in accessing data from more 

than one table. The relationship may be defined at the time of table creation or at a 

latter stage. Usually it is done right in the beginning when planning the database 

design. The relational design process provides a structured approach to modeling an 

information system’s data and the business rules for that data. The three key 

components used in relational database design are Entities, Attributes and 

Relationships.  

KEY FIELD: We have already seen that in MS-Access data from more than one table 

can be related on a common field called key field. The key-field links the data in the 

two tables. MS-Access senses this relationship by comparing the key fields and if 

they match performs an automatic linking. Such an automatic linking is called AUTO-

JOIN. However user can specifically (manually) link any two tables on required key 

fields by creating a relationship.  

PRIMARY KEY: Primary key of a rule, which ensures that unique data is entered for a 

field and the field, is not left blank (Null). This makes the record unique. For example, 

in a Bank Master file there will be one record for one Account Number. Student roll 

numbers, Account numbers Customer numbers, receipt numbers are examples for 

primary key fields.  

LINK\TRANSACTION TABLE: To manage large amount of data, we distribute the data in 

many tables. The main table is referred to as the master table and the lower level 

table in which the related data stored is the transaction table. The two tables are 

related and must be linked based on a field, which is common.  

 



8.2.3 ELEMENTS OF A DATABASE:  
The important database objects are:  

o Tables,  

o Queries,  

o Reports,  

o Macros, and  

o Modules.  

 

TABLES: A Table is a collection of data about a specific topic, such as products, 

students or suppliers. Using a separate table for each topic means you store that 

data only once, which makes your database more effecient and reduces dataentry 

errors. Tables organize data into colums {called fields} and row {called records} M.S-

Access has a table data sheet view, where in you can add, edit, or view the data in a 

table. you can also check the spelling and print yours tables data, filter or sort 

records, change the data sheets appearance, or change the table structure by 

adding or deleting columns. in the MS-Access, table Design view, you can create an 

entire table from scratch, or add, delete, or customize an existing tables fields.  

QUERIES: You use queries to ask question about your data. Queries are also used to 

view, change, and analyze this data in different ways. Queries can be used as the 

source of records for forms and reports. The most common type of query is a select 

query. A select query retrieves data from one or more table using criteria you 

specify, and then display it in the order you want. You can create a query with a 

wizard or from scratch in query design view. In design view, you specify the data you 

want to work with by adding the tables or queries that contain the data, and then by 

filling in the design greed.  

FORMS: When a table is opened, it gets presented in a datasheet view. In datasheet 

view data is presented in row and columns. Developing a database form from 

scratch of a tedious task. MS-Access has a form Wizard with which a form can be 

created after answering a number of question about what you want to see. Columnar 

auto form creates a form with one record per page and fields arranged in columns.  

REPORTS: Reports are another type of object used in MS-Access to view and toprint 

data. Reports can present data form a single table as will as more than one table.  



MACROS: A macro executes one or more database commands automatically when it 

is executed. Macros are meant for automating those takes that you do over and over 

again.  

MODULES: A Module is another MS-Access Database object. A module is program 

you write VBA to automate and customize database functions. VBA is Visual Basic 

for Applications, the programming language included in office 97.  

 

8.2.4 FIELD TYPES IN MS-ACCESS:  
MS-Access has many field types. Listed here are some or the field types:  

Texts: These types of field hold text, letters, numbers and other characters. The 

default size is 50.  

Memo: This type of field holds an unlimited amount of text. It is used to store 

narrative descriptions like remark. It can thus store up to 32000 characters. MS-

Access uses the disk space on the basis of data entered in this type of field.  

Number: Numbers formatted in various ways can go in a number field. The data that 

can be stored in this type of field depends on the option selected from the field size 

list. The options available are:  

Byte: Stores number from 0 to 255 without decimals. It occupies one byte.  

o Integer: store numbers from -32768 to 32768 without decimals. It occupies 2 

bytes.  

o Long Integer: Store numbers -2 billion to 2 billion approximately without 

decimals.  It occupies 4 bytes.  

o Single: Store numbers with six digits of precision from -3.402823E38 to 

3.402823E38. it occupies 4 bytes.  

o Double: This is the default field size for number type of fields. It stores 

numbers with 15-digit precision from -1.7976913486232E308 to 

1.7976913486232E308. It occupies 8 bytes.  

Date /Time: dates, Time or date combinations of the transaction. The date or time 

can be stored in different fermatas.  

Currency: This type of field is for money values for any number used in calculations. 

This data type has a special in built logic that corrects rounding errors.  

Auto Number: this type of field cannot be updated or edited. MS Access 

automatically assigns a number to this field when a record is added to a table. When 



a record is added the value in this field is incremented by one. Type of field is useful, 

if the serial number is to be stored in a field.  

Yes/No: These types of field can only logical Values that can contain only one of two 

values True of False. This type of field cannot be used for indexing.  

OLE Object: This type of field is used to store an object such as a MS-Excel 

spreadsheet or a Paint Brush picture etc. The size of picture can be unto 1Ggiga 

Byte. This type of field cannot be used for indexing.  

Hyperlink: These fields hold hyperlink addresses that go to Web sites, database 

objects or other files.  

Lookup Wizard: A lookup field starts a Wizard that places lookup constraints on a 

field; the lookup values can come from a list you enter table or a query Lookup 

wizard. 

 

8.2.5 CREATING TABLES IN MS ACCESS:  
In order to create a table, we must first of all design the table i.e. the fields that must 

be preset in the table and the type of the data that must be stored in those fields. Let 

us create a master file of students. A master file is one in which we store the 

relatively permanent data of the student. For each student there will be only record in 

the table.  

 

Table design for the STDMASTER of the Student Database:  
Creating a Table Using the Design View  
* Open the database in which the table is to be created-Student. It may already be 

open.  

* The database window is displayed with tabs to create different database objects.  

* Click on the table and click on new.  

* Select Design View and click on OK. The table structure is displayed.  

Type the table structure. The table structure contains field name, data type of the 

field and the description and field properties. The top pane of the window lists the 

individual fields its type and description. The bottom pane displays the properties of 

the selected in the top pane.  

Field name can be up to 64 characters long and can contain letters numbers, 

spaces or punctuation marks expect a period (.), accent grave (^), square bracket (0) 

and exclamation (!) It should begin with a valid character or number. It is always 



better to keep the field name short and clear. For example, for students, it is better to 

give the field name as ST ID.  

 

Field properties:  
Field properties can be set on the basis of the field type. The field properties are 

different for different types of fields. The field properties panel is displayed below the 

main panel where the field names are entered.  

Caption: All types of fields have a caption property. The caption is used as the 

heading of the field’s column in Database view. The size of the caption can be upto 

255 Characters. For example the caption for the field ST ID can be student Id, for St 
Name, it can be Student Name etc. 
Field Size: Field size property applies to text and number fields only, for text field 

size can vary from 1 to 255 Defaults is 50. For numbers the size can be a Byte, 

Integer, Single or Double. Default is Double.  

Format: Format specifies how the data entered in a field must be displayed in the 

Database View. The format property will be different for different fields. To specify 

the format property for text and memo fields include a specific symbol in the format 

box. Following are the symbols available and their meanings:  

Symbol Meaning:  
< Display contents in lower case  

> Display contents in upper case  

@” NULL displays “NULL” if empty  

@ “ Not entered” display “Not entered “ if field is empty  

$ Right aligns text in columns  

To specify the formats property Number, Currency, Date/Time, Yes/ No fields, select 

appropriate option from the field property list.  

 

Default Value: Default value specifies the value that must be displayed in a 

particular field when making the data entry. For example, you can type ‘Karnataka’ 

as the default value for the state field. This data will appear automatically during data 

can be modified if required.  

Required: Required property specifies if data must be entered in a field or not. 

Hence if required is set yes the user will not be allowed to leave the field blank 

during data entry. By default, required property is set to NO for all fields.  



Input Mask: In put mask specifies the format in which the data must be entered. For 

example if pin code must be displayed having a space in the middle, enter input 

mask property as 000000.  

Validation Rule: Validation Rule property allows specifying is specified in the 

validation must be made for the data entered in the field. If anything is specified in 

the validation role property, only the data that satisfies the condition specified can be 

entered, all other data is rejected. For example, Total fees must be greater than zero 

and to specify this the validation rule property>0.  

Validation Text: When the data entered in the field does not conform to the 

validation rule that is specified, an error message is displayed on the screen that 

informs the user what is wrong. Validation Text is used to display custom error 

message instead of default error message. For example for Total fees, Total fees 

must be greater that 0"  

Description: is the text that will be displayed on the status bar ending the field. 

Description provides a kind of help to the user by displaying what kind of values must 

be entered in a particular field.  

 

FROM USING AUTO FORM:  
We have seen the table Datasheet view. This simple presentation of data in rows 

and columns is OK for some tasks. It however falls short when you need to view all 

the fields of a record of view a group of related records together for something like 

marks sheet. This is when you need to turn to a Form view.  

In MS- Access the simplest and easiest way to create a form is to use Auto Form 

feature. Using Auto Form you can automatically create columnar, tabular and 

datasheet forms based on a table or a query you select. There are three varieties of 

auto forms.  

o Columnar  

o Tabular  

o Datasheet  

 

Columnar Form:  
A columnar auto form shows 1 record at a time in the form view window. They are 

the easiest forms to create. The fields are arranged in columns.  



 
Creating a columnar Auto Form:  
In the Database window:  

1. Click on the Forms. tab.  

2. Click on New.  

3. Click on Auto Form: Columnar.  

4. Choose the table or query from which data must be used.  

Or  

In the Database window:  

1. Click on the tables tab or queries tab from which you want a form.  

2. Select the table or Query.  

3. Select Auto Form from New object drop-down button on Database Toolbar.  

 

Tabular Form:  
A tabular auto form can show several records in Form View window with the fields 

arranged in rows.  

Creating a Tabular Auto Form:  
In the Database window:  

1. Click on the Forms tab.  

2. Click on New.  

3. Click on the Auto Form: Tabular option.  

4. Select the table or query form which data must be must be used.  

 

Datasheet form:  
In a datasheet Auto Form records are shown the same way as they appear in the 

datasheet Window. In fact you can resize, move hide, and freeze columns as in the 

datasheet view. Now you might want to know the difference between datasheet view 

window and datasheet Auto Form. One difference is that in a datasheet Auto Form 

you can show details of data form more than one table at the same time. The other 

difference is in a datasheet Auto Form you can use graphics and command Buttons. 

 

Creating a Datasheet Auto Form:  
In the Database window:  

1. Click on the Forms tab.  



2. Click on New.   

3. Click on the Auto Form: Datasheet option 

4. Select the table or query from which data must be retrieved.  

Save the form:  
1. Click on the save button.  

2. Enter a name for your form.  

3. Click on OK.  

 

Creating an Auto Form with a Query:  
Now that we have the Query that we need, we can create an Auto Formwith it with a 

couple of clicks  

1. In the Database window, highlight the query we created in the last section.  

2. Select the Auto Form from the New Object button on the Database toolbar. 

The form will be displayed on the screen.  

3. To save the form, close the Form view window. Choose yes and enter a 

name.  

 

QUERIES:  
Queries are used to retrieve and display specific records in a table. They can also be 

used to display specific fields of specific record. Which meet the condition specified. 

A query displays a subset of allot specific fields and records in a table. when a 

change is made to the data. Which is displayed by the query, this change is reflected 

in the table also because of this dynamic relationship between the query and the 

tables, the subset of the data displayed by the query is called Dynast.  
 
Create a select query with one Table:  
Let us start with a simple example that creates a query to show selected fields and 

records from one table.  

1. In the database window click on the queries tab.  

2. Click on New to open new query dialog box.  

3. Double click on Design View or click on OK.  

4. Form the Tables list. Select the Student Master Table. Click on add to add the 

table to the table list and click on close.  



5. You will see a query window. Drag the fields from the field list to the columns in 

the bottom half of the window in whichever order that you would want to see them. 

You can run the query at this point to time to who the data for the fields you have 

dragged for all records in the student Master table.  

 

CREATING AND CUSTOMIZING REPORTS:  
Report is a component of the database that is used to organize and present the data 

in the tables. MS Access allows us to bases a report on a query as well as on a table 

will be retrieved whereas if a report is based on a query only selected rows can 

appear in the report.  

 

AUTO REPORTS:  
An auto report is the quickest way to create a report for a table or a query. It 

generates the report with the table name as the heading and page number as the 

footer. Columnar Auto report create a report where each row is presented vertically. 

o Tabular Auto report creates a report where data is presented in Table Form 

o Label Report creates a mailing list.  

o Chart Report creates a chart Report  

o Design view helps us to create a report based on user requirement.  

 

The report is divided into many sections:  

The Report header: in this section you place a control, which must appear only at 

the beginning of the report.  

The Page header: In this section you place a control which should appear at the 

must appear once for every record.  

The page footer: in this section you place a control, which must appear at the 

bottom of the report.  

 
Columnar Auto report:  
Columnar Auto report shows the records from a table or a query with fields arranged 

in columns.  

To create a columnar Auto report on Sales table:  

1. Click Report tab in the database window.  

2. Click New.  



3. Click on Auto Report> Columnar and choose the sales from the drop down list 

of tables Queries. Click on OK  

4. A preview of the report appears. 

5. Close the Report preview window and access prompts you give a name to the 

report if you want to save it.  

 

Tabular Auto Report:  
A tabular report shows records in regular tabular listing.  

1. Click Report tab in Database window  

2. Click New.  

3. Select table or query for report.  

4. Double click Auto reports > tabular.  

4. Close the report window and give a name to the report.  

Tabular Auto Reports will however have a disadvantage when the tables has 

many fields. This is because MS-Access will try to squeeze and fit all the fields of the 

records onto a page and hence create a mess. So in such cases it is always better to 

design a query with only the relevant fields in view and then create a tabular report 

on this query.  

 

REPORT DESIGN VIEW:  
As with forms the Design view is a place where forms of reports can be designed 

from start. It is however time consuming to design forms the beginning and hence 

what you can do is quickly create a report in a Report wizard and then open it in 

Design view and make changes.  

To open a report in Design view:  
Form the database window select the reports tab and select the report you would like 

to redesign.  

Click on design or click on a preview window and then click on Design view 

button on the toolbar.  

As in the form Design window, in the report design window also you can, 

1. Use tools such as formatting toolbar, toolbox. Field list and the property 

sheets.  

2. Do basic maneuvers like move, resize, and align objects.  

3. Add objects such as fields, text, and graphics to a design.  



4. Use the sub forms/ sub report wizard.  

5. Change the record source for design.  

6. Create a report template.  

 

8.3 SUMMARY:  
o Microsoft Access is a relational database management system from Microsoft, 

which combines the Relational Microsoft Jet Database Engine with a graphical 

user interface. The latest version of MS Access is known as Microsoft Office 

Access. It is a member of the 2007 Microsoft Office system. 

o Access is used by small businesses, within departments of large corporations, 

and hobby programmers to create ad hoc customized desktop systems for 

handling the creation and manipulation of data. Access can be used as a 

database for basic web based applications hosted on Microsoft's Internet 

Information Services. Some professional application developers use Access for 

rapid application development. 

o When multiple concurrent users share a Microsoft Access database, processing 

speed suffers. The effect is dramatic when there are more than a few users or if 

the processing demands of any of the users are high. Access includes an 

Upsizing Wizard that allows users to upsize their database to Microsoft SQL 

Server if they want to move to a true client-server database. It is recommended to 

use Access Data Projects for most situations.  

o A database is a collection of data related to a particular subject or purpose, such 

as tracking customer order or maintaining a music collection. Using MS-Access, 

you can manage all your data from a single database.  

o MS-Access is a RDBMS or a Relational Database Management System. Now 

what do we mean by a Relational Database? In a relational database the tables 

are related to common fields known as key fields. This help in accessing data 

from more than one table. 

 

8.4 KEY WORDS:  
Microsoft Access: Microsoft Access is a relational database management system 

from Microsoft, which combines the Relational Microsoft Jet Database Engine with a 

graphical user interface. The latest version of MS Access is known as Microsoft 

Office Access. It is a member of the 2007 Microsoft Office system. 



Uses of Microsoft Access: Access is used by small businesses, within 

departments of large corporations, and hobby programmers to create ad hoc 

customized desktop systems for handling the creation and manipulation of data. 

Access can be used as a database for basic web based applications hosted on 

Microsoft's Internet Information Services. Some professional application developers 

use Access for rapid application development. 

Shortcoming in MS Access: When multiple concurrent users share a Microsoft 

Access database, processing speed suffers. The effect is dramatic when there are 

more than a few users or if the processing demands of any of the users are high. 

Access includes an Upsizing Wizard that allows users to upsize their database to 

Microsoft SQL Server if they want to move to a true client-server database. It is 

recommended to use Access Data Projects for most situations.  

MS-Access as a Relational Database Management System: MS-Access is a 

RDBMS or a Relational Database Management System. Now what do we mean by a 

Relational Database? In a relational database the tables are related to common 

fields known as key fields. This help in accessing data from more than one table. 

  

8.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
20. Write a detailed note on the MS Access programme.  

21. Discuss in brief the facilities in RDBMS.  

22. Discuss the major facilities available in the MS Excel Spreadsheet programme. 

23. Write a detailed note on the functioning of the MS Excel Spreadsheet 

programme.  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various aspects of working with text. First, 

we shall try to get an introduction to working with text. We shall also discuss about 

characteristics of word processors, uses of word processors, growth and 

development of word processors.  

The lesson structure shall be as follows:  

9.0 Objectives  

9.1 Introduction  

9.2 Presentation of Content  

9.2.1 Working With Text- An Introduction  

9.2.2 Introduction to Word Processors  

9.2.3 Characteristics of Word Processors  

9.2.4 Uses of Word Processors  

9.2.5 Growth and Development of Word Processors  

9.3 Summary 

9.4 Key Words  

9.5 Self-Assessment Questions (SAQs) 

9.6 References/Suggested Reading 

 

9.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Get an Introduction to Working With Text  

o To Get an Introduction to Word Processors  

o To Understand the Characteristics of Word Processors  



o Uses of Word Processors  

o Growth and Development of Word Processors  

 

9.1 INTRODUCTION: 
Page Composition, the method of assembling a document by combining text, 

graphics, and images using a computer and specialized software. The original text 

and graphics are generally produced with software such as word processing and 

illustration programme, and images are captured using digital photography or by 

scanning photographic media (prints, negatives, or transparencies). Each element is 

then transferred into a page-makeup programme, which enables the user to lay out 

text and graphics on the screen. These programmes often include some illustration 

and image-editing features, although their main strength is in their typographic and 

layout capabilities.  

The finished document may be intended for printing or for electronic 

distribution. Printing may be carried out on a local device, such as a laser or ink-jet 

printer, or the document may be output on a printing plate so that multiple copies can 

be printed by one of the printing processes.  

 In this lesson we shall discus about the various aspects of working with text.  

 
9.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Working With Text- An Introduction  

o Word Processors- An Introduction  

o Characteristics of Word Processors  

o Uses of Word Processors  

o Growth and Development of Word Processors  

 
9.2.1 WORKING WITH TEXT - AN INTRODUCTION:  
Today, many people are not writing anymore. Most professionals type in material 

straight on to a computer. In fact, in the newspaper business, reporters feed their 

news stories directly in to their laptop computers while in the field. They send the 

stories via e-mail or other IT-mediated means to their offices.  

News editors in the office go through the stories, select an assign stories 

online through a networked system. Sub editors edit the stories, feed in the 



headlines, sub headlines, and other such text matter as required on to their 

computers. These stories then reach the page make-up personnel, who add photos 

and other graphic material, prepare layout for the stories and the entire pages. Many 

newspapers work almost in a paperless environment.  

 All these have been possible because of many advancements in the IT-

enabled facilities, specifically in the text-related software packages.  

 It is now possible for one or a few persons to compose, design and even print 

many types of material in small scale with the help a computer and a printer. Desk 

top publishing and electronic publishing have revolutionized the publishing world.  

 It is said that a picture is worth a thousand words. This saying, while true in 

many cases, does not diminish the importance of words. This is because in most 

cases, words tell the complete story and the pictures generally supplement the story 

told verbally. And words, when used well, open doors to a world of information and 

knowledge. Words are the most common and widely used means of expression. 

Words are doorways to the world of creativity. And words often take us in to a world 

of fantasy.  

 Computers, particularly text-related software packages, play an important role 

as these not only help us compose text, these also help us present the text in more 

attractive and appealing manner.   

 The different types or forms of text material available are as follows:  

o Written Text,  

o Printed Text,  

o Electronic Text Machine Readable),  

� Scanned Text,  

� Hyper Text,  

There are many software packages available for working with text. These include:  

o WORD PROCESSING PROGRAMMES  

Word  

Word Perfect  

Notepad  

WordPad  

TextEdit  

o DESKTOP PUBLISHING PROGRAMMES  

Microsoft Publisher  



Pagemaker Programmes (PM 5.0, PM 6.5, and PM 7.0)  

Adobe FrameMaker  

Quark Express  

Corel Ventura  

o PRESENTATION AND AUTHORING PROGRAMMES  

PowerPoint  

Presentation Manger  

o GRAPHICS EDITING PROGRAMMES  

o WEB DESIGN PROGRAMMES  

Microsoft FrontPage  

Macromedia Dreamweaver  

 

Here in this lesson, we shall focus on the text-related applications available in the 

various word processing programmes. 

 

9.2.2  WORD PROCESSORS- AN INTRODUCTION:  
A word processor (more formally known as document preparation system) is a 

computer application used for the production including: composition, editing, 

formatting, and possibly printing) of any sort of printable material. 

Word processors also refer to a stand-alone computer unit similar to a typewriter, 

but often including technological advancements such as a screen, advanced 

formatting and printing options, and the ability to save documents onto memory 

cards or diskettes. Word processors almost invariably allowed the user to choose 

between standard typing and word processing modes by way of a switch. Such word 

processors should not be confused with an electric typewriter. 

Word processors are descended from early text formatting tools (sometimes 

called text justification tools, from their only real capability). Word processing was 

one of the earliest applications for the personal computer in office productivity. 

Although early word processors used tag-based markup for document 

formatting, most modern word processors take advantage of a graphical user 

interface. Most are powerful systems consisting of one or more programmes that can 

produce any arbitrary combination of images, graphics and text, the latter handled 

with type-setting capability. 



Microsoft Word is the most widely used computer word processing system; 

Microsoft estimates over five hundred million people use the Office suite. There are 

also many other commercial word processing applications, such as WordPerfect. 

Open-source applications such as OpenOffice's Writer and KWord are rapidly 

gaining in popularity. 

 

9.2.3  CHARACTERISTICS OF WORD PROCESSORS: 
Word processing typically refers to text manipulation functions such as automatic 

generation of: 

o Batch mailings using a form letter template and an address database (also 

called mail merging);  

o Indices of keywords and their page numbers;  

o Tables of contents with section titles and their page numbers;  

o Tables of figures with caption titles and their page numbers;  

o Cross-referencing with section or page numbers;  

o Footnote numbering;  

o New versions of a document using variables (e.g. model numbers, product 

names, etc.)  

 

Other word processing functions include "spell checking" (actually checks against 

wordlists), "grammar checking" (checks for what seem to be simple grammar errors), 

and a "thesaurus" function (finds words with similar or opposite meanings). In most 

languages grammar is very complex, so grammar checkers tend to be unreliable and 

also require a large amount of RAM. Other common features include collaborative 

editing, comments and annotations, support for images and diagrams and internal 

cross-referencing. 

Word processors can be distinguished from several other, related forms of 

software: Text editors (modern examples of which include Notepad, Emacs and vi), 

were the precursors of word processors. While offering facilities for composing and 

editing text, they do not format documents. This can be done by batch document 

processing systems, starting with TJ-2 and RUNOFF and still available in such 

systems as LaTeX (as well as programmes that implement the paged-media 

extensions to HTML and CSS). Text editors are now used mainly by programmers, 



website designers, and computer system administrators. They are also useful when 

fast startup times, small file sizes and portability are preferred over formatting. 

Later desktop publishing programmes were specifically designed to allow 

elaborate layout for publication, but often offered only limited support for editing. 

Typically, desktop publishing programmes allowed users to import text that they 

have written using a text editor or word processor. 

Almost all word processors enable users to employ styles, which are used to 

automate consistent formatting of text body, titles, subtitles, highlighed text, and so 

on. 

Styles are the key to managing the formatting of large documents, since 

changing a style automatically changes all text that the style has been applied to. 

Even in shorter documents styles can save a lot of time while formatting. However, 

most help files refer to styles as an 'advanced feature' of the word processor, which 

often discourages users from using styles regularly. 

 

9.2.4  USES OF WORD PROCESSORS: 
Word processors have a variety of uses and applications within the business world, 

home, and education. 

 

BUSINESS: Within the business world, word processors are extremely useful tools. 

Typical uses include: 

o Memos  

o Letters and letterhead  

o Legal copies  

o Reference documents  

 

Businesses tend to have their own format and style for any of these. Thus, versatile 

word processors with layout editing and similar capabilities find widespread use in 

most businesses. 

 

EDUCATION: Many schools have begun to teach typing and word processing to their 

students, starting as early as elementary school. Typically these skills are developed 

throughout secondary school in preparation for the business world. Undergraduate 

students typically spend many hours writing essays. Graduate and doctoral students 



continue this trend, as well as creating works for research and publication. These 

manuscripts are often in excess of 200 pages, and are typically the defining point of 

a student's career. 

 

HOME: While many homes have word processors on their computers, word 

processing in the home tends to be educational or business related, dealing with 

assignments or work being completed at home. Some use word processors for letter 

writing, résumé creation, and card creation. However, many of these home 

publishing processes have been taken over by desktop publishing programmes such 

as Adobe Pagemaker, which is better suited for these types of documents. 

 

9.2.5  DEVELOPMENT OF WORD PROCESSORS: 
The term word processing was invented by IBM in the late 1960s. By 1971 it was 

recognized by the New York Times as a "buzz word." A 1971 Times article referred 

to "the brave new world of Word Processing or W/P. IBM. introduced W/P about five 

years ago for its Magnetic Selectric typewriter and other electronic razzle-dazzle."  

IBM defined the term in a broad and vague way as "the combination of 

people, procedures, and equipment which transforms ideas into printed 

communications," and originally used it to include dictating machines and ordinary, 

manually-operated Selectric typewriters. By the early seventies, however, the term 

was generally understood to mean semi-automated typewriters affording at least 

some form of electronic editing and correction, and the ability to produce perfect 

"originals." Thus, the Times headlined a 1974 Xerox product as a "speedier 

electronic typewriter," but went on to describe the product, which had no screen, as 

"a word processor rather than strictly a typewriter, in that it stores copy on magnetic 

tape or magnetic cards for retyping, corrections, and subsequent printout." 

Electromechanical paper-tape-based equipment such as the Friden 

Flexowriter had long been available; the Flexowriter allowed for operations such as 

repetitive typing of form letters (with a pause for the operator to manually type in the 

variable information), and when equipped with an auxiliary reader, could perform an 

early version of "mail merge". Circa 1970 it began to be feasible to apply electronic 

computers to office automation tasks. IBM's Mag Tape Selectric Typewriter (MTST) 

and later Mag-Card Selectric (MCST) were early devices of this kind, which allowed 



editing, simple revision, and repetitive typing, with a one-line display for editing single 

lines.  

The 1970s word processing concept did not refer merely to equipment, but, 

explicitly, to the use of equipment for "breaking down secretarial labor into distinct 

components, with some staff members handling typing exclusively while others 

supply administrative support. A typical operation would leave most executives 

without private secretaries. Instead one secretary would perform various 

administrative tasks for three or more secretaries."  

In the early 1970's, computer scientist Harold Koplow was hired by Wang 

Laboratories to programme calculators. One of his programmes permitted a Wang 

calculator to interface with an IBM Selectric typewriter, which was at the time used to 

calculate and print the paperwork for auto sales. 

In 1974, Koplow's interface programme was developed into the Wang 1200 

Word Processor, an IBM Selectric-based text-storage device. The operator of this 

machine typed text on a conventional IBM Selectric; when the Return key was 

pressed, the line of text was stored on a cassette tape. One cassette held roughly 20 

pages of text, and could be "played back" (e.g., the text retrieved) by printing the 

contents on continuous-form paper in the 1200 typewriter's "print" mode. The stored 

text could also be edited, using keys on a simple, six-key array. Basic editing 

functions included Insert, Delete, Skip (character, line), and so on. 

The labor and cost savings of this device were immediate, and remarkable: 

pages of text no longer had to be retyped to correct simple errors, and projects could 

be worked on, stored, and then retrieved for use later on. The rudimentary Wang 

1200 machine was the precursor of the Wang Office Information System (OIS), 

introduced in 1976, whose CRT-based system was a major breakthrough in word 

processing technology. It displayed text on a CRT screen, and incorporated virtually 

every fundamental characteristic of word processors as we know them today. It was 

a true office machine, affordable by organizations such as medium-sized law firms, 

and easily learned and operated by secretarial staff. 

The Wang was not the first CRT-based machine nor were all of its innovations 

unique to Wang. In the early 1970s Linolex, Lexitron and Vydec introduced 

pioneering word-processing systems with CRT display editing. A Canadian 

electronics company, Automatic Electronic Systems, introduced a product with 

similarities to Wang's product in 1974, but went into bankruptcy a year later. In 1976, 



refinanced by the Canada Development Corporation, it returned to operation as AES 

Data, and went on to successfully market its brand of word processors worldwide 

until its demise in the mid-1980s. Despite these predecessors, Wang's product was a 

standout, and by 1978 it had sold more of these systems than any other vendor. 

The phrase "word processor" rapidly came to refer to CRT-based machines 

similar to Wang's. Numerous machines of this kind emerged, typically marketed by 

traditional office-equipment companies such as IBM, Lanier (marketing AES Data 

machines, re-badged), CPT, and NBI. All were specialized, dedicated, proprietary 

systems, with prices in the $10,000 ballpark. Cheap general-purpose computers 

were still the domain of hobbyists. 

Some of the earliest CRT-based machines used cassette tapes for 

removable-memory storage until floppy diskettes became available for this purpose - 

first the 8-inch floppy, then the 5-1/4-inch (drives by Shugart Associates and 

diskettes by Dysan). Printing of documents was initially accomplished using IBM 

Selectric typewriters modified for ASCII-character input. These were later replaced 

by application-specific daisy wheel printers (Diablo, which became a Xerox 

company, and Qume -- both now defunct.) For quick "draft" printing, dot-matrix line 

printers were optional alternatives with some word processors. 

With the rise of personal computers, and in particular the IBM PC and PC 

compatibles, software-based word processors running on general-purpose 

commodity hardware gradually displaced dedicated word processors, and the term 

came to refer to software rather than hardware. Some programmes were modeled 

after particular dedicated WP hardware. MultiMate, for example, was written for an 

insurance company that had hundreds of typists using Wang systems, and spread 

from there to other Wang customers. To adapt to the smaller PC keyboard, 

MultiMate used stick-on labels and a large plastic clip-on template to remind users of 

its dozens of Wang-like functions, using the shift, alt and ctrl keys with the 10 IBM 

function keys and many of the alphabet keys. 

Other early word-processing software required users to memorize semi-

mnemonic key combinations rather than pressing keys labelled "copy" or "bold." (In 

fact, many early PCs lacked cursor keys; WordStar famously used the E-S-D-X-

centered "diamond" for cursor navigation, and modern vi-like editors encourage use 

of hjkl for navigation.) However, the price differences between dedicated word 

processors and general-purpose PCs, and the value added to the latter by software 



such as VisiCalc, were so compelling that personal computers and word processing 

software soon became serious competition for the dedicated machines. Word 

Perfect, XyWrite, Microsoft Word and dozens of other word processing software 

brands competed in the 1980s. Development of higher-resolution monitors allowed 

them to provide limited WYSIWYG - What You See Is What You Get, to the extent 

that typographical features like bold and italics, indentation, justification and margins 

were approximated on screen. 

The mid-to-late 1980s saw the spread of laser printers, a "typographic" 

approach to word processing, and of true WYSIWYG bitmap displays with multiple 

fonts (pioneered by the Xerox Alto computer and Bravo word processing 

programme), Postscript, and graphical user interfaces (another Xerox PARC 

innovation, with the Gypsy word processor). 

MacWrite, Microsoft Word and other word processing programmes for the bit-

mapped Apple Macintosh screen, introduced in 1984, were probably the first true 

WYSIWYG word processors to become known to many people until the introduction 

of Microsoft Windows. Dedicated word processors eventually became museum 

pieces. 

 

9.3 SUMMARY:  
o Computers, particularly text-related software packages, play an important role 

as these not only help us compose text, these also help us present the text in 

more attractive and appealing manner.   

o It is now possible for one or a few persons to compose, design and even print 

many types of material in small scale with the help a computer and a printer. 

Desk top publishing and electronic publishing have revolutionized the 

publishing world.  

o A word processor (more formally known as document preparation system) is a 

computer application used for the production including: composition, editing, 

formatting, and possibly printing) of any sort of printable material. 

o Word processors also refer to a stand-alone computer unit similar to a 

typewriter, but often including technological advancements such as a screen, 

advanced formatting and printing options, and the ability to save documents 

onto memory cards or diskettes. Word processors almost invariably allowed 

the user to choose between standard typing and word processing modes by 



way of a switch. Such word processors should not be confused with an 

electric typewriter. 

o Microsoft Word is the most widely used computer word processing system; 

Microsoft estimates over five hundred million people use the Office suite. 

There are also many other commercial word processing applications, such as 

WordPerfect. Open-source applications such as OpenOffice's Writer and 

KWord are rapidly gaining in popularity.  

o Word processing typically refers to text manipulation functions such as 

automatic generation of: batch mailings using a form letter template and an 

address database (also called mail merging); indices of keywords and their 

page numbers; tables of contents with section titles and their page numbers; 

tables of figures with caption titles and their page numbers; cross-referencing 

with section or page numbers; and footnote numbering; etc.  

o Other word processing functions include "spell checking" (actually checks 

against wordlists), "grammar checking" (checks for what seem to be simple 

grammar errors), and a "thesaurus" function (finds words with similar or 

opposite meanings). Other common features include collaborative editing, 

comments and annotations, support for images and diagrams and internal 

cross-referencing. 

o MacWrite, Microsoft Word and other word processing programmes for the bit-

mapped Apple Macintosh screen, introduced in 1984, were probably the first 

true WYSIWYG word processors to become known to many people until the 

introduction of Microsoft Windows.  

 

9.4 KEY WORDS:  
Text-related Software Packages: Computers, particularly text-related software 

packages, play an important role as these not only help us compose text, these also 

help us present the text in more attractive and appealing manner.   

Word Processor: A word processor (more formally known as document preparation 

system) is a computer application used for the production including: composition, 

editing, formatting, and possibly printing) of any sort of printable material. 

Functions of Word Processing: Word processing typically refers to text 

manipulation functions such as automatic generation of: batch mailings using a form 

letter template and an address database (also called mail merging); indices of 



keywords and their page numbers; tables of contents with section titles and their 

page numbers; tables of figures with caption titles and their page numbers; cross-

referencing with section or page numbers; and footnote numbering; etc.  

 

 

9.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
24. Write a detailed note on word processing.  

25. Discuss in brief the facilities in word processing packages.  

26. Write a detailed note on the functioning of word processing programmes.  

 

9.6 REFERENCES / SUGGESTED READING: 
o Absolute Beginner’s Guide to Computer Basics; Michael Miller; 2007 

o Computers; Anne Rooney; 2005  

o Mastering Microsoft Word; Matthew Holtz; 1987  

o Mastering CorelDRAW; S. Rimmer; 1997  

o How the Web was Born: The Story of the World Wide Web; Robert Cailliau 

& James Gillies; 1997 

o The Internet: The Basics; Jason Whittakar; 2002  

o How the Internet Works; Preston Gralla; 1998  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various introductory aspects of the Page 

Maker software programme. We shall focus entirely on the functioning of the Page 

Maker 5.0 version. The lesson structure shall be as follows:  

10.0 Objectives  

10.1 Introduction  

10.2 Presentation of Content  

10.2.1 Page Maker 5.0- An Introduction  

10.2.2 Functioning of Page Maker 5.0   

10.3 Summary 

10.4 Key Words  

10.5 Self-Assessment Questions (SAQs) 

10.6 References/Suggested Reading 

 

10.0 OBJECTIVES:  
The purpose of this lesson is to help you get familiarized with the Page Maker 

software programme. Aldus Page Maker is a desktop publishing software package. It 

is primarily for users who have some familiarity with traditional publishing, although 

newcomers to the subject will find the programme easy to use. However, an 

understanding of the publishing terms that can be found in the glossary will facilitate 

learning. The objectives of this lesson are: 

o To Get an Introduction to Page Maker 5.0  

o To Know About the Functioning of Page Maker 5.0   

 



10.1 INTRODUCTION: 
Adobe Systems, the corporation that helped launch the desktop publishing revolution 

that started in the early 1980s. Adobe is now one of the world's largest PC software 

companies, with annual revenues exceeding US $1 billion. The company employs 

approximately 3,400 people worldwide and has its headquarters in San Jose, 

California. Adobe has been publicly traded on the Nasdaq National Market since 

1986. 

Adobe Systems has been a key player in electronic publishing for many years 

and is probably best known as the source of the Page Maker 5.0; Page Maker 6.5; 

Page Maker 7.0; the Portable Document Format (PDF, widely used to produce and 

interpret Web-based material); and the Adobe-Premier-Pro (a digital video-editing 

software programme). 

The vision put forward by Adobe Systems is that you should be able to 

publish anything, anywhere, on any device. In practice, this means the reliable 

delivery of visually rich and personalized content wherever the user wants it, whether 

the target is a printer, a Web page, a mobile phone display, a handheld device, a 

computer, or an Internet appliance. Adobe Systems offers a comprehensive line of 

software for enterprise and creative professional customers. Its products enable 

customers to create, manage, and deliver visually rich and reliable content.  

In this lesson focus on the components and the functioning of the Page Maker 

5.0 version. 

 

10.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o Page Maker 5.0- An Introduction  

o Functioning of Page Maker 5.0   
 
10.2.1 PAGE MAKER 5.0- AN INTRODUCTION:  
The Page Maker 5.0 allows you to electronically coordinate all the typographical 

ingredients of a publication, editing and rearranging them at will, and finally printing 

what was seen on the screen to produce camera-ready work. The traditional practice 

by a publisher of producing a dummy (MOCK UP) of the proposed publication should 

still the followed, with the same decisions being made about page size, number of 



columns, size of alleys, heading fonts, subheading fonts, body text font, position of 

illustrations, whether to box or not, etc.  

 

10.2.2 FUNCTIONING OF PAGE MAKER 5.0: 
Here are some major functions of Pager Maker 5.0:  

 
PREPARING TEXT:  
Text is the crux of a publication. Prepare lengthy text in your word processor; enter 

shorter passages directly into the Page Maker text editor. Spell check all text and 

edit it for grammar and clarity before using it in a publication. There are four ways to 

bring text into your word processor: key it in, scan it in through an OCR (optical 

character reading) program, import it from other application programs, or bring it in 

via modem. You import word processing application program styles into Page Maker 

by beginning a paragraph with the name of the appropriate Page Maker style tag in 

angle brackets. The following is an example of how you enter text in your word 

processor so that you can import three styles.  

 

<Heading> IMPORTING STYLES 

<Subhead> Using Tags 

<Body text>  

 

Page Maker applies the styles specified by the first tag and then to every 

subsequent paragraph until it finds a new tag. If a style name tag does not match an 

existing Page Maker style, Page Maker creates a new style based on the formatting 

of the imported text.  

 

Page Maker utilizes fonts to suit the selected printer, which should, therefore, be the 

final printer you intend to use — even if it is an images setter at a service bureau.  

 

SETTING UP PAGES:   
1. With the Page setup dialog box open, study the choices for a few moments 

without taking any action. Clicking on them may highlight choices, or the 

default highlight may be moved from item to item by use of the Tab key.  



2. Again choose File/new and observe that because you chose Cancel, resulting 

in the selections you just made not being implemented, they have been 

replaced with the default setting.  

3. Click on the X in the Double-side check box to uncheck it and to set up a 

single side page for this first project.  

4. Place the insertion point in the left margin text box and change the 

measurement to .75 inches.  

 

TEMPLATES:  
In Page Maker a publication can be started with a template or a grid. A Page Maker 

template consists of graphic placeholders and text placeholders, invariably 

containing shaded graphics and text, which you replace with your own graphics and 

text using the Replace feature in the Place document dialog box. Grids are shapes 

created by nonprinting margin guides, ruler guides, and column guides, which you 

use to position and align text and graphics in your publications. You can create your 

own grids, but Page Maker provides a selection of predestined templates, which are 

shown.  

You can modify a template if it is not exactly what you require, but if you do, or 

if you create a new template for a publication, give it a unique name and save it as a 

template for future use. Elements that are planned to appear on each page of a 

publication prepared from a template must be edited in the master pages, and you 

will learn about master pages in the Page Design section.  

 

FILE OPERATIONS:  
On your companion diskette, which should still be in a floppy drive, there is a 

publication similar to the one you created but did not save. You use this publication 

for the activities in this publication for the activities in this section.  

 

SAVING PUBLICATIONS:  
In PageMaker you save a new publication or give an old publication a new title by 

using the Save as... command in the File menu. Existing publications that are being 

edited are saved with the Save command. New publications should be given a title 

and saved immediately following page setup and then should be saved regularly 

during creation or subsequent editing.  



1. Choose File/Save as ... to open the Save publication.  

2. Click on the OK button. Page Maker automatically adds the extension .PM5 to 

filenames. Observe the name given to the publication is now in the title bar of 

the Layout view.   

3. Again enter the File menu and note that “Save” is in gray because there is no 

longer any new work to save.  

4. Select the Text tool and highlight the heading, ANOTHER KIND OF 

RADIATION, by clicking on the text three times, or by dragging the Text icon 

across the text.  

 

PAGE MAKER SETTINGS:  
When you first access Page Maker, the manufacturer’s default load and, unless you 

change them, they will continue to load each time you start up the program. If you 

alter defaults in the menus while you have a publication open, they will apply only to 

the text and graphics highlighted or enable at the time the selections are made. 

However, if you make selections when you have a blank Page Maker screen, i.e., 

before you have selected either New... or Open.... from the File menu, they will apply 

to all new publications subsequently opened, but they will not apply to existing 

publications that you subsequently open. You learn how to change defaults from the 

steps that follow.  

1. Close any publications you have open, either from the publication’s Control 

menu or by double clicking the publication’s Control box. Answer No to the 

Save before closing question, then choose File/New... to open the Page setup 

dialog box on a clear screen.  

2. When the Page setup dialog box appears, click Cancel.  

3. Choose Element/Line/Hairline Any new publication you now open will have 

Hairline as the default Line selection.  

 

Page Setup:  
1. Double Click the Control menu box of the untitled publication to close it, 

answer No to the Save before closing question, then choose File/ New.... to 

display the Page setup dialog box.  

2. Click on the arrow to the right of the page drop down list box to display the 

choices.  



 

MASTER PAGES:  
If you look at the lower left or your screen you should see two master page icons 

marked L and R for left and right. You select a master page by clicking on one of the 

icons, or by using the Go to page dialog box. If you had disabled the Double sided 

option in the Page setup dialog box, only one master page icon would be displayed 

and it would be a right hand page so that the one inch margin would be on the left, 

the binding side.  

 

Margins: 
When you define margins in Page setup, they repeat on all pages, and any 

subsequent changes you make affect the whole publication.  

Columns: 
Columns do not automatically repeat on the every page, except for facing pages, 

unless set up on a master page. You may set up to 20 columns, either for an 

individual page, or on a master page.  

1. Choose Layout/column guides…. And when the dialog box opens leave the 

Set left and right pages separately unchecked, then type 2 directly into the 

Number of columns box. Click OK.  

2. Observe that with a two-page spread both pages have been affected, then 

click the page 1 icon and observe that it has not been affected.  

3. Click in the alley between any two columns on the left hand page and drag the 

alley 0.5 inch to the right. You now have uneven columns.  

 
 
 
10.3 SUMMARY:  

o Adobe Systems has been a key player in electronic publishing for many years 

and is probably best known as the source of the Page Maker 5.0; Page Maker 

6.5; Page Maker 7.0; the Portable Document Format (PDF, widely used to 

produce and interpret Web-based material); and the Adobe-Premier-Pro (a 

digital video-editing software programme). 

o The Page Maker 5.0 allows you to electronically coordinate all the 

typographical ingredients of a publication, editing and rearranging them at will, 

and finally printing what was seen on the screen to produce camera-ready 



work. The traditional practice by a publisher of producing a dummy (MOCK UP) 

of the proposed publication should still the followed, with the same decisions 

being made about page size, number of columns, size of alleys, heading 

fonts, subheading fonts, body text font, position of illustrations, whether to box 

or not, etc.  

o Text is the crux of a publication. Prepare lengthy text in your word processor; 

enter shorter passages directly into the Page Maker text editor. Spell check all 

text and edit it for grammar and clarity before using it in a publication. There 

are four ways to bring text into your word processor: key it in, scan it in 

through an OCR (optical character reading) program, import it from other 

application programs, or bring it in via modem. You import word processing 

application program styles into Page Maker by beginning a paragraph with the 

name of the appropriate Page Maker style tag in angle brackets. 

 

10.4 KEY WORDS:  
Page Maker 5.0: The Page Maker 5.0 allows you to electronically coordinate all the 

typographical ingredients of a publication, editing and rearranging them at will, and 

finally printing what was seen on the screen to produce camera-ready work. The 

traditional practice by a publisher of producing a dummy (MOCK UP) of the proposed 

publication should still the followed, with the same decisions being made about page 

size, number of columns, size of alleys, heading fonts, subheading fonts, body text 

font, position of illustrations, whether to box or not, etc.  

Preparing Text: Text is the crux of a publication. Prepare lengthy text in your word 

processor; enter shorter passages directly into the Page Maker text editor. Spell 

check all text and edit it for grammar and clarity before using it in a publication. 

There are four ways to bring text into your word processor: key it in, scan it in 

through an OCR (optical character reading) program, import it from other application 

programs, or bring it in via modem. You import word processing application program 

styles into Page Maker by beginning a paragraph with the name of the appropriate 

Page Maker style tag in angle brackets. 

 

10.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
27. Write a detailed note on the Page Maker 5.0 version.  

28. Discuss the functioning of the Page Maker 5.0 version. 



 

10.6 REFERENCES / SUGGESTED READING: 
o Absolute Beginner’s Guide to Computer Basics; Michael Miller; 2007 

o Computers; Anne Rooney; 2005  

o Mastering Microsoft Word; Matthew Holtz; 1987  

o Mastering CorelDRAW; S. Rimmer; 1997  

o How the Web was Born: The Story of the World Wide Web; Robert Cailliau 

& James Gillies; 1997 

o The Internet: The Basics; Jason Whittakar; 2002  

o How the Internet Works; Preston Gralla; 1998  
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LESSON STRUCTURE:  
In this lesson we shall discus about some introductory aspects of Corel Draw. First, we 
shall focus on the CorelDRAW Graphic Suite. We shall also briefly discuss the growth of 
CorelDRAW. Finally, we shall focus on the features of CorelDRAW. The lesson structure 
shall be as follows:  

11.0 Objectives  

11.1 Introduction  

11.2 Presentation of Content  

11.2.1 CorelDRAW- An Introduction 

11.2.2 CorelDRAW Graphic Suite  
11.2.3 Growth of CorelDRAW 

11.2.4 Features of CorelDRAW 

11.3 Summary 

11.4 Key Words  

11.5 Self-Assessment Questions (SAQs) 

11.6 References/Suggested Reading 

 
11.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Get an Introduction to CorelDRAW  
o To Understand the CorelDRAW Graphic Suite  
o To Understand the Growth of CorelDRAW 

o To Know About the Features of CorelDRAW 

 

11.1 INTRODUCTION: 



 CorelDRAW is a vector graphics editor developed and marketed by Corel 

Corporation of Ottawa, Canada. It is also the name of Corel's Graphics Suite.  

CorelDRAW was originally developed for Microsoft Windows and currently 

runs only on Windows 2000 and newer versions. The current version- CorelDRAW 

X3 is compatible with Windows Vista.  

In this lesson we shall discus about some aspects of Corel Draw. 

 

11.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o CorelDRAW- An Introduction  

o CorelDRAW Graphic Suite  
o Growth of CorelDRAW  
o Features of CorelDRAW  

 
11.2.1 CORELDRAW- AN INTRODUCTION:  
Several innovations to vector-based illustration originated with CorelDRAW: a node-

edit tool that operates differently on different objects. These include: fit text-to-path, 

stroke-before-fill, quick fill/stroke color selection palettes, perspective projections, 

mesh fills and complex gradient fills.   

CorelDRAW is different from its competitors in a number of ways. It is a 

graphics suite, rather than just a vector graphics programme. Also CorelDRAW 

includes a large collection of fonts and clip art. The biggest improvement with 

CorelDRAW over other graphic software programmes is its ability to edit bitmaps. A 

full range of editing tools allow the user to adjust contrast, color balance, change the 

format from RGB to CMYK, add special effects such as Vignettes and special 

borders to bitmaps. Bitmaps can also be edited more extensively using Corel 

PhotoPaint, opening the bitmap directly from CorelDRAW and returning to the 

program after saving. 

CorelDRAW's chief competitor is Adobe Illustrator. Although they are both 

vector-based illustration programs, the user experience differs greatly between the 

two. For instance, CorelDRAW can work with multi-page documents directly; 

Illustrator only offers a single-page layout view, but it will allow you to divide that 

large layout in the print options so that it prints on multiple pages. While Illustrator 

will read CorelDRAW's native file type and vice versa, the translation is almost never 



perfect. CorelDRAW can open Adobe PDF files, Adobe PageMaker and InDesign, 

Microsoft Publisher and Word, and several other programmes can print documents 

to PDF using the Adobe PDFWriter printer driver, which CorelDRAW can then open 

and edit every aspect of the original layout and design. CorelDRAW can also open 

PowerPoint Presentations with little or no problem.  

 

11.2.2 CORELDRAW GRAPHIC SUITE: 
Over time, additional components were developed or acquired and bundled with 

CorelDRAW. The list of bundled packages usually changes somewhat from one 

release to the next. There are several mainstays that have remained in the package 

for many releases now, however: PowerTRACE (a bitmap to vector graphic 

converter), PHOTO-PAINT (a bitmap graphic editor), and CAPTURE (a screen 

capture utility). 

The current version of CorelDRAW Graphics Suite contains the following 

packages: 

o CorelDRAW: Vector graphics editing software  

o Corel PHOTO-PAINT: Raster image creation and editing software  

o Corel CAPTURE: Enables several methods of image-capture  

o Corel PowerTRACE: Converts raster images to vector graphics.  

o Pixmantec RawShooter Essentials: Support for RAW file format  

 

11.2.3 GROWTH OF CORELDRAW: 
Here is a brief note on how CorelDRAW has grown over the years through its 

various versions:  

o Version 2 of CoerlDRAW (1991) had an envelope tool (for distorting text or 

objects using a primary shape), Blend (for morphing shapes), Extrusion (for 

simulating perspective and volume in objects) and Perspective (to distort 

objects along X and Y axes).  

o Version 3 of CoerlDRAW (1992) included Corel PHOTO-PAINT* (for bitmap 

editing), CorelSHOW (for creating on-screen presentations, CorelCHART (for 

graphic charts), Mosaic and CorelTRACE (for vectorizing bitmaps). The 

inclusion of this software was the precedent for the actual graphic suites.  

o Version 4 of CoerlDRAW (1993) included Corel PHOTO-PAINT* (for bitmap 

editing), CorelSHOW (for creating on-screen presentations, CorelCHART (for 



graphic charts), CorelMOVE for animation, Mosaic and CorelTRACE (for 

vectorizing bitmaps). The inclusion of this software was the precedent for the 

actual graphic suites.  

o In version 5 of CoerlDRAW (1994), Corel Ventura was included in the suite 

(and then sold as a separate program). This was a layouting software akin to 

PageMaker or InDesign.  

o Version 6 of CoerlDRAW (1995) had Customizable interface, Polygon, Spiral, 

Knife and Eraser tools. Corel Memo, Corel Presents, Corel Motion 3D, Corel 

Depth, Corel Multimedia Manager, Corel Font Master and Corel DREAM (for 

3D modelling) were included in the suite.  

o Version 7 of CoerlDRAW (1997) contained Context-sensitive Property bar, 

Print Preview with Zoom and Pan options, Scrapbook (for viewing a drag-and-

dropping graphic objects), Publish to HTML option, Draft and Enhanced 

display options, Interactive Fill and Blend tools, Transparency tools, Natural 

Pen tool, Find & Replace wizard, Convert Vector to Bitmap option (inside 

Draw), Spell checker, Thesaurus and Grammar checker. The suite included 

Corel Scan and Corel Barista (a Java-based document exchange format).  

o Version 8 of CoerlDRAW (1998) had Digger selection, Docker windows, 

Interactive Distortion, 3D, Envelope and tools, Realistic Dropshadow tool, 

interactive color mixing, color palette editor, guidelines as objects, custome-

sized pages, duotone support. Corel Versions was included in the suite.  

o Version 9 of CoerlDRAW (1999) contained the Mesh fill tool (for complex color 

filling), Artistic Media tool, Publish to PDF features, embedded ICC color 

profiles, Multiple On-screen Color Palettes and Microsoft Visual Basic for 

Applications 6 support. The suite included Canto Cumulus LE, a piece of 

software for media management.  

o Version 10 of CoerlDRAW (2000) had CorelR.A.V.E. (for vector animation), 

Perfect Shapes, Web graphics tools (for creating interactive elements such as 

buttons), Page sorter, multilingual document support, navigator window.  

o Version 11 of CoerlDRAW (2002) had symbols library, image slicing (for web 

design), pressure-sensitive vector brushes, 3-point drawing tools.  

o Version 12 of CoerlDRAW (2003) contained Dynamic guides, Smart Drawing 

tools, Export to MS Office or Word option, Virtual Segment Delete tool, 

Unicode text support.  



o Version X3 of CoerlDRAW (2006) contained Double click Crop tool ( the first 

vector software able to crop groups of vectors and bitmap images at the same 

time), Smart fill tool, Chamfer/Fillet/Scallop/Emboss tool, Image Adjustment 

Lab. Trace became integrated inside Draw under the name PowerTRACE.  

 

11.2.4 FEATURES OF CORELDRAW: 
By now, you must have encountered terms like “bitmapped graphics” and “vector 

based graphics”. The original graphics packages were primarily bitmapped graphics 

packages. This means that each small dot on the display screen (called a pixel in 

computer talk) was treated as either black or white. Once its color became 

established, it stayed that way until changed by the operator. Pictures were 

essentially made up of a series of these dots, and the images were created, moved, 

stored, and printed by the computer in the black white dot format.  

 
DIFFERENT TYPEFACES AND SIZING: Corel Draw comes with over 150 typefaces. These 

typefaces are available to the users independent of the printer they use as long as it 

is a LaserJet, color, paint jet or dot matrix printer. More typefaces are available from 

third parties, or the user can create his own font using the WFN Front Export filter 

included and described in the CorelDraw. This capability of Draw is extensive, but 

not necessarily unique. What is different about Draw is its ability to change the way 

text characters look.  

 
HOW TO USE MOSAIC: Mosaic is a new addition to Corel Draw and makes working 

with Draw files a lot easier than before, because it allows a preview of the image 

contained in the file. This is particularly useful when many files have been saved 

relating to the same topic.  

Mosaic shows a group of boxes on the display that roughly represent the 

image contained in the file. If a file was created under an older version or DRAW 

(before release 2.0), then the box will appear with a line through it. Drawings created 

with Release 2.0 will show the drawing itself. Retrieving an older drawing into DRAW 

2.0 and saving it again will allow MOSAIC to recover an image of the drawing for 

display during directory review. Once a drawing is selected in MOSAIC, it can be 

loaded into DRAW simply by double clicking on the drawing.  

 



THE VALUE OF CORE RACE! AND AUTO TRACE: Given the benefits associated with 

vector graphics as opposed to bitmapped graphics, it is sometimes useful to convert 

a bitmapped graphics into a vector based graphic. This is the purpose of Corel 

TRACE! Auto Trace.  

 

UNDERSTANDING THE CORELDRAW SCREEN: It is assumed that CorelDraw! Is already 

installed on your computer. If it is not, please refer to the User’s Manual and the 

other excellent information provided by Corel. They stress that DRAW should be 

installed “outside of Windows.” Please note this suggestion to ease your installation.  

Starting CorelDraw!, once it is installed, is made simple by using the windows 

environment. Follow these simple steps:  

1. Turn on your Computer (make sure your monitor is also on).  

2. Watch your monitor as the computer starts itself. You should see a “Window” 

screen appear. If you do, go on to step. 3 If not, and all you see is a blank screen 

with some text lettering, type WIN then press Return (Enter) . This loads Window. 

3.0 in to your computer.  

 

SETTING UP THE GENERAL PAGE CHARACTERISTICS: CorelDraw! Provides a general 

page setup option under the FILE menu. This option is used to establish the general 

‘paper’ and ‘drawing’ environment within which the drawings will be created. Clicking 

on the page Setup option under FILE will show the Page Setup dialog box. With in 

this dialog box are options page orientation, page size, and several other options 

listed at the bottom.  

Most of your drawing will probably be done in the portrait orientation on a 

letter-sized paper, which means that the height (vertical dimension) of the page is 11 

inches and the width (horizontal dimension) is 8.5 inches, similar to a notebook sheet 

of paper. Landscape mode means that the sheet is rotated 90 degrees from the 

portrait mode, and the height is now 8.5 inches and the width is 11 inches.  

1. Select the Letter Page Size and Portrait Orientation and notice the 

horizontal/vertical dimensions listed.  

2. Change the Orientation from Portrait of Landscape, and notice that the 

horizontal/vertical dimensions swap places. This applies equally to the other 

page sizes such as legal (8.5x14 inches), Tabloid (11x17 inches,) A3, A4, A5, 

B5, and Slide options. These all have pre-set dimensions and the dimensions 



are listed in light type on the screen, meaning they cannot be altered by the 

user.  

3. Change the setting back to Portrait.  

 

DRAWING BASIC SHAPES: The previous sections outlined the basic history of DRAW, 

with procedures for accessing Draw’s commands and setting up the general page 

format. The following sections show how DRAW can be easily used to create 

wonderful shapes and designs. Section four deals with drawing lines, circular 

shapes, the rectangular shapes. It lays the groundwork for working with more exotic 

objects, so please start with this section before moving on to the others.  

 

To demonstrate this:  

1. Move the cursor to a spot on your page and click.  

2. While pressing Ctrl, move the cursor to the right and notice that it appears 

fixed in a horizontal direction.  

3. Keeping Ctrl pressed, move the cursor in a vertical direction, and notice that 

the line appears fixed along a vertical line.  

4. Keeping Ctrl pressed, move the cursor along an angle and notice that the line 

appears to jump from one angular orientation to another without going through 

the intermediate angles. In the information listed at the center of the status 

bar, notice an Angle designation with Degrees listed. As you move from one 

angle to another, the Degrees move in fixed increments.  

 

CREATING PIE SHAPES FROM ELLIPSES AND CIRCLES:  
1. Click on the SHAPE tool.  

2. Click and drag the small outlined box at the top of the circle. As you drag the 

small box, the circle edge will begin to open up.  

3. Let go of the mouse button and notice the final shape.  

 

MOVING THE CIRCLE OR ELLIPSE: Click on the PICK tool and then click and drag on the 

outline of the circle we just drew. The circle moves along with the cursor until you 

release the mouse button. The circle then redraws in the new location. This is an 

easy way to move an object around on the screen and applies to all objects and text 

boxes.  



 

SKEWING AND ROTATING AN OBJECT: Clicking once on an object outlines it with the 

small black boxes. Clicking on it again outline it with a series of arrows and place a 

“bull’s-eye” in the center of the object. Dragging on the curved arrows in the corners 

of the objects will make the object rotate around the center of the bull’s-eye. The 

object can be rotated either clockwise or counterclockwise. Dragging the bull’s-eye 

to another location will change the point around which the object rotates. This may 

be useful for special applications.  

1. Create a rectangle.  

2. Select the PICK tool and click on the rectangle if you do not see a series of 

arrows then click on the rectangle again.  

3. Drag the bull’s-eye into one of the corners of the rectangle.  

4. Drag the curved arrows in the corners. Notice how the object now rotates 

around the new bull’s-eye location. The horizontal and vertical double arrows 

on each side are used to skew the objects along a horizontal or vertical path, 

respectively.  

5. Click and drag one of these double arrows, and see the object begin to skew 

along the path you follow. This process of rotating and skewing works on all 

objects and paragraph text boxes.  

 

WORKING WITH BEZIER CURVES: As we have been from the few sections, DRAW is an 

effective tool for creating boxes, circles, and straight lines, Most drawing require 

curves to provide a level of artistic appeal, and DRAW has some special features 

that make working with curves simple. CorelDraw! Uses the term Bezier to describe 

its method of dealing with curves. In essence, DRAW takes the curve you draw and 

develops a mathematical method of describing it using Nodes and Control Points.  

 

ADDING TEXT TO THE DRAWING (TEXT STRINGS AND PARAGRAPH TEXT): A text string is a 

limited number of words (up to 25 characters) that are typically used for headlines or 

emphasis on a page. More of Draw’s features can be used on text strings than on 

paragraph text, so if you plan to perform extensive reworking of the text, then 

entering it as a text string is recommended.  

 



DUPLICATING OBJECTS: Duplicating objects in DRAW is a simple process and cab be 

accomplished in several ways. Each way has its benefits and is worth taking a few 

moments to review.  

 
DUPLICATING BY DRAGGING:  

1. Clear your page and then draw a rectangular shaped object using the 

RECTANGLE tool as outlined in a previous section.  

2. Give the rectangle a light fill as chosen by the FILL tool.  

3. Press the spacebar to select the PICK tool.  

4. Now press the “+” key and then click and drag on the rectangle’s border. 

Notice that the original rectangle remains in place, and a new one is dragged 

around the screen.  

5. Release the mouse button and a duplicate of the original rectangle is drawn.  

 

POSITIONING OBJECTS ON THE PAGE: Positioning objects in DRAW is a little confusing 

since the way they appear. On the editing page is different from the way they appear 

when printed. This was discussed briefly in the last section when the duplicated 

rectangular objects appeared as lines on the editing page, but appeared as filled 

boxed in front of one another on the preview page. Let’s experiment with object 

positioning using CorelDraw!  

1. Clear the editing screen by selecting New under the FILE menu.  

2. Draw a rectangle that is one inch in height and three inches in width. Give it a 

medium dark interior fill.  

3. Draw a two-inch square with a light interior fill and place it over the center of 

the first rectangle. DRAW also allows automatic alignment of objects along a 

combination of horizontal/vertical and left/right/center options. 

4. Marquee select the three objects using the PICK tool, and then click on the 

Align option under the ARRANGE menu. Notice the Align dialog box appears 

and allows for left, center, or right alignment of the objects in both a horizontal 

and vertical direction.  

5. Select the Horizontal Center option (aligning the objects along their centers) 

and the vertical Bottom options, then click on OK. The bottom of each object 

is aligned along the same horizontal line and are all centered as shown in the 

figure.  



 

SAVING AND RETRIEVING A DRAWING: Save your work often. Few things are more 

aggravating that to have several hours of work is lost due to a power failure or a 

confused computer. DRAW does not automatically save your drawing at preset 

intervals, so you need to discipline yourself to do it. The process is made easy but 

not automatic. If you do not already have a few objects on your screen, draw a few 

rectangles and ellipses. Notice that the name of the drawing shown on the title bar is 

“UNTITLED. CDR.” We are now going to name and save this drawing.  

 

SPECIAL EFFECTS (ADDING PERSPECTIVE):  
1. Deactivate the grid feature by clicking on the Snap To Grid option of the 

DISPLAY menu.  

2. Click on the TEXT tool and then enter the word EXCELLENT on the page in 

60-point type.  

3. Select the PICK tool, and click on the EFFECTS menu.  

 

CONTOURING OBJECT SHAPES USING ENVELOPES:  
1. Click on the TEXT tool  

2. Enter the word PACKAGES.  

3. Select the PICK tool then click on the Edit Envelope option of the EFFECTS 

menu.  

4. Select the second (single arc) option in the editing mode submenu, and notice 

that a dashed line and several node points now outline the object.  

5. Drag the center top node upward a little, and then drag the center bottom 

node down a little.  

6. Next, drag the center end node to the left a little, and then drag the center 

right end node to the right a little.  

 

MAKING A BITMAPPED IMAGE INTO DRAW VECTOR GRAPHIC: The scaling capability of 

vector graphic images makes them preferable to bitmap images. In reality, many 

images available are bitmap based because they were created when vector images 

were not prevalent, or they were created using a scanner (e.g. Scan man hand 

scanner). Corel TRACE! And the Auto Trace feature of DRAW.  



These capabilities are hanky when trying to re-create a company logo, or 

when taking a hand drawing and converting it to a vector graphic after it was 

scanned into the computer as a bitmap (.TIF, .PCX)  

 

11.3 SUMMARY:  
CorelDRAW includes a large collection of fonts and clip art. The biggest 

improvement with CorelDRAW over other graphic software programmes is its ability 

to edit bitmaps. A full range of editing tools allow the user to adjust contrast, color 

balance, change the format from RGB to CMYK, add special effects such as 

Vignettes and special borders to bitmaps. Bitmaps can also be edited more 

extensively using Corel PhotoPaint, opening the bitmap directly from CorelDRAW 

and returning to the program after saving. 

CorelDRAW Graphics Suite contains the following packages: CorelDRAW: Vector 

graphics editing software; Corel PHOTO-PAINT: Raster image creation and editing 

software; Corel CAPTURE: Enables several methods of image-capture; Corel 

PowerTRACE: Converts raster images to vector graphics; and Pixmantec 

RawShooter Essentials: Support for RAW file format.   

Corel Draw comes with over 150 typefaces. These typefaces are available to the 

users independent of the printer they use as long as it is a LaserJet, color, paint jet 

or dot matrix printer. More typefaces are available from third parties, or the user can 

create his own font using the WFN Front Export filter included and described in the 

CorelDraw. This capability of Draw is extensive, but not necessarily unique. What is 

different about Draw is its ability to change the way text characters look.  

 

11.4 KEY WORDS:  
CorelDRAW: Several innovations to vector-based illustration originated with 

CorelDRAW: a node-edit tool that operates differently on different objects. These 

include: fit text-to-path, stroke-before-fill, quick fill/stroke color selection palettes, 

perspective projections, mesh fills and complex gradient fills.   

Advantages of CorelDRAW: CorelDRAW can work with multi-page documents 

directly; but its chief competitor is Adobe Illustrator only offers a single-page layout 

view. CorelDRAW can open Adobe PDF files, Adobe PageMaker and InDesign, 

Microsoft Publisher and Word, and several other programmes can print documents 

to PDF using the Adobe PDF Writer printer driver, which CorelDRAW can then open 



and edit every aspect of the original layout and design. CorelDRAW can also open 

PowerPoint Presentations with little or no problem.  

Additional Components CorelDRAW: These include: PowerTRACE (a bitmap to 

vector graphic converter), PHOTO-PAINT (a bitmap graphic editor), and CAPTURE 

(a screen capture utility). 

CorelDRAW Graphics Suite: CorelDRAW Graphics Suite contains the following 

packages: CorelDRAW: Vector graphics editing software; Corel PHOTO-PAINT: 

Raster image creation and editing software; Corel CAPTURE: Enables several 

methods of image-capture; Corel PowerTRACE: Converts raster images to vector 

graphics; and Pixmantec RawShooter Essentials: Support for RAW file format.   

 

11.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
29. Write a detailed note on the CorelDRAW programme.  

30. Discuss in brief the facilities in CorelDRAW.  

31. Discuss the major facilities available in the CorelDRAW programme. 

32. Write a detailed note on the functioning of the CorelDRAW programme.  

 

11.6 REFERENCES / SUGGESTED READING: 
o Absolute Beginner’s Guide to Computer Basics; Michael Miller; 2007 

o Computers; Anne Rooney; 2005  

o Mastering Microsoft Word; Matthew Holtz; 1987  

o Mastering CorelDRAW; S. Rimmer; 1997  

o How the Web was Born: The Story of the World Wide Web; Robert Cailliau 

& James Gillies; 1997 

o The Internet: The Basics; Jason Whittakar; 2002  

o How the Internet Works; Preston Gralla; 1998  
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LESSON STRUCTURE:  
In this lesson we shall discus about the history and development of the Internet. 

First, we shall discuss the history of the Internet. We shall also briefly discuss about 

how to get connected to the Internet. Next, we shall discuss the working of the 

Internet and the benefits of the Internet. The lesson structure shall be as follows:  

12.0 Objectives  

12.1 Introduction  

12.2 Presentation of Content  

12.2.1 History of the Internet  

12.2.2 Connecting to the Internet  

12.2.3 Working of the Internet 

12.2.4 Benefits of the Internet 

12.3 Summary 

12.4 Key Words  

12.5 Self-Assessment Questions (SAQs) 

12.6 References/Suggested Reading 

 

12.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Understand the History of the Internet 

o To Know About How to Get Connected to the Internet  

o To Understand the Working of the Internet 

o To Know About the Benefits of the Internet  

 



12.1 INTRODUCTION: 
The Internet is a network of networks. It mainly connects networks of computers. Let 

us start with some interesting facts and perceptions about the Internet. It is a set of 

computers connected through fiber optics, phone lines, satellite links and other 

media. It is a place where you can talk to your friends and family around the world.  

The Internet is a place to get cool game demos. The Internet is an ocean of 

resources waiting to be mined. It is a place to do research for your thesis or a 

business presentation. The Internet is an unlimited commercial opportunity. It is a 

worldwide support group for any problem or need.  

The Internet is gold mine of professionals in all fields sharing information 

about their work. The Internet is the collection of hundreds of libraries and archives 

that will open to your fingertips. It is an ultimate time-waster. It is the technology of 

the future that will help make our lives and those of our children brighter.  

 In this lesson we shall discus about various aspects of the Internet. 
 
12.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o History of the Internet  

o Connecting to the Internet  
o Working of the Internet  
o Benefits of the Internet  

 
12.2.1 HISTORY OF THE INTERNET:  
The Internet started with the Arpanet and a few resourceful computer scientists who 

wanted to share files among people working on similar projects. ARPA is the 

acronym (abbreviation) for Advanced Research Projects Agency of the United 

States’ Department Of Defense.  

In September 1969, the University Of California at Los Angeles (UCLA), the 

Stanford Research Institute (SRI), the University Of California, Santa Barbara 

(USCB), and the University of Utah were connected using 500 kbps leased voice 

lines, and this network is called Arpanet. Although the original objectives of this 

research project were military-related, it was soon used for other purposes.  



Other universities and organizations including research and commercial 

organizations; soon began to use this technology to create their own networks, some 

of these networks then were connected to the Arpanet.  

Another factor in the rapid growth of this technology was the inclusion of the 

TCP/IP protocols in the Berkeley version of Unix. TCP/IP protocols gained wide 

usage, and more networks were created with them. These networks began to 

connect to each other.  

Soon there were many separate networks. Collectively, these connected 

computer networks were referred to as the Internet, or more simply the Net. The 

number of networks increases every day. And the Internet now connects more than 

50 million users worldwide.  

 
12.2.2 CONNECTING TO THE INTERNET:  
An account with Internet Service Provider (ISP) is a must to connect to the Internet. 

In India VSNL {Videsh Sanchar Nigam Ltd.} is one of the Internet Service Providers. 

Individual computers can establish the connections with ISP’s servers. A username 

and a password restriction is used to connect to the main server. Direct cable 

connection and dial-up networking (using telephone lines and modem) are the ways 

to connect your machine to ISP’s servers.  

In case of dial-up networking, telephone lines and modems are used to 

connect to local ISP. In this kind of connection user must dial the ISP’s phone 

numbers to establish the connection. In copper wires (telephone lines) digital data 

cannot travel. So digital data is converted into analog signals and transmitted. The 

speed of the connection is determined based on the status of the telephone system. 

If telephone system uses copper wires, the speed of the data flow cannot exceed 64 

Kbps.  

Internet Browser brings the Internet to your system. Web browsers enable you 

to use most of the Internet features like sending and receiving mail, downloading 

files from the Internet, browsing documents on the Net and Microsoft Internet 

Explorer are the two most popular Web browsers. These browsers can be used to 

watch videos on the Web, listen to music, read a book and even to shop.  

 

INTERNET SERVICE PROVIDERS:  



The cheapest way to surf the Internet is to get a connection from your local Internet 

Service Provider (ISP). The ISP takes you to the Internet. ISP will charge you 

periodically for the Internet access. Your ISP may also charge you an initial setup 

fee. If you are accessing the Internet from within windows, you will require SLIP 

(Serial Line Input Protocol) or PPP (Point to Point Protocol) connections VSNL, 

MTNL and Satyam Online are the popular Internet Service Providers in India. They 

have DNS servers in many cities throughout India. SLIP and PPP are two popular 

protocols that allow home computers to the Internet as peer hosts.  

In this mode of connection host computer will be able to browse the network 

individually without any interruption from the server. For TCP/IP connection Internet 

Service Provider must have PPP and SLIP protocols.  

 

DNS SERVERS:  
DNS server is a computer that translates the domain name of another computer into 

an IP (Internet Protocol) address and vice versa on request. Every computer in the 

network has an IP address, which specifies its physical network connection. To 

locate the information in Internet two kinds of addresses can be used. These are 

domain names and IP addresses. Domain names follow a format called Domain 

Name system.  

 

CONNECTION TYPES:  
There are different connection types to get connected to the Internet. These are:  

o In a host/terminal connection or shell account, your computer acts as if it were 

a terminal directly connected to an internal host. Terminal emulation programs 

(windows Terminal) can be used to make your computer act as a terminal. 

The terminal program signals the modem to dial and handles the transfer of 

characters from your computer to the host computer and back. This account 

does not permit the download of graphics, video or audio from web sites. It is 

less expensive.  

o TCP/IP link allows your computer to function as an internet host. These links 

are called either SLIP (Serial Line Internet Protocol) or PPP (Point to Point 

Protocol) links. Using this account direct e-mail, some sort of news group 

access, FTP, Telnet and running browser software is possible. This account is 

more expensive and allows for graphics download.  



 

12.2.3 THE WORKING OF THE INTERNET:  
In a network if you wish to send mail, enter the name of the user (i.e., the user name 

to whom you wants to send the mail). The E-mail system of the network sends the 

mail to the concerned address.  

This arrangement is similar to calling a local telephone number. Anyone 

wanting to access a telephone number from outside city limit must enter the area 

code and the telephone number. Similarly if the two people are not in the same 

Email system, they must enter fully qualified addresses. Between these two persons 

there may be many networks. Once the email is sent, the message is broken into 

small pieces called ‘packets’. Packets are the basic unit of measurement on the 

Internet.  

There are special purpose computers called “Routers” on the Internet, which 

will decide what is the best path to the destination to send these packets. Once 

these packets reach their destination they are reassembled into the original 

massage.  

The Internet has been described as cooperative anarchy. Each individual 

network has its own rules. Communication between networks is possible because of 

cooperation. There is no central administration of the Internet but there are formal 

bodies within the Internet that perform coordinating functions.  

 

ROUTERS:  
Routers are specialized computers that read the addresses of packets and direct the 

packets to their destination. They are devices that forward traffic between networks, 

using information from the network layer and from routing tables. Some routers are 

dedicated i.e. they are used only for shuffling the traffic.  

Some routers are also used for other purposes including file storage. A 

Routing Table is a table or database of routing path and decision variables that allow 

routers to send packets on to the correct destination.  

 

12.2.4 BENEFITS OF THE INTERNET:  
The Internet performs many functions. The major benefits of he Internet are:  

 
SEARCH FOR INFORMATION:  



In the Internet there are sites that have electronic versions of classic literature pages, 

pages of movie facts, stock quotes, collection of music, other interactive contents, 

and mountains of additional information. Since there is awful lot of information, you 

may have trouble finding a place to start.  

 

There are search tools in the Internet that helps you search for specific information. 

Yahoo {http://www.yahoo.com},  

Lycos {http://www.lycos.com},  

WebCrawler {http://www.khoj.com},  

Cyber {http://www.cyber411.com} are popular search engines available. Cyber411 is 

a great search engine as it combines results of 16 search engines and is still very 

fast. Khoj is an Indian search engine.  

 

USE ELECTRONIC MAIL:  
One of the widely features on the Internet is electronic main (e-mail). With e-mail you 

can send and receive mails without even leaving the keyboard. Messages can be 

sent globally just by paying local telephone charges. When someone sends you an 

email, it is stored in your mailbox (on service provider’s computer). Using the email 

program, connect to your ISP; download your message to your local hard disk. Email 

eliminates the need of postage stamps and greatly reduces the time taken to send 

and receive messages.  

 

CHAT WITH OTHER PEOPLE:  
If you like talking to complete strangers and making new friends, Internet is the best 

place. With chat programs you can talk with a group of people, whose geographical 

location you need not know.  

 
TELNET TO OTHER COMPUTERS:  
With telnet programme, you can connect to another computer and use it as if you 

were sitting at its keyboard. When the telnet program connects your computer to a 

remote computer, the remote computer usually asks you to enter a user name and a 

password. On telnet sites that allow anonymous access you can enter anonymous 

as your user name and your e-mail address as the password.  

 



 

 

12.3 SUMMARY:  
o The Internet is a network of networks. It mainly connects networks of 

computers. Let us start with some interesting facts and perceptions about the 

Internet. It is a set of computers connected through fiber optics, phone lines, 

satellite links and other media. It is a place where you can talk to your friends 

and family around the world.  

o The Internet started with the Arpanet and a few resourceful computer 

scientists who wanted to share files among people working on similar 

projects. ARPA is the acronym (abbreviation) for Advanced Research Projects 

Agency of the United States’ Department Of Defense.  

o In the Internet there are sites that have electronic versions of classic literature 

pages, pages of movie facts, stock quotes, collection of music, other 

interactive contents, and mountains of additional information. Since there is 

awful lot of information, you may have trouble finding a place to start.  

o One of the widely features on the Internet is electronic main (e-mail). With e-

mail you can send and receive mails without even leaving the keyboard. 

Messages can be sent globally just by paying local telephone charges. When 

someone sends you an email, it is stored in your mailbox (on service 

provider’s computer). Using the email program, connect to your ISP, 

download your message to your local hard disk. Email eliminates the need of 

postage stamps and greatly reduces the time taken to send and receive 

messages.  

o If you like talking to complete strangers and making new friends, Internet is 

the best place. With chat programs you can talk with a group of people, 

whose geographical location you need not know.  

 
12.4 KEY WORDS:  
Internet: The Internet is a network of networks. It mainly connects networks of 

computers. Let us start with some interesting facts and perceptions about the 

Internet. It is a set of computers connected through fiber optics, phone lines, satellite 

links and other media. The Internet is gold mine of professionals in all fields sharing 



information about their work. The Internet is the collection of hundreds of libraries 

and archives that will open to your fingertips.  

Internet Connection: An account with Internet Service Provider (ISP) is required to 

connect to the Internet. In India VSNL {Videsh Sanchar Nigam Ltd.} is one of the 

Internet Service Providers. Individual computers can establish the connections with 

ISP’s servers. A username and a password restriction is used to connect to the main 

server. Direct cable connection and dial-up networking (using telephone lines and 

modem) are the ways to connect your machine to ISP’s servers. In case of dial-up 

networking, telephone lines and modems are used to connect to local ISP.  

Routers: Routers are specialized computers that read the addresses of packets and 

direct the packets to their destination. They are devices that forward traffic between 

networks, using information from the network layer and from routing tables. Some 

routers are dedicated i.e. they are used only for shuffling the traffic.  

Search for information: In the Internet there are sites that have electronic versions 

of classic literature pages, pages of movie facts, stock quotes, collection of music, 

other interactive contents, and mountains of additional information. Since there is 

awful lot of information, you may have trouble finding a place to start.  

Use Electronic Mail: One of the widely features on the Internet is electronic main 

(e-mail). With e-mail you can send and receive mails without even leaving the 

keyboard. Messages can be sent globally just by paying local telephone charges. 

When someone sends you an email, it is stored in your mailbox (on service 

provider’s computer). Using the email program, connect to your ISP, download your 

message to your local hard disk. Email eliminates the need of postage stamps and 

greatly reduces the time taken to send and receive messages.  

Chat with Other People: If you like talking to complete strangers and making new 

friends, Internet is the best place. With chat programs you can talk with a group of 

people, whose geographical location you need not know.  

 

12.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
33.  Write a detailed note on the Internet.  

34. What are the different modes of getting connected to the Internet? Discuss in 

detail.  

35. Discuss in detail the benefits of the Internet.  

  



12.6 REFERENCES / SUGGESTED READING: 
o Absolute Beginner’s Guide to Computer Basics; Michael Miller; 2007 

o Computers; Anne Rooney; 2005  

o Mastering Microsoft Word; Matthew Holtz; 1987  

o Mastering CorelDRAW; S. Rimmer; 1997  

o How the Web was Born: The Story of the World Wide Web; Robert Cailliau 

& James Gillies; 1997 

o The Internet: The Basics; Jason Whittakar; 2002  

o How the Internet Works; Preston Gralla; 1998  
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LESSON STRUCTURE:  
In this lesson we shall discus about the various aspects of the World Wide Web. 

First, we shall focus on the. We shall also briefly discuss the. The lesson structure 

shall be as follows:  

13.0 Objectives  

13.1 Introduction  

13.2 Presentation of Content  

13.2.1 World Wide Web- The Origin 

13.2.2 Important Concepts Related to the World Wide Web  

13.2.3 Search Engines   

13.2.4 Domain Names and IP Addressing  

13.2.5 Setting up Internet Accounts on a PC  

13.2.6 Advantages of E-Mail  

13.3 Summary 

13.4 Key Words  

13.5 Self-Assessment Questions (SAQs) 

13.6 References/Suggested Reading 

 

13.0 OBJECTIVES:  
The objectives of this lesson are: 

o To Know About the Origin of the World Wide Web  

o To Understand some Concepts Related to the World Wide Web 

o To Know About the various Search Engines   

o To Know About Domain Names and IP Addressing 

o To Understand about Setting up Internet Accounts on a PC 

o To Know About the Advantages of E-Mail  



 

13.1 INTRODUCTION: 
World Wide Web and the Internet are not the same, but they are related and 

interdependent. The World Wide Web or simply the Web resides “on top of” the 

Internet.  

The World Wide Web is a huge collection of “pages” of information linked to 

each other around the globe. Each page can be a combination to text, pictures, 

audio clips, video clips, animations and other electronically presentable material. 

What makes Web pages interesting is that they contain hyperlinks usually called 

links. Each link points to another web page and when you click a link, your browser 

program fetches the page the link connects to. Every page can have many links that 

take you to new destination. Web pages can be linked to other anywhere in the 

world. This system of inter linked documents is known as hypertext.  

Here in this lesson, we shall discuss about the World Wide Web.  
 
13.2 PRESENTATION OF CONTENT: 
The content of this lesson shall be presented as follows:  

o World Wide Web- The Origin  

o Important Concepts Related to the World Wide Web  

o Search Engines   
o Domain Names and IP Addressing  
o Setting up Internet Accounts on a PC  
o Advantages of E-Mail  

 
13.2.1 WORLD WIDE WEB- THE ORIGIN:  
The world wide web is known fondly to millions as WWW, W3 or simply as the Web. 

The Web is actually a gateway of the Internet. It can be thought of as a graphical 

interface to the Internet, providing a revolutionary way of accessing information 

scattered across millions of computers around the world.  

Before the World Wide Web, the Internet was very difficult to navigate. Much 

of the information on it was tough to find and just as difficult to make use of. Locating 

and downloading files on the Internet needed some UNIX skills and specialized tools 

to get the job done.  



Tim Berbers-Lee is widely known as the Father of the World Wide Web. 

Berbers was a physicist at the European Organization for Nuclear Research 

{CERN}, a highly esteemed Physics Laboratory in Switzerland. He became 

frustrated with the difficulty of navigating the Internet and the lack of any common, 

easy-to-use interface for accessing the information residing on it.  

As a part of his job at CERN, Berbers-Lee frequently used the Internet for 

research, collaboration and communicating with colleagues. He knew the problems 

of using the Internet and was determined to make his job easier by building a system 

that would make navigating easy. In 1989, started working on the World Wide Web 

project. The project started in 1991.  

In February 1993, the National Center for Supercomputing Applications 

(NCSA) released the first public version of Mosaic, a breakthrough software that 

kicked the World Wide Wed into high gear. It supported a user-friendly graphical 

user interface. This appealed to people normally uncomfortable using text based 

products such as Line Mode Browsers.  

In addition, Mosaic supported the use of a mouse. One could now navigate 

without using the keyboard. This was a tremendous advance for most computer 

users. The Web was no longer simply a hypertext system. It had evolved into a fully 

functional and seamlessly integrated hypermedia.  

It was seamless because one could access all protocols and programmes as a 

whole, without requiring a special tool for each. And it was hypermedia because 

these protocols delivered inter-linked text, video, sound and graphics that were 

treated as a single coherent collection of information. The Web was now a global 

system that allowed access to files from around the world.  

Since Mosaic was introduced, the Web has skyrocketed in popularity.  

 

13.2.2 IMPORTANT CONCEPTS RELATED TO THE WORLD WIDE WEB:  
 Here we shall discuss some important concepts related to the Internet.  

 
WEB PAGES:  
Familiarizing you with the Web does not take very long, and is a fun way to prepare 

yourself for creating Web documents. The best place to start is with the web page, 

the visual part of a much larger system that people most often associate with the 

World Wide Web. These are main components of the Web.  



Most people think mainly of the individual web pages, as they are the most 

visually captivating aspect of the entire system. The term ‘page’ refers to nothing 

more than a World Wide Web document. However, a web page is much more like a 

word processing document. Especially the way it is viewed. When the information on 

a web page is not visible, you scroll either vertically or horizontally to see more.  

 

WEB SITES:  
A World Wide Web site is simply a collection of interlinked web pages. Web pages 

need not be related. By its very nature the Web makes it possible to link any number 

of items, including other pages. For instance, a page might have links to other pages 

containing photography and cartoons or just about anything else.  

Because of the inherent diversity found in the Web, to suggest that a site is a 

related group of documents would be big mistake. If you were to think of the Web as 

a giant filling cabinet, each site would be a folder inside it. The pages in turn would 

be documents inside the folders.  

 

HOME PAGES:  
A home page is the first page of a website. One often faces this big question: How to 

find a site if it is merely a collection of interlinked pages? Simple, each site has a 

home page, the official gateway or entry to the site. From the home page, you can 

get an overview of the site and begin exploring it.  

A properly designed home page is, in essence, like a hospitable host. It 

invites you in and tells you about all the things you can see and do during your visit. 

It is the most important page of any site, the starting point for your journey.  

 

WEB SERVER:  
The final part of the web is the server. A web server does a great deal of work in 

making web in making pages and sites available to browser. They are the linking 

mechanism between you and the web; between people and pages. A large company 

may have its own server, but usually individuals and small companies rent or lease 

space on the server provided by an Internet Access Company. Without servers there 

would be no Web.  

Web pages must reside somewhere on the Internet in order to be accessed 

with a browser and a server is the link. There are literally millions of Web servers on 



the Internet, each of which may be home to thousands of Web pages. A server is 

responsible for delivering these pages to your Web browser when it asks for it: i.e, it 

“serves” web pages to browsers.  

Web servers consist of special hardware and software that makes it possible 

to carry out browser requests. Perhaps you have heard of the term client-server? 

This is exactly the type of relationship your browser and the server have. The 

browser is considered a client, since it asks to see or use certain documents located 

on the Internet.  

 

PROTOCOLS:  
The main protocol for transferring information on the Web is the HyperText Transfer 

Protocol or HTTP. Web pages, both text pages and graphics pages, are sent from 

the server to the browser using this protocol. The web also supports most of the 

other popular Internet protocols, such as File Transfer Protocol (FTP), Gopher, 

News, and Wide Area Information Service (WAIS). But you need not remember all 

these protocols. Your browser does all the work, dynamically switching protocols as 

needed.  

Uniform Resource Locators or URL’s are the standard way of locating and 

retrieving information on the World Wide Web. They tell your browser what piece of 

information to retrieve, how to get to it, and what protocol to use in the process. A 

URL can be thought of as a postal address for the web. They specify where pages, 

files and other pieces of information are located, making it possible for browsers to 

find and display or even to download that information.  

Provide a URL to your browser so it can find and access web pages and FTP 

files. 

URLs are read from left to right, just like a telephone number. The first piece 

of information in a URL describes what type of protocol the browser must use to 

retrieve a given object.  

Examples:  

o http://  

o wais://  

o ftp://  

o telnet://  

o file://  



 

13.2.3 SEARCH ENGINES:  
People commonly refer to the current era as the Information Age. The best thing 

about today’s Internet is the enormous range of resources on it. The worst thing 

could be the absence of a guide to those resources. Finding information often is a 

nightmare.  

Fortunately, we have Web search engines to locate any required information. 

The URL of the required site must be submitted to search engine. Keywords are built 

into the index page of the site. For a site to be listed after such a submission, it may 

take upto 7 to 10 days. SubmitAway.com helps you submit your URL to these search 

engines. Some search engines have a definite format and expect you to type the 

keywords. When you connect any of the search engines using its URL, you are 

asked to type in the key words in the search box. The search engine displays a list of 

locations that matches your search parameters.  

 

POPULAR SEARCH ENGINES:  
Here is a list of some popular search engines:  

www.yahoo.com: This is one of the earliest and very popular engines. Yahoo is a 

preferred choice for millions of Web surfers.  

www.lycos.com: An effective tool to pinpoint the site of your choice. Carnegie-

Mellon University developed this site.  

www.infoseek.com: By far, one of the most effective search engines that will 

search the World Wide Web for the information you need. A good feature is the 

‘search within results’ which will narrow down the results to a manageable number of 

web sites.  

www.excite.com: The exciting thing about this engine is the profusion of chat links 

ranging from the general to very specific.  

www.altavista.digital.com: One of the few engines which lets you search across 

sites in many languages, ranging from Greek to Hebrew to Estonian.  

www.isleuth.com: It’s the mother of all searches, because six engines do the work 

for you at once.  

www.Webcrawler.com: Their daily toolbox is an interesting add on that lends it an 

extra edge.  



www.goto.com: Elegant in its simplicity, this engine does the searching job 

efficiently.  

www.cyber411.com: This is a meta-parallel search, which reaches across 16 

engines and displays non-duplicated results.  

www.khoj.com: A search engine for Indian web sites. The khoj home page has links 

to topics of Indian interests.  

www.hotbot.com:  
 

13.2.4 DOMAIN NAMES AND IP ADDRESSING:  
As in our everyday lives we need some way of telling the people where a particular 

thing is located. Similarly, on the Internet also, we need to tell people where a 

particular resource is located. For this purpose there are two kinds of addressing.  

o Domain Addressing  

o IP (Internet Protocol) Addressing  

 

Domain names follow a format called the Domain Name System (DNS). Every 

computer on the Internet has both the Domain name and an IP address. When a 

domain name is used, a Domain Name Server translates that name to the 

corresponding IP address. Domain names describe organizational or geographic 

realities. They either indicate the country the network connection is in, or what 

organization owns it and sometimes further details.  

A computer that translates the domain name of another computer into an IP 

address, and vice versa, upon request is known as DNS server. These servers are 

located all over the world and automatically do this translation when a URL 

containing a domain name is submitted through a browser.  

 

DOMAIN NAMES:  
Domain names describe organizational or geographic realities. They either indicate 

the country the network connection is in, or what organization owns it and sometimes 

further details. A computer that translates the domain name of another computer into 

an IP address, and vice versa, upon request is known as DNS server. These servers 

are located all over the world and automatically do this translation when a URL 

containing a domain name is submitted through a browser. The IP address is 



returned to the browser that placed the request. The browser then lands on this IP 

address.  

Com: Commercial  

Edu: Education  

Gov: Government  

Net: An administrative organization for a network  

Mil: Non-classified military networks  

Org: Usually private organizations and others  

 

Here are some domain names for countries: 
De: Germany (Deutschland)  

It: Italy  

Nz: New Zealand  

In: India  

 

For more information or domain for countries visit: ftp://ftp.nw.com/zone.iso-country-

codes 

 

IP ADDRESSING:  
Each computer or server is known as the host and the IP address specifies its 

physical network connection. An IP address is a set of four numbers (32 bits) 

separated by period (a dot). A part of the address is designated as the network 

address, and the other part as a node address.  

Network address uniquely identifies each network. Each machine on the 

same network shares that network address as part of its IP address. Node address 

uniquely identifies each machine on a network (must be unique because it identifies 

a particular machine.) In the given IP address 202.54.15.178, the 202.54 is the 

network address and 15.178 is the node address.  

 

13.2.5 SETTING UP INTERNET ACCOUNTS ON A PC:  
There are two types of accounts popularly used. These are:  

LEASED LINE: This is like cable TV, where your system is directly linked to the ISP 

using a dedicated cable. Data transfer is very fast (64 KBPS and upwards) and is 



also expensive (runs into lakhs of Rupees per year). Large companies prefer this 

with branches widely spread.  

DIAL-UP: This is achieved via a modem. You place a telephone call via the modem, 

to your ISP’s modem or router. When contact is established, you can hear a 

handshake or a welcome note. And then you log on to the network and when 

authenticated you are on the net.  

This accounts is less expensive (approximately Rs.20 per hour). But this is 

such slower as only a maximum speed of 14.4 KBPS can be reached. The speed, 

however, varies depending on the traffic on your route and on the quality of 

telephone connections.  

Individuals and small companies prefer this account type. In order to prepare 

your computer to connect to your ISP’s server using a telephone line, you must 

install Dialup Network components of Windows Operating System. You will find this 

on your Windows installation CD.  

Since Internet uses TCP/IP as a standard protocol this must be installed in 

your computer. TCP/IP must be configured according to the information given to you 

by your Internet Service Provider (ISP)- the hostname, domain and IP address.  

 

DIAL- UP NETWORKING:  
To set up a TCP/ IP, make sure that you have installed Dial-Up Networking in 

Window 95 or Windows NT system. If it is installed you will see that Dial Up Network 

must be installed on your computer to ensure that you can connect to the Internet 

through telephone Line.  

 
STEPS TO INSTALL DIAL–UP NETWORKING: Click on start > Setting >Control Panel. 

From the Control Panel double-click on the Add/Remove Programs option.  

o Select Windows Setup tab  

o Click on Communications and then on the Details button. A dialog pops up 

displaying the currently installed Communications applications.  

o Click on the check box next to the Dial-Up Networking option.  

o Click on OK in the Add/Remove Program properties dialog box. You will be 

prompted for the appropriate (Windows 95 or Windows NT) CDROM or 

installation files.  

 



13.2.6  ADVANTAGES OF ELECTRONIC MAIL:  
The main benefit of e-mail, when compared to other messaging media like fax, is 

that it is almost instantaneous. More importantly, it directly reaches the concerned 

individual’s electronic mail box without getting buried under a mountain of paper. In 

some cases, you can even confirm whether your message has been received and 

read by the recipient—something next to impossible with a letter or fax.  

Sure the good old telephone offers advantages similar to that of a letter or fax, 

but what do you do when the person you are calling is not at his table or if he is a 

few continents away?  

With e-mail even if the recipient is not around, the message is delivered into 

his mailbox and is available the next time he checks in the mailbox. E-mail also 

ensures a much higher degrees of security and privacy. Only an authorized person 

can open or even know the presence of the mail. An authorized person is one who 

knows the login name and password to the recipient’s mailbox.  

Compared to other media, e-mail is very cheap. The cost of sending 

electronic message across the world is the same as sending one across the city. In 

most cases, the cost of an e-mail is equivalent to the cost of a local telephone call. 

Further, as the message is in an electronic form, you save money or printing, fax 

paper and ink. Used correctly, e-mail offers many advantages over a physical mail or 

message.  

For example, using encryption technology you could electronically deliver 

confidential documents saving time and money over the standard practice to having 

a ‘reliable’ person hand delivering a sealed document. Similarly by using digital 

signatures, you can even hinder forgery as digital signatures, like fingerprints can be 

verified and are unique for every user and message.  

 

13.3 SUMMARY:  
o The World Wide Web is a huge collection of “pages” of information linked to 

each other around the globe. Each page can be a combination to text, 

pictures, audio clips, video clips, animations and other electronically 

presentable material. What makes Web pages interesting is that they contain 

hyperlinks usually called links.  

o The world wide web is known fondly to millions as WWW, W3 or simply as the 

Web. The Web is actually a gateway of the Internet. It can be thought of as a 



graphical interface to the Internet, providing a revolutionary way of accessing 

information scattered across millions of computers around the world.  

o The World Wide Web is seamless because one could access all protocols 

and programmes as a whole, without requiring a special tool for each. And it 

ws hypermedia because these protocols delivered inter-linked text, video, 

sound and graphics that are treated as a single coherent collection of 

information. The Web is now a global system that allowed access to files from 

around the world.  

o A web site is simply a collection of interlinked web pages. Web pages need 

not be related. By its very nature the Web makes it possible to link any 

number of items, including other pages.  
o A home page is the first page of a website. One often faces this big question: 

How to find a site if it is merely a collection of interlinked pages? Simple, each 

site has a home page, the official gateway or entry to the site. A properly 

designed home page is, in essence, like a hospitable host. It invites you in 

and tells you about all the things you can see and do during your visit. It is the 

most important page of any site, the starting point for your journey.  

o A web server does a great deal of work in making web in making pages and 

sites available to browser. They are the linking mechanism between you and 

the web; between people and pages. A large company may have its own 

server, but usually individuals and small companies rent or lease space on the 

server provided by an Internet Access Company. Without servers there would 

be no Web.  

o The main protocol for transferring information on the Web is the HyperText 

Transfer Protocol or HTTP. Web pages, both text pages and graphics pages, 

are sent from the server to the browser using this protocol. The web also 

supports most of the other popular Internet protocols, such as File Transfer 

Protocol (FTP), Gopher, News, and Wide Area Information Service (WAIS). 

But you need not remember all these protocols. Your browser does all the 

work, dynamically switching protocols as needed.  

o Uniform Resource Locators or URL’s are the standard way of locating and 

retrieving information on the World Wide Web. They tell your browser what 

piece of information to retrieve, how to get to it, and what protocol to use in 

the process. A URL can be thought of as a postal address for the web. They 



specify where pages, files and other pieces of information are located, making 

it possible for browsers to find and display or even to download that 

information.  

o Web search engines help us to locate any required information. The URL of 

the required site must be submitted to search engine. Keywords are built into 

the index page of the site. For a site to be listed after such a submission, it 

may take upto 7 to 10 days. SubmitAway.com helps you submit your URL to 

these search engines. Some search engines have a definite format and 

expect you to type the keywords.  

o Domain names describe organizational or geographic realities. They either 

indicate the country the network connection is in, or what organization owns it 

and sometimes further details.   

o Network address uniquely identifies each network. Each machine on the 

same network shares that network address as part of its IP address.  

 

13.4 KEY WORDS:  
World Wide Web: The World Wide Web is a huge collection of “pages” of 

information linked to each other around the globe. Each page can be a combination 

to text, pictures, audio clips, video clips, animations and other electronically 

presentable material. What makes Web pages interesting is that they contain 

hyperlinks usually called links. Each link points to another web page and when you 

click a link, your browser program fetches the page the link connects to.  

Web Sites: A web site is simply a collection of interlinked web pages. Web pages 

need not be related. By its very nature the Web makes it possible to link any number 

of items, including other pages. For instance, a page might have links to other pages 

containing photography and cartoons or just about anything else.  

Home Pages: A home page is the first page of a website. One often faces this big 

question: How to find a site if it is merely a collection of interlinked pages? Simple, 

each site has a home page, the official gateway or entry to the site. From the home 

page, you can get an overview of the site and begin exploring it.  

Web Server: The final part of the web is the server. A web server does a great deal 

of work in making web in making pages and sites available to browser. They are the 

linking mechanism between you and the web; between people and pages. A large 

company may have its own server, but usually individuals and small companies rent 



or lease space on the server provided by an Internet Access Company. Without 

servers there would be no Web.  

Protocols: The main protocol for transferring information on the Web is the 

HyperText Transfer Protocol or HTTP. Web pages, both text pages and graphics 

pages, are sent from the server to the browser using this protocol. The web also 

supports most of the other popular Internet protocols, such as File Transfer Protocol 

(FTP), Gopher, News, and Wide Area Information Service (WAIS). But you need not 

remember all these protocols. Your browser does all the work, dynamically switching 

protocols as needed.  

Uniform Resource Locators: URL’s are the standard way of locating and retrieving 

information on the World Wide Web. They tell your browser what piece of information 

to retrieve, how to get to it, and what protocol to use in the process. A URL can be 

thought of as a postal address for the web. They specify where pages, files and 

other pieces of information are located, making it possible for browsers to find and 

display or even to download that information.  

Domain Names: Domain names describe organizational or geographic realities. 

They either indicate the country the network connection is in, or what organization 

owns it and sometimes further details. A computer that translates the domain name 

of another computer into an IP address, and vice versa, upon request is known as 

DNS server. These servers are located all over the world and automatically do this 

translation when a URL containing a domain name is submitted through a browser. 

IP Addressing: Each computer or server is known as the host and the IP address 

specifies its physical network connection. An IP address is a set of four numbers (32 

bits) separated by period (a dot). A part of the address is designated as the network 

address, and the other part as a node address.  

 

13.5 SELF-ASSESSMENT QUESTIONS (SAQs): 
36.  Discuss the importance of the World Wide Web in detail  

37. Write a detailed note on the origin of the World Wide Web.  

38. Write a detailed note on some important concepts related to the world wide 

web.   

39. Write a detailed note on search engines .   

40. Write a detailed note on domain names and IP addressing.   

41. Write a detailed note on some advantages of E-Mail.   
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